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UNSTEADY FLOW ANALYSIS USING HEC-RAS FOR MARICOPA COUNTY

AGENDA INDEX

• Tuesday

Type Title Tab Prefix Instructor

Lecture Overview of HEC-RAS 1.1 L-01 Brunner
Lecture Data Requirements for Unsteady Flow Models 1.2 L-02 Ackerman
Workshop Pre-Processing Geometric Data 1.3 W-01 Ackerman/Brunner
Lecture Boundary and Initial Conditions 1.4 L-03 Brunner
Workshop Basic Unsteady Flow Modeling 1.5 W-02 Brunner/Ackerman

Wednesday

Lecture Modeling Bridges and Culverts 2.1 L-04 Ackerman
Workshop Modeling Bridges and Culverts 2.2 W-03 Ackerman/Brunner
Lecture Inline and Lateral Hydraulic Structures 2.3 L-05 Brunner
Lecture Storage Areas and Storage Area Connections 2.4 L-06 Ackerman
Workshop Lateral Hydraulic Structures, Storage Areas, and 2.5 W-04 Brunner/Ackerman

Storage Area Connections

Thursday

Lecture Model Stability, Accuracy, and Sensitivity 3.1 L-07 Brunner
Workshop Trouble Shooting 3.2 W-05 Brunner/Ackerman

•
Lecture Advanced Features for Unsteady Flow 3.3 L-08 Ackerman
Workshop Dam and Levee Breaching 3.4 W-06 Ackerman/Brunner
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Cameron To Ackerman:

Education:

Registration/Professional
Affiliations:

Experience:

Technical Subjects:

Hydraulic Engineer, Hydrology and Hydraulics
Technology Division, 5301756-1l04/ext! 358.

BS, Civil Engineering, University of California, Davis,
1997
MS, Civil Engineering, University of California, Davis,
1999

Registered Civil Engineer, California, 2001;
Member ASCEIEWRI; AGU; Tau Beta Pi;.

5 years, Hydraulic Engineer, Hydrology and Hydraulics
Technology Division, HEC. Dam break modeling and
river analysis studies; research, development, and
application of geographic information systems (GIS)
methods for surface water modeling; and development of
GIS-based flood warning and response systems.

3 years, Hydraulic Engineer, Water Resource Systems
Division and Planning Analysis Division, HEC.
Research, development, and application of GIS methods
for surface water modeling, flood damage analysis, and
risk communication; riverine, wetland restoration,
hydrology, and watershed impact analysis studies.

3 years, Civil Engineer Intern, HEC. Riverine and
watershed studies; investigation of remote sensing
techniques; effects of riverine wetlands for surface water
hydrology; application of GIS methods for hydrologic
analysis; development of GIS methods for surface water
modeling.

2 seasons, Hydrology Crew Leader, USFS, Tahoe
National Forest. Surveyed Sierra Nevada streams; fish
and invertebrate sampling, movement of woody debris,
channel characterization and measurement, Rosgen
channel typing, monitor hydrologic impacts to watershed.

River hydraulics, dam break analysis, surface water
hydrology, and GIS for surface water modeling.
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Gary u-: Brunner:

Education:

Registration/Professional
Affiliations:

Experience:

Technical Subjects:

Senior Technical Hydraulic Engineer (River Hydraulics),
GS-14, (530) 756-ll04/ext. 352.

BS, Civil Engineering, Pennsylvania State University,
State College, PA, 1983
MS Civil Engineering, Pennsylvania State University,
State College, PA, 1985

Registered Civil Engineer, California, 1987; member Tau
Beta Pi, Chi Epsilon, Transportation Research Board,
FMA (Floodplain Management Association), EWRI, and
A.S.C.E.

21 years, Senior Technical Hydraulic Engineer,
Hydrology and Hydraulics Technology Division,
Hydrologic Engineering Center, IWR. In charge of the
development ofthe HEC River Analysis System (HEC
RAS); perform research in the area of river hydraulics;
provide technical assistance to Corps field personnel;
teach engineering classes in river hydraulics and surface
water hydrology; perform complex riverine studies.

2 years, Research and Teaching Assistant, Penn State
University. Research on overland flow processes, and
teaching surveying to undergraduates.

River hydraulics; steady flow, unsteady flow, and Dam
Break analyses; surface water hydrology; risk and
uncertainty analysis; sediment transport processes; real
time river forecasting; hydrologic statistics; utilizing GIS
with hydrology and hydraulic models; also have
extensive teaching experience in river hydraulics and
surface water hydrology.
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1.1 L-01

This lecture is intended to be an overview of the HEC-RAS software.

•
L - Overview of HEC-RAS/Brunner



HEC-RAS

• 1-Dimensional hydraulics program

• Compute water surface profiles from channel
geometry and flow

• Steady and Unsteady Flow

: ••• : Hydrologic Engineering Center
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• HEC-RAS

1.1 L-01

IC:\HEC Dala\HEC·RAS\ProjecblJv1odesto\Ballle1.plj

PI", 1S'~Flom 1C:\HEC Data\HEC-RAS\Projects\Modesto\Baxter.pOl

Geome",,: impaled GIS Da'a >8ridQe> jC:\HEC Data\HEC·RAS\Project$\Mode$to\BaKtet.~2

S,~ Flow: 1S'~Flom !C:\HECData\HEC.flAS\Projects\Modesto\Baxlef. f01

Uml.~F~w:1 I
Dewiption: If..''llIe GIS Awica60n o I Version 4.0 Beta IUS Cotlom",. u....

• Graphical User Interface
• Data storage/management
• Graphics, Tabular Output & Reporting
• GeoRAS - HEC-RAS GIS Interface

a Hydrologic Engineering Center 3
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Type and Scale of Applications
& ++4%

1.1 L-01

•
• Types of Studies

• Initial screening and reconnaissance studies
• Detailed Investigations and alternative evaluations
• Design Studies
• Real-time forecasting

• Spatial Scale of Application
• Very small urban areas with small drainage systems
• Moderate-size river systems with natural and

constructed channels
• Large-scale river systems

• Time Scale of Applications
• Peak flow profiles
• Single event simulations
• Long term simulations

t:~:l Hydrologic Engineering Center

HEC-RAS has been designed for modeling a wide range of spatial and time scales.
The software can be used to model from large scale river systems, down to very
small streams (even flume data could be modeled). Time scales can range from
modeling peak flows (steady flow), full hydrographs (unsteady flow), and even
period of record analysis. HEC-RAS can be used to perform a range of studies from
initial screening level studies, up to and including detailed hydraulic designs.

L - Overview of HEC-RAS/Brunner
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Steps in Developing a Hydraulic
Model with HEC-RAS

• There are five main steps in creating an HEC-RAS
model:
• Starting a new project

• Entering Geometric Data
• Create or import geometry and add structures

• Entering flow data
• Steady flow (Peaks) or unsteady flow (hydrographs)

• Creating a Plan and performing the computations

• Viewing Results

:••• : Hydrologic Engineering Center

1.1 L-01
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Geometric Data

• Cross Sections
• Detailed Bridge Analysis
• Detailed Culvert Analysis (9 shapes)
• Multiple openings (bridge, culverts, conveyance)
• Inline Structures (weirs/spillways, gates)
• Lateral Structures (weirs/spillways, gates, culverts)
• Storage Areas and Storage Area Connections
• Rating Curves
• Pump Stations
• Floating ice
• Levees
• Extensive data import and export
• GIS Connections

r.'I"r.'J Hydrologic Engineering Center
~

Geometric data consist of establishing the connectivity of the river system (River
System Schematic), entering cross-section data, defining all the necessary junction
information, adding hydraulic structure data (bridges, culverts, dams, weirs, etc.)
and cross section interpolation. The geometric data is entered by selecting
Geometric Data from the Edit menu on the HEC-RAS main window.

L - Overview ofHEC-RAS/Brunner
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• ~ RAS Geometric Data Editor - Schematic

1.1 L-01
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Hydrologic Engineering Center

The HEC-RAS Geometry Editor allows the user to enter data from scratch, import
data from other models, or import data from a GIS. User's can add Background
maps for improved visualization.

7
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Cross Sections

Hydrologic Engineering Center

After the river system schematic is completed, the next step for the modeler is to
enter the cross section data. Cross section data represent the geometric boundary of
the stream. Cross sections are located at relatively short intervals along the stream
to characterize the flow carrying capacity of the stream and its adjacent floodplain.
Cross sections are required at representative locations throughout the stream and at
locations where changes occur in discharge, slope, shape, roughness, at locations
where levees begin and end, and at hydraulic structures (bridges, culverts, inline
weirs/spillways, and lateral weirs/spillways).

L - Overview of HEC-RAS/Brunner
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V Cross Section Editor

1.1 L-01
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~ Hydrologic Engineering Center 9

To enter cross section data, the user presses the Cross Section button on the
Geometric Data window. Once the cross section button is pressed, the Cross
Section Data Editor will appear as shown above (Except yours will be blank
until you have added some data), To add a cross section to the model, the user
must do the following:

From the Cross Section Editor, select the river and the reach that you would like to
place the cross section in. This is accomplished by pressing the down arrow on
the River and Reach boxes, and then selecting the river and reach of choice.

1. Go to the Options menu and select Add a new Cross Section from the list. An
input box will appear prompting you to enter a river station identifier for the
new cross section.

2. Enter all of the required data for the new cross section. Required data is the data
that is openly displayed in the cross section editor window.

3. Enter any desired optional information (i.e., ineffective flow areas, levees,
blocked obstructions, etc.). Optional cross section information is found under
the Options menu.

4. Press the Apply Data button in order for the interface to accept the data. The
apply data button does not save the data to the hard disk, it is used as a
mechanism for telling the interface to use the information that was just entered.
If you want the data to be saved to the hard disk you must do that from the File
menu on the geometric data window.

L - Overview of HEC-RAS/Brunner 9



~ Bridge Editor

1.1 L·01

•

To enter bridge data the user presses the Bridge/Culvert button on the
geometric data window. Once the bridge/culvert button is pressed, the
Bridge/Culvert Data Editor will appear as shown above (your bridge/culvert
editor will come up with a blank window until you have entered the bridge
data). To add a bridge to the model, do the following:

1. Select the river and reach that you would like to place the bridge in.
Selecting a reach is accomplished by pressing the down arrow on the river
and reach box, then selecting the river and reach of choice.

2. Go to the Options menu and select Add a Bridge and/or Culvert from the
list. An input box will appear prompting you to enter a river station
identifier for the new bridge.

3. Enter all of the required data for the new bridge. This includes:

• Bridge Deck

• Sloping Abutments (optional)

• Piers (optional)

• Bridge modeling approach information

4. Enter any desired optional information. Optional bridge information is
found under the Options menu at the top of the window.

5. Press the Apply Data button for the interface to accept the data.

RS-45360. Relilrotl:dDownstre~m (Elfldge)

f.'l"f.l Hydrologic Engineering Center
~
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• Culvert Editor

1.1 L-01
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Hydrologic Engineering Center

Culvert data are entered in the same manner as bridge data. To enter culvert
data the user presses the Bridge/Culvert button on the Geometric Data
window. Once this button is pressed, the Bridge/Culvert Data Editor will
appear. To add a culvert group to the model the user must then do the
following:

1. Select the river and reach that you would like to place the culvert in. This
selection is accomplished by pressing the down arrow on the river and reach
boxes and then selecting the river and reach of choice.

2. Go to the Options menu of the Bridge/Culvert editor and select Add a
Bridge and/or Culvert from the list. An input box will appear prompting
you to enter a river station identifier for the new culvert group. After
entering the river station, press the OK button and the cross sections that
bound the new culvert group will appear in the editor.

3. Enter all of the required data for the culvert group. This includes the road
embankment information and the culvert specific data. The roadway
information is entered in the same manner as a bridge (using the
deck/roadway editor). To enter culvert specific data, press the Culvert
button on the Bridge/Culvert Data editor.

4. Once all of the culvert data are entered, press the OK button in order for the
interface to accept the information.

11

L - Overview ofHEC-RAS/Brunner 11



1nIn.
StruclUUP

----
Inline Structure Editor

1.1 L-01

•
o

Rule$" (Illsteady dat~) ...

Ele ¥iew Qpllons tjelp

Riv..: fmi\'ilfijijij' ""-"'''T::I "o'''YD·." I +01
Reech: IWe'Reech ::oJ RiverSt..:;=141:::::.75====3~·!l.!l

UpslJeem X5: -!1.1L.J Upstream channel ~r>;lth: 90 Iitl
Description lnline \,llei and Gated Spilway

Pilot Flow 0 Breoch Iplan date} . I
Gated Spillway

Oeorn: Gate Geometry wlh :3 Gate Groups Flow: 7 Flow Profiles

30.············································.,.······...

200 400 600 eoo 1000

Stetion(ft)

:,.,: Hydrologic Engineering Center

Inline structure data are entered in a similar manner as bridge and culvert data. To
enter an inline structure press the Inline Structure button from the Geometric
Data window. Once this button is pressed, the Inline Structure Data editor will
appear as shown above (except yours will be blank until you enter some data).

To add an inline structure to a model, the user must do the following:

1. Select the river and reach that you would like to place this inline structure into.
This is accomplished by first selecting a River, then selecting a specific reach
within that river. The River and Reach selection buttons are at the top of the
Inline Structure Data editor.

2. Go to the Options menu at the top of the window and select Add an Inline
Structure from the list. An input box will appear asking you to enter a river
station identifier for locating this structure within the reach. After entering the
river station, press the OK button and a copy of the cross sectionjust upstream
of this river station will appear on the screen. This cross section is used in
formulating the inline structure crossing.

3. Enter all of the data for the Inline structure. This data will include a
Weir/Embankment profile, and any gated spillways that you may be modeling.
Gated spillways are optional. If the user does not enter any gated spillways,
then the program assumes that there is only an inline weir.

4. Once all of the Inline Structure data are entered, press the Apply Data button in
order for the interface to accept the data. The editor can then be closed by
selecting Exit from the File menu at the top of the window.

L - Overview of HEC-RAS/Brunner
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~ Lateral Structure Editor
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~. Hydrologic Engineering Center

Lateral weir, gated spillway, and culvert data are entered in a similar manner as
bridge and culvert data. To enter a lateral structure, press the Lateral Structure
button from the Geometric Data window. Once this button is pressed, the Lateral
Structure Data editor will appear as shown above (except yours will be blank until
you have entered some data) .

13
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a: Storage Area Editor
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Hydrologic Engineering Center

Storage Areas are lake like regions in which water can be diverted into or from.
Storage areas can be located at the beginning of a reach, at the end of a reach, or
they can be located laterally to a reach. Storage areas can be connected to a river
reach by using a lateral structure connection. Storage areas can be connected to
another storage area by using a storage area connection. Storage area connections
can consist of a weir and gated spillways; a weir and culverts; just a weir; or a linear
routing option. An example river system with storage areas is shown in above.

To add a storage area to the river system, first use the storage area drawing tool at
the top of the geometric editor. Once the storage area, drawing tool is selected, the
user single clicks the left mouse button to begin drawing the storage area.
Additional points are added by moving the mouse and single clicking. The storage
area will be represented as a polygon. To finish drawing the storage area, double
click the left mouse button. The first and last point will then be connected, and the
storage area will be filled in with a blue color. The user will then be prompted to
enter a name for the storage area.

After the storage area is drawn and labeled, the user must enter data to describe the
storage area. This is accomplished with the storage area editor, which is one of the
buttons on the left side of the geometric editor.

•
L - Overview of HEC-RAS/Brunner 14
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Storage Area Connections

~ Hydrologic Engineering Center 15
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Storage Area connections are used to link two storage areas together with a
hydraulic structure. Storage area connections can consist of a weir; culverts and a
weir; gated spillways and a weir; or a linear routing option. To establish a hydraulic
connection between two storage areas, press the "Storage Area Conn" button at the
top of the geometric data window. Once the storage area connection drawing tool is
invoked, the user simple presses the left mouse button one time while over the from
storage area, then double click the left mouse button while over the too storage area.
This establishes the connection between the storage areas, as well as what is
considered to be the positive flow direction.

Once a connection is made between two storage areas, the user must enter
information describing the hydraulics of the connection. This is accomplished by
pressing the Storage Area Conn editor button on the left hand side of the geometric
data editor.

Inlin.
Stfuott...

'IIIiiI;IJ'

View
PIc1uro
• ; r-'-' ~-..-..-_.-_...._ ..------- .

:-~----_.._ - __.--- -.-..--_.~-----.·---·-----CU01~5···

Letenlll
Suuelur•........

•

•
L - Overview ofHEC-RAS/Brunner 15



[i] Pump Stations
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•A pump station can be used to pump water between two storage areas, a storage
area and a river reach, or between two river reaches. Each pump station can have
up to ten different pump groups, and each pump group can have up to twenty
identical pumps. To add a pump station to the system, select the Pump Station
drawing tool at the top of the geometric data editor. When this button is pressed,
the mouse icon will change to a set of cross hairs with a pump. Move the mouse to
the location that represents where the pump station will be pumping from, press the
left mouse button to start the connection. Next, move the mouse to the location
where the pump station will be pumping too, then press the left mouse button again.
This will establish a pump station connection between two elements.

Once a pump station is added to the system, the user must edit the pump station and
fill in the required data. To bring up the pump station editor, select the pump
station editor button on the left hand side of the geometric data editor, or move the
mouse over the pump station icon on the schematic, press down on the left mouse
button, then select Edit Pump Station.

L - Overview ofHEC-RAS/Brunner
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Once the geometric data are entered, the modeler can then enter either steady flow
or unsteady flow data. The type of flow data entered depends upon the type of
analyses to be performed.

•

•

•

Flow Data and Boundary Conditions

• Steady flow data - Peak flows or time lines
• Unsteady flow data - Hydrographs
• Boundary Conditions

• Stage and/or flow hydrographs
• Rating Curves
• Normal or critical depth
• Lateral and uniform lateral inflow hydrographs
• Groundwater interflow
• Time series of gate openings
• Elevation controlled gates
• Navigation Dam Operations
• Gates controlled by User Defined Rules

: '.,: Hydrologic Engineering Center 17
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Steady Flow Data and Boundary
Conditions Editor

Once all of the geometric data are entered, the modeler can then enter any steady
flow data that are required. To bring up the steady flow data editor, select Steady
Flow Data from the Edit menu on the HEC-RAS main window.

The user is required to enter the following information: the number of profiles to be
calculated; the peak flow data (at least one flow for every river reach and every
profile); and any required boundary conditions. The user should enter the number
of profiles first.

After all of the flow data have been entered into the table, the next step is to enter
any boundary conditions that may be required. To enter boundary conditions data
press the Boundary Conditions button at the top right of the steady flow data
editor.

Boundary conditions are necessary to establish the starting water surface at the ends
of the river system (upstream and downstream). A starting water surface is
necessary in order for the program to begin the calculations. In a subcritical flow
regime, boundary conditions are only necessary at the downstream ends of the river
system. If a supercritical flow regime is going to be calculated, boundary
conditions are only necessary at the upstream ends of the river system. If a mixed
flow regime calculation is going to be made, then boundary conditions must be
entered at all ends of the river system.

L - Overview ofHEC-RAS/Brunner
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• Unsteady Flow Data and Boundary
Conditions Editor

1.1 L-01
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To bring up the unsteady flow data editor, select Unsteady Flow Data from the
Edit menu on the HEC-RAS main window. The user is required to enter boundary
conditions at all of the external boundaries of the system, as well as any desired
internal locations, and set the initial flow and storage area conditions at the
beginning of the simulation.

Boundary conditions are entered by first selecting the Boundary Conditions tab
from the Unsteady Flow Data editor. River, Reach, and River Station locations of
the external bounds of the system will automatically be entered into the table.
Boundary conditions are entered by first selecting a cell in the table for a particular
location, then selecting the boundary condition type that is desired at that location.
Not all boundary condition types are available for use at all locations. The program
will automatically gray-out the boundary condition types that are not relevant when
the user highlights a particular location in the table. Users can also add locations
for entering internal boundary conditions. To add an additional boundary condition
location, select the desired River, Reach, and River Station, then press the Add a
Boundary Condition Location button.

•

•
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1.1 L-01
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IEnter 10 compute water surface profiles

Once all of the geometry and steady flow data have been entered, the user can begin
calculating the steady flow water surface profiles. To perform the simulations, go to the
HEC-RAS main window and select Steady Flow Analysis from the Run menu. The Steady
Flow Analysis window will appear as shown above.

The first step in performing a simulation is to put together a Plan. The Plan defines which
geometry and flow data are to be used, as well as provide a description and short identifier
for the run. Also included in the plan information are the selected flow regime and the
simulation options.

Before a Plan is defined, the user should select which geometry and flow data will be used
in the plan. To select a geometry or flow file, press the down arrow button next to the
desired data type. When this button is pressed, a list will appear displaying all of the
available files of that type that are currently available for the project. Select the geometry
and flow files that you want to use for the current plan.

To establish a Plan, select New Plan from the File menu on the steady flow analysis
window. When New Plan is selected, a window will appear prompting you to enter a title
for the plan. After you enter the title, press the OK button to close the window and accept
the title. The user will also be prompted to enter a short identifier for the plan. The short
identifier is limited to 16 characters. It is very important to enter a short identifier that is
descriptive of the plan. When viewing multiple plan output from the graphics and tables,
the Short ID will be used to identify each plan.

The last step is to select the desired flow regime for which the model will perform
calculations. The user can select between subcritical, supercritical, or mixed flow regime
calculations.

:'1': Hydrologic Engineering Center 20
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• Unsteady Flow Hydraulic Computations

1.1 L-01

Once all of the geometry and unsteady flow data have been entered, the user can
begin performing the unsteady flow calculations. To run the simulation, go to the
HEC-RAS main window and select Unsteady Flow Analysis from the Run menu.
The Unsteady Flow Analysis window will appear as shown above.

•

•

1. Define a Plan

2. Select which
programs to run

3. Enter the simulation ,...------!'o,.

time window L....--y'

4. Set the computational
settings c:::>

5. Press the
compute button

Hydrologic Engineering Center
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After the model has finished the steady or unsteady flow computations the user can
begin to view the output. Output is available in a graphical and tabular format. The
current version of the program allows the user to view cross sections, water surface
profiles, general profiles, rating curves, hydrographs, X-Y-Z perspective plots,
detailed tabular output at a single location, and summary tabular output at many
cross sections. Users also have the ability to develop their own output tables.

Viewing Results~g

• Graphics
• Cross sections B
• Water surface profiles~
• Generic plots - Any variable in profile~
• Rating Curves [E]
• XYZ Plot ~
• Stage and flow hydrographs ~
• Animation - (cross section, profile, 3D plots)

• Tabular Output
• Pre-defined detailed tables ~
• Pre-defined summary tables [j]
• User-define output tables

:••• : Hydrologic Engineering Center
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• Cross Section Plot

1.1 L-01
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To view a graphic on the screen, select Cross Sections, Water Surface Profiles,
Rating Curves, or any other graphic option from the View menu on the HEC-RAS
main window. Once you have selected one of these options, a window will appear
with the graphic plotted in the viewing area. An example cross-section plot is
shown above. The user can plot any cross section by simply selecting the
appropriate reach and river station from the list boxes at the top of the plot. The
user can also step through the cross section plots by using the up and down arrows.

:•• ,: Hydrologic Engineering Center
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Profile Plot
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An example profile plot is shown above. The profile plot displays the water surface
profile for the first reach in the river system. If there is more than one reach,
additional reaches can be selected from the Options menu on or the reach button at
the top of the window.
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• Rating Curves

1.1 L-01
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An example rating curve plot is shown in above. The rating curve is a plot of the
water surface elevation versus flow rate for the profiles that were computed. A
rating curve can be plotted at any location by selecting the appropriate reach and
river station from the list boxes at the top of the plot.

•

•

: ••• : Hydrologic Engineering Center 25

L - Overview ofHEC-RAS/Brunner 25



XYZ Plot

1.1 L-01
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•Another type of graphic available to the user is the X-Y-Z Perspective Plot. The X
Y-Z plot is a 3-dimensional plot of multiple cross sections within a reach. An
example X-Y-Z Perspective plot is shown in above.
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• Stage and Flow Hydrographs

1.1 L-01
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If the user has performed an unsteady flow analysis, then stage and flow
hydrographs will be available for viewing. To view a stage and/or flow hydrograph,
the user selects Stage and Flow Hydrographs from the View menu of the main
HEC-RAS window. When this option is selected a plot will appear as shown above.
The user has the option to plot just the stage hydrograph, just the flow hydrograph,
or both as shown in the figure. Additionally, there are three tabs on the plot. The
tabs are for plotting (Plot), viewing the data in tabular form (Table), and plotting a
rating curve of the event (Rating Curve). By default the window comes up in a
plotting mode.

The stage and flow hydrograph plot also has a menu option to select the specific
node types to be viewed. By default the plot comes up with a node type of cross
section selected. This allows the user to view hydrographs at cross sections only.
Other available node types include: Bridges/Culverts; Inline Structures; Lateral
Structures; Storage Areas; Storage Area Connections; and Pump Stations.

Additional output for the hydrograph plot includes statistics about the hydrographs
(peak stage and flow, time of peak, and volume). Also, the user can simultaneously
plot observed hydrograph data at locations where they have gaged information
stored in a DSS file. The user attaches gaged hydrograph information to cross
section locations from the Unsteady Flow Data editor.

:-t.: Hydrologic Engineering Center 27
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Detailed Tabular Output
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Detailed output tables show hydraulic information at a single location, for a single
profile. To display a detailed output table on the screen, select Detailed Output
Tables from the View menu of the main HEC-RAS window. An example detailed
output table is shown above.

By default, this table comes up displaying detailed output for cross sections. Any
cross section can be displayed in the table by selecting the appropriate river, reach
and river station from the list boxes at the top of the table. Also, any of the
computed profiles can be displayed by selecting the desired profile from the profile
list box. Additionally, different plans can be viewed by selecting a plan from the
plan list box.

Users can also view detailed hydraulic information for other types of nodes. Other
table types are selected from the Type menu on the detailed output table window.

L - Overview ofHEC-RAS/Brunner
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•

Profile summary tables are used to show a limited number of hydraulic variables for
several cross sections. To display a profile summary table on the screen, select
Profile Summary Table from the View menu of the main HEC-RAS window. An
example profile summary table is shown above.

here are several standard table (Std. Tables) types available to the user. Some of the
tables are designed to provide specific information at hydraulic structures (e.g.,
bridges and culverts), while others provide generic information at all cross sections.

•
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Besides computing steady and unsteady flow water surface profiles, HEC-RAS has
several options to perform specific types of simulations. Some of the unique
simulation options contained in HEC-RAS are listed above.

Simulation Options

• FEMA Floodway Analysis

• Channel Design/Modifications

• Bridge Scour Analysis

• Detailed Velocity Distribution

• Mixed Flow Regime in Unsteady Flow

• Dam Break Analysis

• Levee Breaching and Overtopping

• Navigation Dams

:,.,: Hydrologic Engineering Center
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• FEMA Floodway Analyses
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The evaluation of the impact of floodplain encroachments on water surface
profiles can be of substantial interest to planners, land developers, and engineers.
Floodplain and floodway evaluations are the basis for floodplain management
programs. Most of the studies are conducted under the National Flood Insurance
Program and follow the procedures in the "Flood Insurance Study Guidelines and
Specifications for Study Contractors," FEMA 37 (Federal Emergency
Management Agency, 11085).

HEC-RAS contains five optional methods for specifying floodplain
encroachments. For information on the computational details of each of the five
encroachment methods, as well as special considerations for encroachments at
bridges, culverts, and multiple openings.

Floodwav Definitions:

FLOODPLAI : The channel ofa water course and those portions of the adjoining land area
which are required to carry a flood.

FLOO 0 WAY: The channel of a water course and the adjacent land areas that must be reserved
in order to discharge the base flood without cumulatively increasing the water-surface elevation
more than a designated height. (FEMA 37)

FLOODWAY FRINGE: That portion of the floodplain between the floodway and the natural
outline of the floodplain of the base flood.

L - Overview ofHEC-RAS/Brunner 31



Channel Design/Modification Editor
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The channel design/modification tools in HEC-RAS allow the user to perform a
series of trapezoidal cuts into the existing channel geometry or to create new
channel geometry. The current version of HEC-RAS has two tools for performing
channel modifications. These tools are available from the Tools menu of the
Geometric Data editor and are labeled Channel Design/Modification and Channel
Modification (original). The tool labeled Channel Design/Modification is a new
tool for HEC-RAS version 4.0. The tool labeled Channel Modification (original)
is the original channel modification tool developed for HEC-RAS. The original
channel modification tool has been left in HEC-RAS for those user's who may
prefer this tool to the new one. Both channel modification tools will be described in
this chapter. In general, these tools are used for planning studies, but it can also be
used for hydraulic design of flood control channels.

L - Overview of HEC-RAS/Brunner
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• Bridge Scour Analysis

1.1 L-01
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The computation of scour at bridges within HEC-RAS is based upon the methods
outlined in Hydraulic Engineering Circular No. 18 (FHWA, 2001). Before
performing a scour analysis with the HEC-RAS software, the engineer should
thoroughly review the procedures outlined in the Hydraulic Engineering Circular
No. 18 (HEC 18) report.

After performing the water surface profile calculations for the design events, and
computing the flow distribution output, the bridge scour can then be evaluated. The
total scour at a highway crossing is comprised of three components: long-tenn
aggradation and degradation; contraction scour; and local scour at piers and
abutments. The scour computations in the HEC-RAS software allow the user to
compute contraction scour and local scour at piers and abutments. The current
version of the HEC-RAS software does not allow the user to evaluate long-term
aggradation and degradation. Long term aggradation and degradation should be
evaluated before performing the bridge scour analysis. Procedures for performing
this type of analyses are outlined in the HEC No. 18 report.

33

Leuend

WSPfl

0;;;;;;-
~

""If.
Brista

Corrtr Scour

Total SCOlX

Bridge Scour RS =10.36

10

Steiion(tt)

·10

L.1l 0,,,,,,,,, RV<
• 1ft, ~07 &65
c lftls~ 2.63 2.99

EQUation: CIe¥ Live

Yl:

Vl:

Y1l:

02:

W2:
D5Olmm,
EQUation:

AoploochXS Aivel St... bO'8 3
1 • •• ·_·_

HIe: fHuchulC OMi:rl Data HD F~e: fQ\HEC Data\RAS\SteadIJ Flow El(~oIes\SCOUR.hOl

Aiv« Ip.... D.ok 3p,oIae, IpF1 3 ~~

A.och, l""eD.ok ..:J A"",S'. f:c11O:":':36:-:B'="A--"':3=i· .~J!J IC~§e;;[.=11 ~ R.p"" .

Con••ction 1Pie< I Abutmentl
LOB Chonnol ROB

~~~
~~~
~~r-
1J3!'3 19 126146.81 r
121~!J6 130036 r-
~~~
IDeI...::J ID"'...3 IDeI~.::J

(LNe Bed Speclic 0 ~ ,

i01: 1i56~.~8 IH~68.?3 175f:~.~8

1Wl, Iss' &l 1'00.00 196. &l

iKl, ~fQ.59iJ ro:sso- ro:sw-

:•• ,: Hydrologic Engineering Center

•

•
L - Overview ofHEC-RAS/Brunner 33



Velocity Distribution
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The user has the option of plotting velocity distribution output from the cross
section viewer. Velocity distributions can only be plotted at locations in which the
user has specified that flow distribution output be calculated during the
computations. To view the velocity distribution plot, first bring up a cross section
plot (select "Cross Sections" from the view menu of the main HEC-RAS window).
Next, select the cross section in which you would like to see the velocity
distribution output. Select Velocity Distribution from the Options menu of the
cross section window. This will bring up a pop up window that will allow you to
set the minimum velocity, maximum velocity, and velocity increment for plotting.
In general, it is better to let the program use the maximum velocity range for
plotting. Next, the user selects Plot Velocity Distribution, then press the "OK"
button and the velocity distribution plot will appear as shown above.
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Mixed Flow Regime for Unsteady Flow

• Subcritical and Supercritical Flow

• Hydraulic Jumps
• Draw Downs (sub to super)

:,.,: Hydrologic Engineering Center

Modeling mixed flow regime (subcritical, supercritical, hydraulic jumps, and draw
downs) is quite complex with an unsteady flow model. In general, most unsteady
flow solution algorithms become unstable when the flow passes through critical
depth. The solution of the unsteady flow equations is accomplished by calculating
derivatives (changes in depth and velocity with respect to time and space) in order
to solve the equations numerically. When the flow passes through critical depth, the
derivatives become very large and begin to cause oscillations in the solution. These
oscillations tend to grow larger until the solution goes completely unstable.

In order to solve the stability problem for a mixed flow regime system, Dr. Danny
Fread (Fread, 1986) developed a methodology called the "Local Partial Inertia
Technique." The LPI method has been adapted to HEC-RAS as an option for
solving mixed flow regime problems when using the unsteady flow analysis portion
ofHEC-RAS. This methodology applies a reduction factor to the two inertia terms
in the momentum equation as the Froude number goes towards 1.0.

1.1 L-01
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Mixed Flow Regime Example
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A profile plot of a mixed flow regime problem is shown above. This example was
run with the unsteady flow simulation capability within HEC-RAS using the mixed
flow regime option. The example shows a steep reach flowing supercritical, which
then transitions into a mild reach. A hydraulic jump occurs on the mild reach. The
mild reach then transitions back to a steep reach, such that the flow goes from
subcritical to supercritical. Because of a high downstream boundary condition (for
example backwater from a lake), the flow then goes from supercritical to subcritical
though another hydraulic jump.

500
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• Cross Section and Profile Animation of
Breach
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HEC-RAS can be used to model both overtopping as well as piping failure breaches
for earthen dams. Additionally, the more instantaneous type of failures of concrete
dams (generally occurring from earthquakes) can also be modeled. The resulting
flood wave is routed downstream using the unsteady flow equations. Inundation
mapping of the resulting flood can be done with the HEC-GeoRAS program
(companion product to HEC-RAS) when GIS data (terrain data) are available. An
example plot of the Dam and the profile for a Dam Break analysis is shown above.

•
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Profile Plot of Levee Breach
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•

Levee overtopping and breaching can be analyzed within HEC-RAS by modeling
the levee as a lateral structure. When modeling a levee with a lateral structure, the
area behind the levee should not be included in the cross section data of the main
river. The cross sections should stop at the bottom of the levee. The lateral
structure (levee) can be connected to a storage area or another river reach. The
strategy for modeling the area behind the levee will depend upon what will happen
to the water if the levee overtops or breaches. If the water going over or through the
levee will pond, then a storage area would be more appropriate for modeling the
area behind the levee. If the water will continue to flow in the downstream
direction, and possibly join back into the main river, then it would be more
appropriate to model that area as a separate river reach.

: ••• : Hydrologic Engineering Center 38
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• Navigation Dam Operations

1.1 L-01

Navigation Dam Operations can be used to control gate operations to maintain an
upstream water surface elevation (Hinge point).

For a navigation dam, the program will try to maintain both a minimum and
maximum water surface at one or more locations along a navigation channel. The
program does this by controlling the gate settings on an inline structure. The user
enters a target water surface (and various other calibration data) and the program
will adjust the gate settings at user specified time intervals in order to meet the
target water surface as closely as possible.

•

•

Hinge Point Locations

/

:, •• : Hydrologic Engineering Center 39
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Navigation Dams

Sf Paul Plan: Lock and Dam 6 Test Run
Oeom:l8.06 Flow:

1.1 L-01
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Shown in the example above is lock and dam no. 6 on the Mississippi river.

L - Overview ofHEC-RAS/Brunner
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•

Recently Added Features

• Overflow Gates
• User Defined Rules for Gate Operations

• Pressure Flow in Pipes

• Pump Station Rules

• Geo-referencing Tools
• Water Quality - Temperature Modeling

• SIAM (Sediment Impact Analysis Module)
• Sediment Transport (erosion and deposition)

:••• : Hydrologic Engineering Center 41
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Overflow Gates Example

1.1 L-01

•
Test of Overflow Gales Plan: Open Air Gates - Complex Network 12/19f2005
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The example above demonstrates the use of overflow gates for both an inline and a
lateral structure.
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The operating procedures for determining and controlling the releases from
reservoirs and other types of hydraulic structures can be quite complex. HEC-RAS
allows flexibility in modeling and controlling the operations of gates at hydraulic
structures through the use of rules (Figure above). Examples of variables that could
be used to control releases from a hydraulic structure are: current flows and water
surfaces at the structure, current flows and stages at a downstream or upstream cross
section location, time considerations (winter, morning, etc), and/or previously
computed values (accumulated outflows, running averages, etc). Rule operations in
HEC-RAS are available for inline hydraulic structures, lateral hydraulic structures,
and storage area connections that contain gates .

•

•
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Generic Rules Example
Tampa Bay Water Project Hillsborough River - Har ey Canal

G~c:tricDafa . HRlBC Hilbborougb 08132003 • v _ ~(Q)(R)
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•Sown above is an example data set in which rules have been applied to control gate
settings in order to control flow going from the main river to a canal. This example
is a water supply model in which water is taken from the main river for use as
drinking water for the city of Tampa Bay, FL. The rules for how much water can be
taken on any given day are quite complex. The new HEC-RAS Rules Editor
allowed these rules to be modeled in an automated fashion within the simulation
process.

L - Overview of HEC-RAS/Brunner
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• Pressurized Pipes, Pump Station,
And Levee Breach Animation

1.1 L-01

HEC-RAS can be used to model pressurized pipe flow during unsteady flow
calculations. This is accomplished by using the Priessmann slot theory applied to
the open channel flow equations. To model pressure flow with HEC-RAS, the user
must use cross sections with a Lid option. The cross section is entered as the
bottom half of the pipe and the Lid is entered as the top half of the pipe. Any shape
pipe can be modeled, however, the details of the pipe shape will depend on how
many points the user puts in for the bottom (cross section) and the top (Lid) .

45
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Pump Station Override Rules
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1.1 L-01

•

Advanced control rules have been added to the Pump Station capabilities of HEC
RAS in order to override normal pump operations. Override rules make it easy to
tum pumps on and off based on time of day, as well as target flows and stages from
any location in the model. Rules can also be set to override the total pump station
maximum or minimum flow capacity.

Plot PtI'np u..ves ...
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GIS Tools in HEC-RAS--
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Hydrologic Engineering Center

If cross sections are added to an HEC-RAS model from the cross section editor or
through the HEC-2 import feature, the user will need to enter the coordinates of the
cross section cut lines to develop a geo-spatially referenced schematic. The cross
section cut line coordinates can be entered by selecting XS Cut Lines Table from
the GIS Tools menu on the Geometric Data editor window. The coordinates for the
river network can be entered similarly by selecting Reach Invert Lines Table from
the GIS Tools menu.

The coordinates that are entered for the cross section cut lines must be consistent
with the previously entered GIS data (i.e. if the GIS data is in state plane
coordinates, then the user entered data must also be in state plane coordinates).
Once all of the cross section cut lines have consistent coordinates, the schematic and
XYZ plot will display the cross sections geo-spatially correct.

1.1 L-01
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1.1 L-01

HEC-GeoRAS •

HEC-GeoRAS is a pre and post-processor for assisting engineers in performing river
hydraulics studies. GeoRAS is designed to work seamlesslessly with HEC's River Analysis
System (HEC-RAS). GeoRAS can be used to pre-process geometric data for import into
RAS and can be used as a post-process to RAS to create inundation maps from RAS results.

• Pre-processor for
generating geometric data
for HEC-RAS

: '.,: Hydrologic Engineering Center

• Post-processor for
mapping and displaying
results from hydraulic
simulations

48
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Truckee River Animation

I:~:l Hydrologic Engineering Center
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Water Quality (Temperature) Model

• Based on unreleased version of CE-QUAL-RIV1

• QUICKEST-ULTIMATE numerical scheme

• Finite Volume
• Variable grid size
• Automatic time step selection

• Full energy budget

Of Hydrologic Engineering Center
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• Source/Sink Term for Temperature
(Energy Budget)

1.1 L-01

!J.<JUt> solar radiation (qsw)
f:$V't:::,

f (site location, time of day, day of year,
atmospheric turbidity, cloud cover)

• ground heat conduction

• shading (topographic, riparian)

Planned:

f (air temperature, water temperature)

f (temperature gradient, wind, a&b)

qnet =qsw +q/wn +qh +qe

latent heat (qe) f (vapor pressure gradient, wind, a&b)

)
sensible heat (qh)

net longwave radiation (qlw)

•
Hydrologic Engineering Center 51

The water quality model will compute the source term. In this case the energy balance.
We'll compute each term as a function of atmospheric parameters and water temperature.

Shortwave is a function of location of sun, atmospheric conditions, time of day and year. It
may be measured directly or we have a tool to compute.

Longwave radiation comes from atmosphere, and it is also radiated by the water surface.
Changes with water temperature and air temperature.

Sensible heat is also called conduction. Air mass above the water interface conducts heat
into a parcel of water. Function of the temperature gradient and turbulence which we'll
characterized with mean wind speed and a fitting parameter.

•
Latent heat is evaporation. As water evaporates, it changes phase and loses energy in the
form of heat. As water evaporates, it cools. This is a function of the vapor gradient
(humidity) and turbulence characterized by wind speed and a fitting parameter.

Sensible and latent are collectively called the surface fluxes and are the primary calibration
variables.

L - Overview ofHEC-RAS/Brunner 51



Water Quality Input Data Editor

1.1 L-01

•

Solar radiation can be entered directly, or can be computed from lat/long and fitting
parameters, these plots are measured and computed solar radiation. Useful for synthetic
data creation, as well as filling in gaps in data sets.

Hydrologic Engineering Center

•
52

12

Radiation

10 1106 07 08 09
Sep97
Dot,

03 04 05

Met

400 .

200

j-!f'="""':''''- -"'' S.'Um" jW/m2 31141Spo....."''''.d.me><.S33.min.OI

IC::::;:@lnm~::::.._...)1

S-'Cramento Mo!IinSlem 107750.0
SCtCtarnento MainStem 104691.8
Saclamento MainStem 101162.1
SacJamento MainStem 95950.74
Saclamenl:o MainStem 91742.10
Saclamento MainStem 85522.44 tit!

~

SoOCl'amento Aiver
f;':! Be Bound~y Conditions

"" \I Sacramenlo MainSlem 11
\1 :~.:!<::r<lm~r"ltoM<:!~')S!.;m ~~X14.

\1 S')('I"hr.~,;',:,Mili!'lSWm~4'B

.. \1 S<:crafWj~oM..'}~'I$;£f') 80')~'::1 16
lC InilielConcitions

.... 9 Dispefsion Coefficients
f;j-.rt:iJ: MeleOfo!ogy D<!Itesels

F::l·(tF Sacramento River ILIMlo Secol
"! Atmospheric Pressure

, .. J A' Temperalure
, "HumOly
;..~ ShOJI W<!Ive Radation
'··QCloudi'less
: ..~ Wind Speed

~2' L Water Qualay Paramelets
"tt N~ooen

.. .,(.D. Phosphorus

... A1\)ae
0-2 Dissolved OKygen

Sedinent Interaction

•
L - Overview of HEC-RAS/Brunner 52



1~~~V~~f~~-'~"';-,-
't • , ,...... . . ,

• Time Series Plots

li::i.,B",.,"':.-';;.,~",r*~.-""""'¥~ -~"7::' ., fIjfW~~ $,~J~
·..,U)ltj,· Illtt.l':t,
,*"H:mJ'''''"~'.... n""~· .IUl*.~
...,.l~'-"at\,,~~

... 1~·\oll_'
.... U11lllot' \o!lt1lf!-
... Utl"ll' .UII!!:"
__ ~'tJll.' "1'1::.:-
.. Jt,,*·.HI~'

j
;:=~:\.~~~~
....,., J <Jlllit'''·
...,,~..--~
::: ,.::=:
_ ...... • NIo/I(.;J

Ii :;=~:=:I";*"" ~~~

Water temperature

1.1 L-01

These two time series plots compare water temperature and solar radiation, but could be
many different variables, including hydrodynamics.
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Profile Plot of Temperature

1.1 L-01

•

•
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• Map View of Temperature Animation

1.1 L-01

•

•
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HEC-RAS Animation of Temperature,
Algae, and Dissolved Oxygen

1.1 L-01
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Mobile Bed Sediment Transport

• Quasi-Steady Hydrodynamics
• Transport Capacity
• Sediment continuity
• Sorting and Armoring
• Erosion and Deposition
• Graphical User Design

I:~:I Hydrologic Engineering Center
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Goals of adding Sediment Routing into
HEC-RAS

• Replicate the capabilities of HEC-6
• Re-coding general capabilities in RAS

• Differences exist in hydraulic computations

• Add new capabilities beyond current HEC-6
Features

• Improve the capabilities where we have know
deficiencies

Hydrologic Engineering Center
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•

Transport Potential Functions

-Ackers-White

-Englund-Hansen

-Laursen (Copland)

-Myer-Peter-Meuler

-Toffaleti

-Yang (Sand and Gravel)

- Wilcock
I:~:t Hydrologic Engineering Center
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Transport Capacity

• Bed Material and Inflowing Load divided into
separate grain classes (up to 20)

• Transport potential is calculated for each grain
size

• Transport Capacity =(Transport Potential for
each grain size) X (fraction of that material in
active layer of bed)

I:~:I Hydrologic Engineering Center
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• Sediment Continuity: Exner Equation

1.1 L-01

Lambda = porosity of the material

Nu = depth of erodeable material

Qs = average sediment discharge rate during the time step

•

•

:, •. : Hydr

r--
Stream Bed I

Surface

I Model Bottom
(Bed Rock)

Control Volume at
Cross Section 2

--
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Temporal Constraints on Eroding and
Depositing

• Erosion and deposition does not occur
instantaneously.

• Deposition is based on settling velocity:
• Deposition efficiency coefficient =

• Erosion is based on "Characteristic Flow Length"
• Erosion = (Gs - Qs) x Ce Entrainment Coefficient

• Where:

:••• : Hydrologic Engineering Center

Vs = settling velocity by grain size; De = effective depth of water (average water
depth)

Gs = Transport Capacity; Qs = Current load in the flow field; Ce = Entrainment
coefficient

Cover layer constraint is also applied when you have erosion occurring.

L - Overview ofHEC-RAS/Brunner
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Sorting and Armoring

Hydrologic Engineering Center 63

Exner 5
implemented
Currently in RAS

Diagramed and
Conceptualized
HEC 6 Code

Active
Layer

Bedrock Layer

Also Simple
Active Layer
Method

* Erosion can be further constrained by the cover Layer

Cover Layer }

1111111111Subsurface Layer

Inactive Layer
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Erosion and Deposition
to RAS Cross Sections •
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• Animation of Bed Movement
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Bed gradations vary per cross section, courser at upstream boundary, finer at second
cross section.
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•
Data Requirements for
Unsteady Flow Models

Cameron Ackerman, P.E.

1.2 L-02

•

•

The objective of this lecture is to discuss geomtric data options in HEC-RAS and
how the geometric pre-processsor uses the geometric to preprocess hydraulic
tables for use in unsteady flow simulations.

Geometry Requirements\GWB\CTA 1



Geometry Preprocessor
I

• What does it do?
• Process~,s geometric data into a series of

hydraulic tables and rating curves .

• Why do we use it for unsteady flow?
• Instead 6f calculating hydraulic variables for

each croSs-section during each iteration, the
program! interpolates the hydraulic variables
from the, tables.

2

The preprocessor is us~d to process the geometric data into a series of
hydraulic property tables and rating curves. This is done in order to speed
up the unsteady flow ccUculations. Instead of calculating hydraulic variables
for each cross-section Quring each iteration, the program interpolates the
hydraulic variables frorrjl the tables. The preprocessor must be executed at
at least once, but then only needs to be re-executed if something in the
geometric data has ch~nged.

Geometry Requirements\GWB\CTA
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Hydraulic Property Plot
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3

Cross sections are processed into tables of elevation versus hydraulic
properties of areas, conveyances, and storage. Each table contains a
minimum of 21 points (a zero point at the invert and 20 computed values).
The user is required to set an interval to be used for spacing the points in the
cross section tables. The interval can be the same for all cross sections or it
can vary from cross section to cross section. This interval is very important,
in that it will define the limits of the table that is built for each cross section.
On one hand, the interval must be large enough to encompass the full range
of stages that may be incurred during the unsteady flow simulations. On the
other hand, if the interval is too large, the tables will not have enough detail
to accurately depict changes in area, conveyance, and storage with respect
to elevation.

1.2 L-02
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Conveyance Calculations

• Manning's Equation

K = 1.486 AR2/ 3

n

4

Conveyance is calculat~d from the above form of Manning's equation (based
on English units):

1.2 L-02

•

•
where:

K = conveyiance for subdivision

= Mannirig's roughness coefficient for subdivision
i

= flow area for subdivision

= hydraulic radius for subdivision (area I wetted perimeter)

= friction ,slope

•
Geometry Requirements\GWB\CTA 4



•

•

•

Conveyance Calculations

.. n1 112 nch n3 ,
~1P11 A2 P2 Ach Pch A3 P3 ~~ -- - - -

Klob =K1 + K2 Krob =K3- -
Kch

5

The determination of total conveyance and the velocity coefficient for a cross
section requires that flow be subdivided into units for which the velocity is
uniformly distributed. The approach used in HEC-RAS is to subdivide flow in
the overbank areas using the input cross section n-value break points
(locations where n-values change) as the basis for subdivision.

The program sums up all the incremental conveyances in the overbanks to
obtain a conveyance for the left overbank and the right overbank. The main
channel conveyance is normally computed as a single conveyance element.
The total conveyance for the cross section is obtained by summing the three
subdivision conveyances (left, channel, and right) .

1.2 L-02
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Cross Section Example
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Cross Section Table Parameters

7

The Geometric Data Editor is shown in the above figure. From this editor,
select the button labeled Htab Paramo to view and edit the cross section
table parameters.

1.2 L-02
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Cross S~ction Table Parameters

• Starting EI~vation

• Increment
• Number of Points

8

1.2 L-02

•

As shown in the figure, ,the table contains three columns in which the user ."
can enter information: starting elevation; increment; and Number of Points.
The first time the user qpens this editor all of the columns are automatically
filled. The starting elevation columns are automatically filled to an elevation
one foot higher than thEf invert, however, the user can change these values
to whatever they want. ! The second and third columns are used for the table
increment and the number of points. These two variables will describe the
extent to which the tabl~ encompasses the cross section data. A default
value will be set for the. increment and the number of points. Normally the
increment will be set to,one foot, and the number of points will be set to a
value that will allow the,table to extend to the top of the cross section. If this
combination would end, up with less than 20 points, then the number of
points is set to 20 and t~e increment is reduced to get the table to the top of
the cross section. The luser can set these values individually for each cross
section, or they can highlight a series of cross sections and use the Set
Values button to enter the value for all of the highlighted sections. Other
options are available to multiply highlighted fields by a factor or add a
constant to all of them.. Additionally, cut, copy, and paste buttons are
available for manipulating the data.

•
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Entering Geometric
Parameters

• Manning's n Values
• Ineffective Flow Areas

• Non-Permanent vs. Permanent
• Normal vs. Multiple Blocks

• Blocked qbstruction

• Levees

9
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Entering Geometric Parameters

....~, [Geometric Data Editor I

10

The Geometric Data Editor is shown in the above figure. From this editor,
select the button labele'd Cross Section to view and edit the cross section
geometry.

Geometry Requirements\GWB\CTA
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Manning's n Values
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11

Selection of an appropriate value for Manning's n is very significant to the
accuracy of the computed water surface profiles. The value of Manning's n
is highly variable and depends on a number of factors including: surface
roughness; vegetation; channel irregularities; channel alignment; scour and
deposition; obstructions; size and shape of the channel; stage and
discharge; seasonal change; temperature; and suspended material and
bedload.

1.2 L-02
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Manning's n Values
i

1.2 L-02

•

The above figure iIIustrc::)tes the horizontal variation in Manning's n values
along the cross section.
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•
There are several references a user can access that show Manning's n
values for typical channiels. An extensive compilation of n values for streams
and floodplains can be found in Chow's book "Open-Channel Hydraulics"
[Chow, 1959]. Excerpts from Chow's book, for the most common types of
channels, are shown in iTable 3.1 of the Hydraulic Reference Manual for
HEC-RAS version 3.0 on pages 3-14 and 3-15.

Geometry Requirements\GWB\CTA

•
12



•

•

•

Entering Geometric
Parameters

• Manning's n Values
• Ineffective Flow Areas

• Non-Permanent vs. Permanent
• Normal vs. Multiple Blocks

• Blocked Obstruction

• Levees

13
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Ineffective Flow Areas

• Areas where water is not actively being
conveyedl The velocity of water in the
downstre~m direction is close to zero.

• This water is included in the storage
calculations and other wetted cross
section parameters, but it is not included
as part of, the active flow area.

14
.

This option allows the user to define areas of the cross section that will
contain water that is not actively being conveyed (ineffective flow).
Ineffective flow areas are often used to describe portions of a cross section
in which water will pone!, but the velocity of that water, in the downstream
direction, is close to zero. This water is included in the storage calculations

I

and other wetted cross isection parameters, but it is not included as part of
the active flow area.

In unsteady flow mode Ing it is important to account for channel storage as
well as conveyance. In steady flow modeling it is sometimes possible to
completely ignore portions of the cross section that are dead storage, this is
not the case in unsteady flow modeling because the hydrograph volume
must be recognized. It :may be useful to think of storage-only portions of a
cross section as having: extremely high n-values, which effectively nulls the
conveyance.

Geometry Requirements\GWB\CTA
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Ineffective Flow Areas Requirements

• Ineffective Flow Stations
• Left and/or right ineffective flow stations

denote the location of the ineffective flow
areas along the cross section .

• Trigger Elevations
• Water elevation at which the ineffective flow

area begins to convey flow (non-permanent),
or remains ineffective (permanent).

15

Setting an ineffective flow area requires at least one bank station and
elevation. The bank station denotes the location of the ineffective flow area
along the cross section. There are two different methods for setting bank
stations (normal and multiple blocks).

When the water surface surpasses the trigger elevation, the ineffective flow
area will either begin to convey flow or remain ineffective depending upon its
type (permanent on non-permanent). The concepts of permanent and non
permanent ineffective flow areas are addressed in the next set of slides.

1.2 L-02
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Non-Permanent Ineffective Flow Area
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As shown in the slide, t~ere are two ineffective flow areas (left bank and right •
bank). The ineffective flow areas are set to non-permanent. This means
that the left bank and right bank areas will not convey flow until the trigger
elevation has been rea~hed. The trigger elevation is denoted by the end
point of the two arrows i In this example the trigger elevation is 216 feet.

•
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• Non-Permanent Ineffective Flow Area
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The water surface is rising but has not exceeded the trigger elevation. The
rising water surface has increased the storage in the left and right overbanks
but has not increased the conveyance in these areas because ineffective
flow areas account for storage and not conveyance.
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Non-Permanent Ineffective Flow Area
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For non-permanent ineffective flow areas, once the water surface is higher
than the trigger elevatidn, the entire ineffective flow area becomes effective
(as shown in the slide).! Water is assumed to be able to move freely in that
area based on the roug,hness, wetted perimeter, and area of each
subdivision. The left a'1d right overbanks are no longer considered storage
but are now active flow!areas.
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• Permanent Ineffective Flow Area

1.2 L-02

225 .15-+-.25-+-.04 + Upstream of bridge' embankment
.15------oj

Legend

VIIS 1OFE819991700

220

.
Ground..

lne1f.
8eInksta

2: 215

i
~

210

20S

20001S00200+------~--~~--~~---~o ~O 1~

stallon(ft)

•
19

Occasionally you may need to have ineffective flow areas remain ineffective
permanently. The ineffective flow areas can be set to the permanent mode
individually from the cross section editor, or through a table from the
geometric data editor.

In this example, the same ineffective flow areas were used except they were
set to permanent. As seen in the slide when the water surface is below the
trigger elevation the permanent ineffective flow area behaves like the non
permanent area.

•
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Permahent Ineffective Flow Area
i
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For permanent ineffective flow areas, when the water surface elevation
surpasses the trigger elevation, the area below the trigger elevation remains
ineffective. Water abov~ the trigger elevation is assumed to convey flow.
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• Normal Ineffective Flow Areas
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The normal ineffective flow area option allows the user to define a left station
and elevation and a right station and elevation (normal ineffective areas).
When this option is used, and if the water surface is below the established
ineffective elevations, the areas to the left of the left station and to the right
of the right station are considered ineffective.
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Normal Ineffective Flow Areas

22

Set the normal ineffectiye flow area locations by selecting Ineffective Flow
Areas under the Optior[ls menu of the Cross Section Data Editor. In the
ineffective flow area wihdow, select the radio button labeled Normal. Notice
the box labeled Permanent, check this box if the ineffective flow area never
conveys flow.
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• Blocked Ineffective Flow Areas
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The multiple block ineffective area option allows for the establishment of
blocked ineffective flow area. Multiple blocked ineffective flow areas are
useful for bridge geometry with slopes or multiple openings.
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Blocked Ineffective Flow Areas

24

Blocked ineffective flow areas require the user to enter an elevation, a left
station, and a right stati,on for each ineffective block. Up to ten blocked

I

ineffective flow areas dm be entered at each cross section. Notice the
column labeled Permaritent (yIn), change this column to "y" for permanent
ineffective flow areas. i

,
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Entering Geometric Parameters

• Manning's n Values
• Ineffective Flow Areas

• Non-Permanent vs. Permanent
• Normal vs. Multiple Blocks

• Blocked Obstruction

• Levees

25
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Blocked Obstructions,
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• Decrease Flow Area
• Add Wetted Perimeter
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Blocked obstructions aNow the user to define areas of the cross section that
will be permanently blopked out. Blocked obstructions decrease flow area
and add wetted perimeter when the water comes in contact with the
obstruction. A blocked iobstruction does not prevent water from going
outside of the obstruction.
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Blocked Obstructions

Horiz~1VMiation in n YakJes:

Horizontal Variation in Kvalles:
Vert~ y,yl<!tlon in n vltlues •••
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The user may define a left station and elevation and a right station and
elevation (normal blocked areas). When this option is used, the area to the
left of the left station and to the right of the right station will be completely
blocked out.
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Ei?tering Geometric
Parameters

• Manningi's n Values
• Ineffecti~e Flow Areas

• Non-P~rmanent vs. Permanent
• Normal. vs. Multiple Blocks

• Blocked !Obstruction

• Levees
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Levees
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This option allows the user to establish a left and/or right levee station and
elevation on any cross section. When levees are established, no water can
go to the left of the left levee station or to the right of the right levee station
until either of the levee elevations are exceeded. Levee stations must be
defined explicitly, or the program assumes that water can go anywhere
within the cross section. An example of a cross section with a levee on the
left side is shown in the figures. In this example the levee station and
elevation is associated with an existing point on the cross section .

1.2 L-02
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Levees
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Graphical Cross Section Editor
ZOOm In
Zoom OUt
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Undo Edits
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Add staJElev Points
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Grid ...

Located in the Geometric Data Editor under the Tools menu.

31

A graphical cross section editor is available from the Tools menu of the
Geometric Data Editor. The user has the option to move objects (objects
are ground points, main channel bank stations, ineffective flow areas,
levees, and blocked obstructions), delete objects, or add new objects.

To move an object, the user first selects Move Objects from the Options
menu. Then move the mouse pointer over the object that you want to move,
press down the left mouse button, and then move the object. When you are
finished moving the object, simply release the left mouse button and the
object will be moved. To delete an object, first select Delete Objects from
the Options menu. Next, move the mouse pointer over the object that you
would like to delete and click the left mouse button. Whatever object is
closest to the mouse pointer will be deleted. To add an object to the cross
section, first select the type of object you want to add from the available list
under the Options menu. Once you have selected an object type to add,
move the mouse pointer to the location where you would like to add it and
click the left mouse button. If the object that you are adding requires more
than one point, such as blocked ineffective flow areas and blocked
obstructions, then continue to move the mouse pointer and click the left
mouse button to add the additional points.

1.2 L-02
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Setting Ineffective Areas to Permanent

,
Located in the Geometric Data Editor under the Tools menu.
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The default in HEC-RAS is to set ineffective flow areas to non-permanent.
To change a set of rivet stations from non-permanent to permanent, select
Setting Ineffective Ar~as to Permanent Mode... under the Tools menu
located in the Geometric Data Editor. Then select the proper river, reach,
and river stations.

This is especially usefu:' after using the Graphical Cross Section Editor
because there is no option in the editor to change between non-permanent
and permanent.

Geometry Requirements\GWB\CTf\
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Geometry Preprocessor

33

The geometric preprocessor is located in the Unsteady Flow Analysis
Window, found from the main program window under the Run menu.

1.2 L-02
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Hydraulic Property Tables
I

Cross-sections ••• I

Water Surface Profiles. •••
General Profile Pio~ ...
Rating Curves... i
X-'(-2 Perspective !i'Jols ...
Stage and Flow Hydrographs ...

I
Detailed OulputTabies ,••

ProfilesummarYT~le ...

34

View output from the g~ometric preprocessor by examining the hydraulic
property tables and plots. The output is located under the View menu, or
the shaded button in thl3 figure.
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Hydraulic Property Plot

Property Table
RS·52879.19

legend
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Output can be viewed in graphical form. Viewing the graphical output is a
good diagnostic tool for examining cross section geometry. The relationship
of area, storage, and conveyance should be examined for abrupt changes
with elevation. Any abrupt changes should be reviewed to determine the
overall significance within that particular model.

1.2 L-02
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Hydr1aulic Property Table
i

36

Detailed output is also available for each computed increment. Detailed
output can be examinea to determine a specific elevation or station where a
problem is occurring.
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•

Geometry and Unsteady Flow

• What is going to happen to the water
when it gets out of the channel?

• Ineffective Flow Areas

• Levees
• Conveyance Calculations Using Subdivisions

37

When examining geometry, the user must consider where water may leave
the main channel and how it will behave once out of the main channel.
Knowing these factors gives the user a general idea of how to correctly
model the situation within the framework of HEC-RAS.
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Ineffective Flow Areas
i
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As seen in the figure, t~ere is water in the right overbank. Because RAS is a
one-dimensional model, the water surface elevation will be the same for the
entire cross section. T~e user must determine if water can physically enter
the right overbank at this cross section by examining upstream and
downstream cross sections.

If water will enter the right overbank then the user must determine how to
model this area.
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Non-Permanent Ineffective Flow

Property Table
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The figure above represents the previous cross section with the right
overbank modeled as non-permanent ineffective flow. As seen on the figure,
the storage in the cross section increases until reaching the trigger elevation
where the ineffective flow area is turned off. By turning off the ineffective flow
area the storage in the cross section returns to zero and the area of the
cross section increases.

If the water level could possibly reach the trigger elevation then this is
probably not the proper way to model this cross section. The change in
volume of storage, and the change in area of the cross section, is too
significant to model with a non-permanent ineffective flow area.

1.2 L-02
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Permanent Ineffective Flow Area
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The figure above represents the previous cross section with the right
I

overbank modeled as permanent ineffective flow. As seen on the figure, the
storage in the cross section increases until reaching the top of the ineffective
flow area where it remains constant.

If the water level could possibly reach the trigger elevation, while remaining
relatively stationary, then this is probably a better representation compared
to a non-permanent in~ffective flow area.
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• Levees
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If it is determined that water will not enter the right overbank, then the area
should be modeled with a levee. When the levee is established, no water
can go to the right of the right levee station until the levee elevation is
exceeded.

•

•
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Levees

legend

Con..... Channel

Con..... Overbanks.
COny. Total

storage Arel:t

:I~~......;..-~~-.-,--~~~~--=-~~
o 2000: 4000 6000 8000 10000 12000 14000 18000 16000

ConveysnceflOOO (cts) storage (sq tt)

42

As seen on the figure, i,f the levee elevation is exceeded there will be an
extremely large increase in conveyance with elevation for this geometry.
This would not be the ~roper way to model the cross section if the levee is
overtopped. Keep in mind that the magnitude of conveyance on the x-axis is
divided by 1000.
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Storage Area Option

• What if adding a levee or ineffective flow
area has a significant affect on the
conveyance and storage relationships?
• Alter the cross section by terminating it at the

beginning of the problem area.
• Model the area that was deleted with a lateral

weir and off-stream storage area ...
• Storage areas will be discussed in impending

lectures.

43

If the cross sectional geometry denotes a significant change in storage or
conveyance when a levee is overtopped then this cross section should be
altered. The cross section should be terminated at the levee and the area
that was deleted should be modeled as a storage area. Abrupt and
significant changes in storage and conveyance should be avoided because
they can cause instabilities in the unsteady flow model.
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Con~eyance Subdivisions
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•

As shown in the figure above, there is a distinct increase in elevation located •.
at station 2000. The el]ltire left bank is being modeled with one Manning's n
value. Remember that!RAS computes the left and right overbank
conveyances using subdivision of Manning's n.

•
Geometry Requirements\GWB\CTl\ 44



• Conveyance Subdivisions
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As seen in the figure, there is a hitch in the increase of conveyance with
elevation at just above 75 feet. This corresponds to the steep increase in
elevation located at station 2000 on the previous figure.

HEC-RAS uses Manning's equation to calculate conveyance. Imbedded in
this equation are relationships for channel depth, channel area, and wetted
perimeter. In this example, when the calculations go just above the
elevation of 75 feet, Manning's equation sees an enormous increase in
wetted perimeter for a minute increase in water depth. The conveyance
answer found from this calculation is dramatically different from the
conveyance answer found at the previous calculation below 75 feet.

•
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Con~eyance Subdivisions
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To account for this situ~tion, a subdivision made by inserting another •
Manning's n value mus[t be added at the point of discontinuity. The value
does not need to be different, as long as the subdivision is present, RAS will
calculate separate conveyances for the geometry.

•
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• Conveyance Subdivisions
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As seen on the figure, this subdivision for the left overbank smoothed the
relationship between conveyance and elevation.
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1.3 W-01

Workshop
Pre-Processing Geometric Data

Introduction

This workshop will help ·students learn how to use HEC-RAS to pre-process geometric
data. Students willieam how to set cross-sectional table properties; pre-process the cross
sections into tables of elevation versus conveyance, area, and storage; and review the
output from the pre-processor. While this data is from an actual study, the model and
results ofthis workshop do not represent current orfuture conditions ofthe river.

Background

The stream for this example is a section of Beaver Creek located near Kentwood, Louisiana.
The bridge crossing is located along State Highway 1049, near the middle of the river reach.
However, the bridge will not be used for this workshop. The field data for this example was
obtained from the United States Geological Survey (USGS) Hydrologic Atlas No. HA-601.

Figure 1 Beaver Creek near Kentwood, Louisiana
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Problem Description

A project file (Preprocessor.prj) with the title "Beaver Creek Geometric Data" has
been loaded on your worksIiop computers. This file contains all the data for this
workshop. Only the pre-pro~essorwill be used in this workshop to examine the hydraulic
property tables for cross sections.

Tasks

The following is a summary of the required tasks for each group:

1. View HTAB Parameters and Analyze the Hydraulic Property Table

View the default! Cross Section Table Parameters for this
workshop in the ~eometric Data Editor by selecting the HTAB
Parameters butt,on. Are the default parameters appropriate for
this geometry? If not, change the parameters to appropriate
values.

Rerun the Geom:etry Preprocessor on the Unsteady Flow Analysis window.

View the Hydraulic Property Tables and Plots for each cross section. Note
the general relation between conveyance and elevation.

2. Place Levees at ~ecessaryLocations

Place levees at the following locations by either using the Graphical Cross
Section Editor elr the Cross Section Editor. (The placement doesn't need to
be exact for the graphical method).

•

•
River Statio~

5.99
5.76
5.29
5.13
5.00

Station
866
906
223
358
518

Elevation
214.8
214.3
209.6
209
209

Save the geometry as a new geometry file (*.g02) and then run the pre
processor (using the new geometry file). Next, view the Hydraulic Property
Tables at each cross section where a levee was added. How did the
conveyance vs. elevation relationship change because of the levee addition?
Compare with the previous geometry file.

•
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3. Place Normal Permanent Ineffective Flow Areas

Add permanent ineffective flow areas at the same locations as the levees.
(Place the permanent ineffective flow areas behind the levees - don't delete
the levees). Save the geometry as a new geometry file (*.g03) and run the
pre-processor using the new geometry file. Next, view the Hydraulic
Property Tables at each cross section where a permanent ineffective flow
area was added and compare the three geometry files. How did this change
affect the conveyance vs. elevation relation compared to Task 2? What
provides a better relation between conveyance and elevation, Task 2 or Task
3? Why?

Questions

1. Considering that HEC-RAS is a one-dimensional model, what problems will
occur if a levee is overtopped during a simulation? What options in RAS can
be used to model a levee being overtopped?

2. Are there any anomalies with the conveyance in the overbanks at River
Station 5.29? If so, what is it caused by, and how can it be fixed?

Geometry Prepocessing Workshop 3 GWB/CTA
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3. How does a permanent ineffective area affect storage within the cross section?
When should a cross section be modeled with non-permanent ineffective areas
and when should it be modeled with permanent ineffective areas?

•

•

•
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Boundary &Initial Conditions

Boundary and
Initial Conditions

Objectives:
• Know requirements and options for
boundary conditions
• Know initial condition requirements
• Review sources of data for both

References:

HEC-RAS River Analysis System, User's Manual, Chapter 8, Performing an
Unsteady Flow Analysis, November 2002.

L- Boundary & Initial ConditionslBrunner/ Gee
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Boundary & Initial Conditions

Unsteady Flow Data

• Initial Conditions - Required
• Establish flow and stage at all nodes at the start of

simulation

• External Boundaries - Required
• Upstream and Downstream ends of the river
• Typically flow or stage hydrograph upstream
• Typically rating or "normal depth" downstream

• Internal Boundaries - Optional
• Add flow within the river system
• Define gate operation

As with steady-flow applications, the Unsteady Flow data define flow and
starting conditions for the simulation. The model simulates a dynamic hydraulic
process on an segment of a river system network. To perform the hydraulic
calculations within the segment, the time-varying "Boundary Conditions" must be
defined for the "External Boundaries."

The Unsteady Flow editor provides the options to defined:

• External boundary type and data

• Add internal boundary data

• Set the initial conditions for the start of the simulation

L- Boundary & Initial Conditions/Brunner/ Gee
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Boundary &Initial Conditions

Unsteady Flow Data Editor

1.4 L-03

•

•

Once all of the geometric data are entered, the modeler can then enter any
unsteady flow data that are required. To bring up the unsteady flow data editor,
select Unsteady Flow Data from the Edit menu on the HEC-RAS main window.
The Unsteady flow data editor should appear as shown above.

Unsteady Flow Data

The user is required to enter boundary conditions at all of the external boundaries
of the system, as well as any desired intemallocations, and set the initial flow and
storage area conditions in the system at the beginning of the simulation period.

L- Boundary & Initial ConditionslBrunner/ Gee 3



Boundary & Initial Conditions

Boundary Conditions: Upstream

• Editor shows required
external boundaries

• Boundary Type shows
available options

• Upstream options:
• Stage Hydrograph
• Flow Hydrograph
• Stage & Flow

Hydrograph

Boundary conditions are entered by first selecting the Boundary Conditions tab
from the Unsteady Flow Data Editor. River, Reach, and River Station locations of
the external bounds of the system will automatically be entered into the table.

Boundary conditions are entered by first selecting a cell in the table for a
particular location, then selecting the boundary condition type that is desired at that
location. Not all boundary condition types are available for use at all locations.
The program will automatically gray-out the boundary condition types that are not
relevant when the user highlights a particular location in the table.

Users can also add locations for entering internal boundary conditions. To add an
additional boundary condition location, select the desired River, Reach, and River
Station, then press the Add a Boundary Condition Location button.

L- Boundary & Initial ConditionslBmnner/ Gee
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Boundary & Initial Conditions

Boundary Conditions: Downstream

• Downstream Boundary Options:
• Stage Hydrograph • Rating Curve
• Stage &Flow Hydrograph • Normal Depth

The downstream boundary can be:

• Stage Hydrograph - e.g., gage data on the stream, or tidal cycle

• Flow Hydrograph - e.g., gage data converted to flow

• Stage & Flow - e.g., combined observed stage and forecasted flow

• Rating Curve - e.g., rating at a gauged location, or steady-flow rating

• Normal Depth - e.g., average slope of stream to estimate energy slope

L- Boundary & Initial Conditions/Brunner/Gee
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Boundary & Initial Conditions

Flow Hydrograph

1.4 L-03

•
• Read from DSS

• Select DSS file
• Select Pathname

• Enter in Table
• Select time interval
• Select start date/time
• Enter flow data - or

cut &paste

•Flow Hydrograph:

A flow hydrograph can be used as either an upstream boundary or downstream
boundary condition, but is most commonly used as an upstream boundary condition.
When the flow hydrograph button is pressed, the window shown above will appear.
As shown, the user can either read the data from a REC-DSS (REC Data Storage
System) file, or they can enter the hydrograph ordinates into a table.

Ifthe user selects the option to read the data from DSS, they must press the
Select DSS File and Path button. When this button is pressed a DSS file and
pathname selection screen will appear as shown on the next page. The user first
selects the desired DSS file by using the browser button at the top. Once a DSS file
is selected, a list of all of the DSS pathnames within that file will show up in the
table. The' user can use the pathname filters to reduce the number of pathnames
shown in the table. The last step is to select the desired DSS Pathname and to close
the window.

L- Boundary & Initial Conditions/Brunner/ Gee 6
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Select DSS file and Path

1.4 L-03
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•

When the Select DSS File and Path button is pressed a DSS file and pathname
selection screen will appear as shown above. First select the desired DSS file by
using the browser button at the top. Once a DSS file is selected, a list of all of the
DSS pathnames within that file will show up in the table. The user can use the
pathname filters to reduce the number ofpathnames shown in the table. The last
step is to select the desired DSS Pathname and to close the window.

L- Boundary & Initial Conditions/Brunner/ Gee 7



Boundary & Initial Conditions

Enter Flow Data

317.58
429.91
615.75
873.08
1199.07

The user also has the option of entering a flow hydrograph directly into a table,
as shown above. The first step is to enter a Data time interval. Currently the
program only supports regular interval time series data. A list ofallowable time
intervals is shown in the drop down window of the data interval list box. To enter
data into the table, the user is required to select either Use Simulation Time or
Fixed Start Time.

Ifth~ user selects Use Simulation Time, then the entered hydrograph will
always start at the beginning of the simulation time window. The simulation
starting date and time is shown next to this box, but is grayed out.

If the user selects Fixed Start Time then the hydrograph is entered starting at a
user specified time and date. Once a starting date and time is selected, the user can
then begin entering the data.

L- Boundary & Initial Conditions/Brunner/ Gee
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Boundary & Initial Conditions

Monitor Flow Rate-of-change

• Added option for Flow Hydrograph data
• Set Maximum Flow Change in time step
• If input data exceeds max, program will

shorten computational time step

• Min Flow
• Multiplier

An additional option listed on the flow hydrograph boundary condition is to
"Monitor this hydrograph for adjustments to computational time step."
When you select this option, the program will monitor the inflow hydrograph to see
if a change in flow rate from one time step to the next is exceeded. If the change in
flow rate does exceed the user entered maximum, the program will automatically
cut the time step in half until the change in flow rate does not exceed the user
specified max. Large changes in flow can cause instabilities. The use of this
feature can help to keep the solution of the program stable.

Also, the flow hydrograph for model boundaries can be monitored to ensure that
the flow values do not drop below an input minimum value. If the value is less than
the minimum, the value is set to the minimum.

Additionally, the flow hydrograph for model boundaries can be easily modified by
a constant ratio. This allows easy testing ofmodel sensitivity to input flo,w values,.
or an analysis ofmodel results with larger flood events.

These features appear on most flow input editors.

L- Boundary & Initial Conditions/Brunner/ Gee
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Boundary & Initial Conditions

Enter Data to a DSS file

Copy Selected Paths ...

Delete Highlighted Paths ...

Squeeze DSS File ."

Time Series Import ".

• Pathname
• Start date & time

• Time interval

• Units
• Data type
• Enter data, or
• Copy I Paste

Entering time-series data into a DSS file is an alternative to entering time-series
data directly into the simulation. By entering the data into the file, it is available for
use in other simulations. While DSS has DOS programs to accomplish data entry,
this is the easiest Windows method at this time.

The function is a DSS Viewer Utility. The Write Time Series Data to DSS
window provides for data entry of all the required pathname and header
information. Then the data can be entered directly into the table. Or, if the data are
available in a spreadsheet or similar table, the data can be copied and pasted into the
input table.

1.4 L-03
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Boundary & Initial Conditions

Sources of Time-Series Data

• Historic Records (USGS)
• Stage Hydrographs
• Flow Hydrographs

• Computed Synthetic Floods
• Peak Discharge with assumed time.

distribution

• Rainfall-runoff modeling

Unsteady-flow modeling provides a dynamic solution for stage and flow
throughout the river network. The primary boundary data are time-series flow,
typically for a flood event. Where do you get that flow data?

For most program user's, the simulation will route an upstream flow hydrograph,
using a downstream rating curve or normal depth. The upstream hydrograph can
be:

• Historic, like those obtained from the US Geologic Service.

• Synthetic, often, prior studies have computed and published synthetic floods like
the Corps' Standard Project (SPF) or the Probable Maximum Flood (PMF).

• Modeling, using rainfall-runoff models like the Corps' Hydrologic Modeling
System (HEC-HMS).

• Peak Discharge, and a time to peak estimate, can be used to provide a crude
hydrograph using the HEC-RAS interpolation routine (Triangle hydrograph). If a
Unit Hydrograph is available, that distribution can be used to develop a flow
hydrograph.

L- Boundary & Initial Conditions/Brunner/ Gee
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Boundary & Initial Conditions

HEC-HMS Basin Schematic

The HEC-HMS program can be used to model the rainfall-runoffprocess in the
contributing watershed (catchment). Even when there are some gauged data in the
watershed, the hydraulic model may require lateral inflow data and tributary flows
where no gauged data exists. A basin model can be developed to provide the
necessary data at all model locations. By careful coordination of study
reguirements and key information locations, the model nodes can be identified and
modeled consistently among various computer programs. The data can be
conveniently transferred through different models using the HEC-DSS file system.

L- Boundary & Initial ConditionslBrunner/ Gee
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Boundary & Initial Conditions

Stage Hydrograph

• Read from DSS
• Select DSS file

• Select Pathname

• Enter in Table
• Select time interval

• Select start date/time
- Simulation time

- Fixed starting time

• Enter stage data - or
cut & paste

Stage Hydrograph:

A stage hydrograph can be used as either an upstream or downstream boundary
condition. The editor for a stage hydrograph is similar to the flow hydrograph
editor shown above. The user has the choice of either attaching a HEC-DSS file
and pathname or entering the data directly into a table.

L- Boundary & Initial Conditions/Brunner/ Gee
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Boundary & Initial Conditions

Stage and Flow Hydrograph

• Upstream Mixed
• Stage used while

defined

• Flow used after

• Purpose:

• Real-time use

• Mix observed stage
with

• Forecasted flow

Stage and Flow Hydrograph:

The stage and flow hydrograph option can be used together as either an upstream
or downstream boundary condition. The upstream stage and flow hydrograph is a
mixed boundary condition where the stage hydrograph is inserted as the upstream
boundary until the stage hydrograph runs out of data; at this point the program
automatically switches to using the flow hydrograph as the boundary condition.
The end ofthe stage data is identified by the HEC-DSS missing data code of"
901.0". This type ofboundary condition is primarily used for forecast models
where the stage is observed data up to the time of forecast, and the flow data is a
forecasted hydrograph.

1.4 L-03
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Boundary & Initial Conditions

Rating Curve

• Single value rating
• Downstream boundary
• Read from DSS

• Select DSS file
• Select Pathname

• Enter in Table
• Enter stage- flow data 

or

• Cut & paste

Rating Curve:

The rating curve option can be used as a downstream boundary condition. The
user can either read the rating curve from HEC-DSS or enter it by hand into the
editor.

The downstream rating curve is a single valued relationship, and does not reflect
a loop in the rating, which may occur during an event. This assumption may cause
errors in the vicinity of the rating curve. The errors become a problem for streams
with mild gradients where the slope of the water surface is not steep enough to
dampen the errors over a relatively short distance.c When using a rating curve, make
sure that the rating curve is a sufficient distance downstream of the study area, such
that any errors introduced by the rating curve do not affect the study reach.

1.4 L-03
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Boundary & Initial Conditions

Normal Depth

1.4 L-03

•
• Enter Friction (energy)

Slope

• Program uses
Manning's equation to
compute stage

• Provides "Normal
Depth" downstream
boundary

Normal Depth:

The Normal Depth option can only be used as a downstream boundary
condition for an open-ended reach. This option uses Manning's equation to
estimate a stage for each computed flow. To use this method the user is
required to enter a friction slope for the reach in the vicinity of the boundary
condition. The slope of the water surface is often a good estimate of the
friction slope.

As recommended with the rating curve option, when applying this type of
boundary condition you sh0uld place it far enough downstream of the study
reach, such that any errors it produces will not affect the results at the study
reach.

•

•
L- Boundary & Initial Conditions/Brunner/ Gee 16
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Boundary & Initial Conditions

Adding an Internal Boundary

• Select:
• River

• Reach
• River Station .

• Add a Boundary
Condition Location

• Location added to
the list of Boundary
Conditions

The Unsteady Flow Data editor automatically has the external boundaries
defined, based on the geometric data model. The user can add internal boundary
locations to define additional lateral flow. Also, when weirs with gates are added,
the gate operation will be defined as an internal boundary.

Select the River, Reach and River Station where the data will be added. Then
press Add a Boundary Condition Location. The location is added to the
boundary condition table.

L- Boundary & Initial Conditions/Bmnner/ Gee
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Boundary & Initial Conditions

Internal Boundary Conditions

• Lateral Inflow
Hydrograph

• Uniform Lateral
Inflow

• Groundwater
Interflow

• Also:
• Gate openings
• Navigation Dams
• Internal Stage/Flow

Lateral Inflow Hydrograph: This internal boundary condition allows the user to
bring in flow at a specific point along the stream.

1.4 L-03

•

•
Uniform Lateral Inflow Hydrograph: This internal boundary condition allows the
user to bring in a flow hydrograph and distribute it uniformly along the river reach
between two specified cross sections.

Groundwater Interflow: This option allows the user to identify a reach that will
exchange water with a groundwater reservoir.

THE FOLLOWING WILL BE PRESENTED IN THE GATE LECTURE

Time Series of Gate Openings. This option allows the user to enter a time series
of gate openings for an inline gated spillway, lateral gated spillway, or a spillway
connecting two storage areas.

Elevation Controlled Gate. Define the opening and closing of gates based on the
elevation of the water surface elevation upstream from the structure.

Navigation Dams: Simulate the gate operations for navigation dams attempting to •
maintain navigation depths.

L- Boundary & Initial ConditionslBrunner/ Gee 18
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Lateral Inflow Hydrograph

1.4 L-03

•

• Lateral flow
downstream from a
Cross· Section

• Read from DSS
• Select DSS file
• Select Pathname

• Enter in Table
• Select time interval
• Select start date/time
• Enter flow data - or cut &

paste

•

Lateral Inflow Hydrograph: This internal boundary condition allows the user to
bring in flow at a specific point along the stream. The user attaches this boundary
condition to the river station of the cross section just upstream of where the lateral
inflow will come in. The actual change in flow will not show up until the next cross
section downstream from this inflow hydrograph. The user can either read the
hydrograph from DSS or enter it by hand.

L- Boundary & Initial ConditionslBrunner/ Gee 19



Boundary & Initial Conditions

Uniform Lateral, Flow Hydrograph

1.4 L-03

•
• Uniform Lateral flow to

a reach element
• Add Internal Location at

Upstream River RS

• Set Downstream RS

• Read from DSS

• Enter in Table

•Uniform Lateral Inflow Hydrograph: This internal boundary condition allows
the user to bring in a flow hydrograph and distribute it uniformly along the river
reach between two specified cross sections. The hydrograph for this boundary
condition type can be either read from DSS, or entered into a table.

L- Boundary & Initial Conditions/Brunner/ Gee 20
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Boundary & Initial Conditions

HEC-HMS Basin Schematic

HMS provides individual watershed flows locations. If a reach flows through a
watershed the hydrograph can be distributed along the reach with the distributed
flow boundary condition.

L- Boundary & Initial ConditionslBmnner/ Gee
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Boundary & Initial Conditions

Groundwater Interflow

• Add Internal Location at
Upstream River RS

• Set Downstream RS
• Input Groundwater

Stage
• Read from DSS
• Enter in Table

• Darcy's Loss Coefficient
• Distance between stages of

river & groundwater

Groundwater Interflow: This option allows the user to identify a reach that will
exchange water with a groundwater reservoir. The stage of the groundwater
reservoir is assumed to be independent of the interflow from the river, and must be
entered manually or read from DSS. The groundwater interflow is similar to a
uniform lateral inflow in that the user enters an upstream and a downstream river
station, in which the flow passes back and forth. The computed flow is proportional
to the head between the river and the groundwater reservoir. The computation of
the interflow is based on Darcy's equation. The user is required to enter Darcy's
groundwater loss coefficient (hydraulic conductivity), as well as a time series of
stages for the groundwater aquifer.

The groundwater algorithm is simplistic; simulating flow in only one direction,
laterally, perpendicular to the river. The groundwater aquifer is assumed,to be very
large such the the interchange of water with the river has no impact on the
groundwater level.

1.4 L-03
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•
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Boundary & Initial Conditions

Darcy's Law

V=KS
v = Velocity (ftlhour)

K = Hydraulic Conductivity (ftlhour)

S =Slope (ftlft) =Stage difference / Distance

Q=VA
Q= Flow (cfs)

A =Area, perpendicular to the flow ( ft2)
- Top width x length, if groundwater below channel

- Valley width x length plus channel depth x length, if
groundwater is above channel invert

Darcy's Law (1856) applied the principles of fluid flow to the flow ofwater in a
permeable media. The velocity of flow equals the product of a coefficient times the
hydraulic gradient. The flow equals the velocity times the effective area = gross
area times porosity of the media. (Hydrology for Engineers, by LKP)

• In RAS, the slope is computed by the difference between the water elevation at
the cross section and the input groundwater elevation, divided by the input Distance.

• The area is length times the flow width.

• The length is the channel length for the reach element (between upstream and
downstream River Stations).

• The flow width depends on the groundwater level.

If the groundwater level is below the invert of the channel, the flow is down
from the channel and the width is the average top width.

If the groundwater level is above the invert, the width is the overbank width
plus the channel depth, estimated by the average channel water elevation
minus the groundwater elevation.

1.4 L-03
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Boundary & Initial Conditions

Initial Conditions

• Requires an initial flow
for all reaches.

• Enter steady-flow at
upstream boundary

• Can add a flow-change
location

• Pool elevation for
storage areas

• Use system status fro.m
previous simulation
(restart)

Initial Conditions In addition to the boundary conditions, the user must establish
the initial conditions of the system at the beginning of the unsteady flow simulation.
Initial conditions consist of flow and stage information at each of the cross sections,
as well as elevations for any storage areas defined in the system. Select the Initial
Conditions tab to bring up the data editor, shown above. There are two options for
establishing the initial conditions.

The first option is to enter flow data for each reach and have the program
perform a steady flow backwater run to compute the corresponding stages at each
cross section. This option also requires the user to enter a starting elevation for any
storage areas in the system. This is the most common method for establishing
initial conditions.

A second method is to read a file of stages and flows written from a previous
run, which is· called a "Restart File". This is often used when running a long
simulation time that must be divided into shorter periods. The output from the first
period is used as the initial conditions for the next period, and so on. However, the
RAS model has a dynamic allocation procedure to overcome the time-dimension
limit.

1.4 L-03
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Boundary & Initial Conditions

Initial Conditions Data

• Initial Flow data
• Should be nearly steady-state conditions

• Starting flow from upstream hydrograph
• Flow distribution from Steady Flow profile

• Initial Elevation in Storage areas
• Stage from historic data

• Initial early in event, dry conditions

• Hot Start file from previous simulation

In most applications, the initial condition is a steady-flow water surface profile
throughout the river system. If a constant flow is defined for each river reach, that
flow should represent a condition when flows are fairly stable, i.e., a period prior to
the start of the flood. The initial value should be the starting flow in the inflow
hydrograph. You do not want a large change in flow between the initial flow and
the first inflow value.

The flows in the river system should be consistent. For a complex river
network, resolve the flow distribution using steady-flow analysis. The new option
for optimizing the flow distribution could be used to help develop a consistent flow
set.

If flow is not steady at the start of simulation, you can use hydrologic routing to
estimate the flows through the river system. Flow changes can be input in the initial
condition, just like steady flow data. An HMS model could be used for this purpose.
Remember, the initial flow in the hydrologic model is steady flow. '

The Hot Start file can be saved from a simulation. Additionally, this option may
be used when the software is having stability problems at the beginning of a run.
Run the model with all the inflow hydrographs set to a constant flow, and set the
downstream boundaries to a high tailwater condition. Run the model with
decreasing tailwater down to a normal stage over time. Once the tailwater is a
reasonable value for the constant flow, those conditions can be written out to a file,
and then used as the starting conditions.

L- Boundary & Initial Conditions/Brunner/ Gee
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Boundary & Initial Conditions

File and Options Menus

New Unsteady Flow Data
Open Unsteady Flow Data •••

Save Unsteady Flow Data

Save Unsteady Flow Data As .
Rename Unsteady Flow Title .

Delete Unsteady Flow File ...

Set Initial Conditions (flow and stage)from p

Exit

The Unsteady Flow Window has the standard File Menu options. It is a good
idea to save the data before going on to the next step.

The Options Menu has four options:

• Delete an added Boundary Condition. You cannot delete external boundaries
because they are required.

• Internal RS Initial Stages to set a stage at the start of simulation.

• Flow Minimum and Flow Ratio Table

• Add Observed Data - this option is helpful when calibrating model to simulate an
historic flood event.

1.4 L-03
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Internal RS Initial Stages

1.4 L-03

•

• Select:
• River
• Reach
• River Station

• Add Location to
table below

• Define Initial
Elevation

•

The initial stage can be set for a river station. Nonnally, this would be defined by
the computed water surface profile during the initial conditions stage of the
computation process. This option is useful at locations upstream from a control
structure where the initial stage is NOT the 'nonnal' backwater elevation.

Select the River, Reach and River Station where the initial stage is to be defined.
Then 'click' the Add an Initial Stage Location button. The location will be
added to the table below. Then you can enter the initial stage for that location.

L- Boundary & Initial ConditionslBrunner/ Gee 27



Boundary & Initial Conditions

Flow Minimum & Flow Ratio Table

• Global Editing to:
• Add constant,
• Multiply values, or

• Set Values

• Minimum Flow value
for boundary

• Multiplying factor to
modify hydrograph for
boundary

The boundary hydrographs can be modified with global editing to:

Add a constant value to the input

Multiply input values by a factor

Set values to an input value

The following two options are also available on all flow hydrograph input windows.

1. The flow hydrograph for model boundaries can be monitored to ensure that the
flow values do not drop below an input minimum value. If the value is less than the
minimum, the value is set to the minimum.

2. The flow hydrograph for model boundaries can be easily modified by a constant
ratio. This allows easy testing of model sensitivity to input flow values, or an
analysis ofmodel results with larger flood events.

1.4 L-03
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Observed (Measured) Data

1.4 L-03

• Time Series in
DSS

• High Water
Marks

• Rating Curve
(Gage)

•

•

There are 3 options available to enter observed data:

1. Time-series data can be entered to define observed stage or flow data. There
data must be in a DSS file.

2. High-water marks can be defined

3. A Rating Curve can be defined
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Boundary & Initial Conditions

Observed Time Series Data

• Add Selected location·

• River
• Reach
• River Station

• Select DSS File

• Select Pathname to
read Observed Data

Observed time-series data can be added to the unsteady flow data set. First
select the model location where the observed data would apply. Select River,
Reach, and River Station and press Add selected location. The location will
appear in the table below. Several locations can be selected.

The second step is the selection ofDSS records to read the observed data. The
lower halfof the window has the standard DSS file and record selection features.
Filters can be selected for pathname parts to facilitate record selection. A DSS
Record should be selected for each Location selected. Remember the time window
set for the simulation will be used to extract the observed data, so be sure there is
observed data for the time window.

1.4 L-03

•

•

•
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Boundary & Initial Conditions

High Water & Rating Curves
• High Water

• Select location

• Add an Obs. WS

• Define Distance
downstream &
stage

• Observed Rating
• Select location

• Distance
downstream

• Stage - Flow data

High Water Marks can be defined for locations along the river reach.

First the nearest upstream cross section is selected and added to the Observed Water
Surface Locations. The distance downstream from the section and the observed
stage are then entered in the table.

Observed Rating provides for a Rating Curve or Measured Flow Data to be
entered.

1. The Rating curve is defined in typical Stage - Flow relationship, starting from
the lowest stage and sequentially increasing.

2. The Measured Point Data is entered by pressing that button and entering the
observed stage and flow, along with optional description. These data do not
have to define a complete rating.

1.4 L-03
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Boundary & Initial Conditions

High Water Marks can be defined for locations along the river reach.

First the nearest upstream cross section is selected and added to the Observed Water
Surface Locations. The distance downstream from the section and the observed
stage are then entered in the table.

511812004

•

•
1.4 L-03

Ground
e

Legend

EG Max W3

WS Max WS

om MaxWS

16000140001200010000. 8000

Main Channel OIsance

600040002000o

HWM1

Observed Rating provides for a Rating Curve or Measured Flow Data to be
entered.

1. The Rating curve is defined in typical Stage - Flow relationship, starting from
the lowest stage and sequentially increasing.

2. The Measured Point Data is entered by pressing that button and entering the
observed stage and flow, along with optional description. These data do not
have to define a complete rating.

•
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•
Boundary & Initial Conditions

File Unsteady Flow Data

1.4 L-03

Second Geometry
refined salsi+paj geo3
shorter pajaro ge04
2nd Geometry· Just Poi, Cd
complete pajaro ge04
shortened just paj, rating curve
shortenedpaj + sat rating curve
shortenedpaj. rating curve.lat inflow
HECLat

sa
salpoLunstdy.u02
s.alpaLunstdy.u03
salpaLunstdy.u04
salpaLunstdy.u05
salpaLunstd.v.u06
salpaLunstdy.u07
salpaLunstdy.u08
salpaLunstdy.u09
salpaLunstdy.ul0

•

•

• Save Unsteady Flow Data

• Provide Descriptive Title

• Ready for Unsteady Simulation

After entering all required data, save the file to permanently write the data to
disk. Once complete, the next step is to set up an unsteady flow simulation. As
with steady-flow simulation, a Plan is established using a Geometry and Unsteady
Flow file.
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1.5 W-02

WORKSHOP 2:

Basic Unsteady Flow Modeling Using HEC-RAS

Problem Description

Beaver Creek data will be used for this workshop. The data comes from
the USGS bridge data developed for the hydraulic analysis of bridges. The
model data are part of the steady-flow data distributed with HECRAS.

In this problem, the geometric data processed in Workshop 1 will be used
to route a flood event. Unsteady flow data will be defined, a simulation
performed and output will be reviewed.

Workshop Tasks:

1. Open Wrk2.prj, which represents the data developed in Workshop 1.

2. Open the Geometry file. Check the HTAB settings and adjust them, if
necessary based on your Workshop 1 analyses. Save the geometry

file.

3. Open the Unsteady Flow data editor and enter the required data for

processing.

a. Upstream Boundary is a flow hydrograph. The data for the flood is
in an excel file, and is listed in Hydrograph Table, on the next page.

b. Downstream Boundary is a rating curve. The data are listed in the
Rating Table, on the next page.

c. Initial Flow should start with the first discharge value from the flood

hydrograph.

P-02(188-08) Unsteady Flow Modeling Workshop 1 Gee, Brunner 2007



Beaver Creek Flood Hydrograph

Date Time Flow
21-May-74 2400 500.00
22-Mav-74 0100 730.00

0200 1404.33
0300 2477.03
0400 3875.00
0500 5502.97
0600 7250.00
0700 8997.03
0800 10625.00
0900 12022.97
1000 13095.67
1100 13770.00
1200 14000.00
1300 13770.00
1400 13095.67
1500 12022.97
1600 10625.00
1700 8997.03
1800 7250.00
1900 5502.97
2000 3875.00
2100 2477.03
2200 1404.33
2300 730.00
2400 500.00

P-02(188-08) Unsteady Flow Modeling Workshop 2

1.5 W-02

Section 5. Rating Curve

Elevation Flow
204.14 200
206.09 500
207.26 1000
208.47 2000
209.30 3000
209.83 4000
210.25 5000
210.68 6000
210.99 7000
211.27 8000
211.53 9000
211.78 10000
212.02 11000
212.25 12000
212.47 13000
212.68 14000
213.00 16000
214.00 21000
215.00 26000
216.00 30000

Gee, Brunner 2007
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1.5 W-02

4. Set up the Unsteady Flow Analysis. Establish a new Plan, check
Programs to Run, and set the times. What Computational Interval
would be appropriate? Don't forget to select the cross sections for
output.

5. Evaluate the results.

a. Are there model results that suggest problems? What could be
done to improve the solution?

b. If time permits, make adjustments and run again.

C. What was the attenuation in peak discharge?

6. Add a lateral flow to River Station 5.29. The inflow starts at 25 cfs,
peaks at 250 cfs at noon and subsides to 25 cfs at midnight. Save the
Unsteady Flow file as a new name and run the simulation as a New
Plan. How much and how far did the inflow change the peak profile?
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2.1 L-04

•
Mod~ling Bridge and Culverts

Cameron Ackerman, P.E.

•

•

Objectives: Review bridge & culvert input, Know added input for processing bridge
and culvert data, Know how to review processed data

References:

HEC-RAS River Analysis System, User's Manual, Chapter 6, January 2001.

HEC-RAS River Analysis System, Hydraulic Reference Manual, January 2001.

Chapter 5 Modeling Bridges

Chapter 6 Modeling Culverts

Appendix B on Flow Transitions, and

Appendix D on WSPRO Coefficients

Flow Transitions in Bridge Backwater Analysis, HEC Research Doc. 42, September 1995.

Once all of the necessary cross-section data have been entered, the modeler can then add
any bridges or culverts that are required. The bridge routines in HEC-RAS allow the
modeler to analyze a bridge with several different methods without changing the bridge
geometry. The bridge routines have the ability to model low flow (Class A, B, and C), low
flow and weir flow (with adjustments for submergence), pressure flow (orifice and sluice
gate equations), pressure and weir flow, and high flows with the energy equation only.

The culvert routines provide for complete analysis for both inlet and outlet control.
Multiple culverts, both identical and different, can be modeled. The program also can
model multiple bridge and/or culvert openings at a single location.

Bridges&Culverts\GWB\CTA 1



Adding a Bridge or Culvert

2.1 L-04

•
Cancel 1OK

• Select River - Reach

• Option - Add a Culvert

• Enter River Station

• OK
No Oatll for Plot

Desaiption: (':,o!(O):P.: 1-::(!·;:,o;':d~~(t ",

Bocrodno X( :'he",,' 'l,"'"" -: ,."";,,,' """... .. ... between I"'" '''Jl~1

Sloping,
!3fidSl·

f'I1odelit')g
ApPf~

HTob, ...

P""""F''=========~I
HTob

IS·eleci-ihe--i,vei'fOi"Siidi:J6lCU!vett't"&tnj·······

2

Culvert data are entered in the same manner as bridge data. To enter culvert data
the user presses the Bridge/Culvert button on the Geometric Data window. Once
this button is pressed, the Bridge/Culvert Data Editor will appear

To add a culvert group to the model the user must then do the following:

1. Select the river and reach that you would like to place the culvert in. This is
accomplished by pressing the down arrow on the reach box, and then selecting the
reach of choice.

2. Go to the Options menu of the Bridge/Culvert editor and select Add a Bridge
and/or Culvert from the list. An input box will appear prompting you to enter a
river station identifier for the new culvert group. After entering the river station,
press the OK button and the cross sections that bound the new culvert group will
appear in the editor.

3. Enter all of the required data for the culvert group. This includes the culvert
deck information and the culvert specific data. The culvert deck and roadway
information is entered in the same manner as a bridge (using the deck/roadway
editor). To enter culvert specific data, press the Culvert button on the
Bridge/Culvert Data editor.

4. Once all of the culvert data are entered, press the OK button in order for the
interface to accept the information.

•

•
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• Bridge - Culvert Data Window

2.1 L-04
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Bridge Application

• Deck/Roadway
• Top of Road
• Approach Fill area
• Bridge Low chord

• Pier Data
• Sloping Abutments
• Bridge Modeling

Approach

•

. '
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3. Enter all of the required data for the new bridge. This may include:'

- Bridge Deck

- Abutments

- Piers

- Bridge modeling approach information

4. Enter any desired optional information. Optional bridge information is found
under the Options menu at the top of the window.

5. Press the Apply Data button for the interface to accept the data.

During the hydraulic computations, the program automatically formulates two
additional cross sections inside of a bridge structure. The geometry inside of the
bridge is a combination of the bounding cross sections (2 and 3) and the bridge
geometry.

The bridge deck editor is used to describe the area that will be blocked due to the
bridge deck, road embankment and vertical abutments. To enter bridge deck
information the user presses the Deck button on the Bridge/Culvert Data Editor.
Once the deck button is pressed, the Deck Editor will appear, as shown on the next
page (except yours will be blank) .
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Deck/
Roadw,t:.o

V
Pier

.L
Sloping, Bridge Modeling Approach

2.1 L-04

'.
Cul<e

Vi Add I Copy I~ Bridge Ii

.. Low Flow Methods'
.~ Compute
r. P' Energy (Standard Step)

C r Momentum Coef Drag Cd r~
c r Yarnell (Class A onl~) Pier Shape K ~~
c r WSPRO Method (Class A onl~) WSPRO Varia'

(' Highest Energy Answer
." _............ . _...... ....•.• •......•..............•J
.. High Flow Methods .. ....•• ····························..·i

r Energy Onl~ (Standard Step)
G Pressure and/or Weir

Submerged Inlet Cd (Blank for table)

Submerged Inlet + Outlet Cd

Max Low Chord (Blank for delaull)

• Low Flow Methods
• Energy
• Momentum

• Yarnell
• WSPRO

• Use or Compute
• Highest Energy option

• High Flow Methods
• Energy Only
• Pressure & Weir

...
Help 1
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The Bridge Modeling Approach editor is used to define how the bridge will be modeled
and to enter required coefficients. Press the Bridge Modeling Approach button on the
Bridge/Culvert Data editor. The editor will appear as shown (except yours will only have
the default methods selected). Low Flows Options. To use any or all of the low flow
methods, click the buttons under the Compute column. If either the Momentum or Yarnell
method are selected, the user must enter a value for the coefficients.

Only one of the methods can be selected as the answer to "Use". An alternative to
selecting a single method is to use the Highest Energy Answer.

High Flow Options. You can choose between Energy-based calculations or pressure
and weir flow calculations. Energy calculations will be based on standard-step calculations
through the bridge.

If pressure and weir flow is the selected, the user must enter coefficients. The first
coefficient applies to the equation that is used when only the upstream side (inlet) of the
bridge is submerged. If this coefficient is left blank, the program selects a coefficient based
on the submergence. The second coefficient applies to the pressure equation when both the
upstream and downstream end of the bridge is submerged. Generally this coefficient is
around 0.8. For more information on pressure flow coefficient~ see Hydraulics of Bridge
Waterways (FHWA, 1978).

Max Low Chord - Sets the elevation at which pressure flow begins to be calculated. If
this field is left blank, then the highest low chord elevation is used.

Once all of the bridge modeling approach information is entered, press the OK.

Bridges&Culverts\GWB\CTA
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• Culvert Data

2.1 L-04
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Culvert Data. To enter culvert specific information, press the Culvert button on
the Bridge/Culvert Data Editor window. When this button is pressed, the Culvert
Data Editor will appear as shown above.

Shape - The shape selection box allows the user to select from one of the eight
available shapes. This is accomplished by pressing the down arrow on the side of
the box, and then selecting one of the eight available shapes.

Rise - The rise field describes the maximum height inside of the culvert.

Span - The span field is used to define the maximum width inside of the culvert. he
span is left blank for circular culverts.

Chart #. - This field is used to select the Federal Highway Administration Chart
number that corresponds to the type and shape of culvert being modeled. Once the
user has selected a culvert shape, the corresponding FHWA chart numbers will
show up in the chart # selection box. See Hydraulics Reference manual.

Scale. - This field is used to select the Federal Highway Administration Scale
number that corresponds to the type of culvert entrance. Once the user has selected
a culvert shape and chart #, the corresponding FHWA scale numbers will show up
in the scale selection box.

Distance to Upstream XS - The distance from the upstream cross section to the
upstream end of the culvert. This data is only used to plot the culverts.

Length - The length field describes the length of the culvert along the centerline of
the barrel.
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Culvert Data - continued

2.1 L-04
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Entrance Loss Coefficient - This coefficient will be multiplied by the velocity head
inside the culvert at the upstream end. This value represents the entrance energy
loss.

Exit Loss Coefficient - This coefficient will be multiplied by the change in velocity
head from inside the culvert to outside the culvert at the downstream end. This
value represents the energy loss that occurs as water exits the culvert.

Manning's nfor Top - This is the Manning's n value of the top of the culvert barrel
and the sides above the depth to use bottom n value.

Manning's nfor Bottom - This is the Manning's n value of the bottom of the culvert
barrel and the sides up to the depth to use bottom n value.

Depth to use Bottom n - This is the depth for using the bottom n value.

Depth Blocked - The depth blocked filed defaults to zero but can be set to fill a
culvert to a input depth. The fill applies to the entire culvert length.

Number ofIdentical Barrels in Culvert - This field counts the number of identical
barrels. The number of identical barrels is limited 25.

Upstream and Downstream Invert Elevations - These two fields set the culvert
invert and define slope.

Upstream and Downstream Centerline Stations - These two fields set the location
of the cuIverts within the cross section.

Once all of the culvert information is entered, the user should press the OK.

•

•
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Flow Transitions

See Appendix B "Flow Transitions in Bridge Backwater
Analysis" in Hydraulics Reference, a summary from
HEC RD #42, September 1995.

7

The bridge and culvert routines utilize four user defined cross sections in the
computations of energy losses due to the structure. A plan view of the basic cross
section layout is shown above.

Cross section 1 is located sufficiently downstream from the structure so that the.
flow is not affected by the structure (i.e., the flow has fully expanded). This
distance should generally be determined by field investigation during high flows.

Cross sections 2 and 3 are the bounding sections for the bridge. Both sections
must be defined before the bridge or culvert data are input. They will be used to
define the bridge interior for the upstream and downstream bridge sections. Both
cross sections will usually have ineffective flow areas to either side of the bridge
opening during low flow and pressure flow profiles. To model only the bridge
opening these two sections, you should use the ineffective flow area option. This
option is selected from the cross-section data editor.

Cross section 4 is an upstream cross section where the flow lines are
approximately parallel and the cross section is fully effective. In general, flow
contractions occur over a shorter distance than flow expansions.

Research Doc 42, presents results examining the flow transitions. These results
are summarized in Appendix B, in the Hydraulic Reference Manual.

2.1 L-04
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Ineffective Area Option

• Bounding sections provide full conveyance

• When all flow is under bridge, Overbanks
cannot convey flow through highway fill

• Ineffective area option indicates overbank
storage instead of conveyance

• Station should be near abutments

• Elevation is set to define when overbanks
become effective - when water flows over
the roadway

8

The effective area option is used to define the ineffective flow portions of the
two cross sections bounding roadway crossings for bridges or culverts. If all the
flow is going under the crossing, then the active flow zone immediately upstream
and downstream from the crossing must be limited to the zone (area) flowing under
the roadway.

Stations. If the bounding cross sections are some distance (say 5 feet or more)
away from the roadway fill, the the active flow area should be wider than the width
of the opening under the roadway. Modelers often use a 1 to 1 transition rate in the
short distance upstream and downstream from the opening due to the more rapid
flow transition near the opening. This approach applies to both bridges and
culverts.

Elevations. The overbanks may be considered effective, once there is sufficient
roadway overflow. Because we do not know exactly what water surface elevations
will be appropriate and estimate must be made initially and then carefully reviewed
after the model is run. A reasonable initial estimate is the top of roadway elevation
for both upstream and downstream sections.

Bridges&Culverts\GWB\CTA
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Ineffective-flow Zone at
Bounding cross sections

-------------------------------------.-.--------------------------------------------------

6.0 Ips

Figure 7. Poley Creek Alabama, Q = 4600 efs. Velocity Vectors from RMA-2.

Note: Contraction - Expansion coefficients DO
NOT apply to unsteady flow solution for
contraction & expansion reaches

9

The ineffective area option is used at sections 2 and 3 to keep all the active flow in
the area of the bridge opening until the elevations associated with the left and/or
right ineffective flow areas are exceeded by the computed water surface elevation.
The program allows the stations and controlling elevations of the left and right
ineffective flow areas to be specified by the user. Also, the stations of the
ineffective flow areas do not have to coincide with stations of the ground profile,
the program will interpolate the ground station.

The ineffective flow areas should be set at stations that will adequately describe
the active flow area at cross sections 2 and 3. In general, these stations should be
placed outside the edges of the bridge opening to allow for the contraction and
expansion of flow that occurs in the immediate vicinity of the bridge.

2.1 L-04
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Ineffective Area Option
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The ineffective area options can be accessed from the bridge editor. Pressing the
section number box invokes the cross-section editor for that section and then the
Ineffective Flow editor. Two options are available: Normal or Blocked.

Normal makes the area to the left of Left and right of Right stations ineffective.

Blocked makes a zone, from beginning to ending station, ineffective.

Elevation defines the upper limit of the option. When the water surface elevation
exceeds the input Elevation, the option "disappears." That is, the entire area is
now effective.

Permanent is a new option in Version 3. If this option is selected, the ineffective
area remains, even when the water surface exceeds the Elevation. The zone will
remain as storage only and conveyance will be computed above the zone. When
that happens, a wetted perimeter is included along the "top" of the ineffective area
zone.

Bridges&Culverts\GWB\CTA
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• Hydraulic Parameters

2.1 L-04
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Hydraulic structures, such as bridges and culverts, are converted into families of
rating curves that describe the structure as a function of tailwater, flow and
headwater. The user can set several parameters that can be used in defining the
curves. To set the parameters for the family of rating curves, the user can select the
HTab Parameter button from the Bridge and Culvert editor or from the Hydraulic
connection editor. When this button is pressed the following window will appear:

•
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Hydraulic Property Tables

2.1 L-04

•
Number of points on free flow curve:

Number of submerged curves:

Number of points on each submerged curves: 120

Apply number of points to all bridges and culverts

Head water maximum elevation: 1225

Tail water maximum elevation (Optional): I'-22-0-

Maximum Swell Head (Optional):

Maximum Flow (Recommended): 150000

OK Cancel

• Default setting shown
• Max curves = 50
• Max points = 20

• Apply to all?
• Max head water elev.

• Optional
• Max tailwater elevation
• Max swell head (head - tail

water difference)

• Max flow

12

As shown in Figure above, the user can set the number of points to be computed
on the free-flow rating curve (maximum of 50 points); the number of submerged
curves to be computed (maximum of 50); and the number of points on the
submerged curves (maximum of20). The default values for these parameters are
40,40, and 10 respectively.

The Maximum Head Water Elevation is required in Version 3.1 or later.
Additionally, the user can refine the curves by putting limits on the extents of the
curves. This can be accomplished by entering the tail water maximum elevation;
maximum swell head (difference between the head water and tailwater); and the
maximum possible flow.

The Maximum Flow expected is good to define. This will ensure the rating
curves are processed to a flow high enough, but not too high.

Bridges&Culverts\GWB\CTA
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The results for bridge and culvert processing is a family of curves. The Free
Flow curve provides the Head Water-Flow relationship without Tail Water
influence. Then, the family of Tail Water-Head Water relationships are shown.
The curves define the change in water-surface elevations between the bounding
sections.

2.1 L-04
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Internal Boundary Plot 
Default Bridge Settings

File Type '1iew
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~.. . ,

14

The Internal Boundary curves can be displayed as a graphic or a table by
selecting the appropriate Tab. The Filename provides access to HTAB results for
all processed Geometry files in the Project. Only one can be displayed at a time.
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• Stage & Flow Hydrograph 
Bridge with Default Settings

2.1 L-04
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Stage and Flow hydrographs for bridges are accessed by clicking the Type menu
and selecting Bridges/Culverts. The display shows the Head Water and Tail
Water Stages along with Flow through the bridge. Check-boxes provide options for
Stage, Flow, Observed Stage, Observed Flow and Use Reference Stage.

•
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Internal Boundary Rating Curve

2.1 L-04

•

The Rating Curve was new to Version 3.1. The curve shows the Bridge HTAB
Rating in light grey with a sequential plot of the Head Water Stage - Flow for the
solution. This plot shows where the solution lies on the family of curves. If the
solution lies in empty space in the bridge rating, an improved rating with more data
in the region should improve the solution.

•
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• HTAB - Set Optional Settings

2.1 L-04

Number of points on free flow curve: 150

Number of submerged curves: r=150:-O--

Number of points on each submerged curves: 120

Apply number of points to aU bridges and culverts

Head water maximum elevation: 1225

Tail water maximum elevation (Optional]: '-=-122:-:-0--

Maximum Swell Head (Optional): 1
Maximum Flow (Recommended): r:::150-:'::OO::"::O-

OK Cancel

• Increase number of
curves & points

• Shorten the range to
provide better definition
• Reduced headwater

• Set Max Tailwater

• Set Max Flow
(default = Flow at Max Free

flow Headwater)

• Or set optional Max Swell
Head

•

•

17

The first demonstration solution is performed with the Default settings, plus the
required Headwater elevation. The second example has HTAB settings to increase
the data within the range of expected solutions.

The number of curves was increased to 50 and number of points on the
submerged curves to 20. The Maximum Headwater elevation was reduced one
foot, the tail water was set, and the Maximum Flow was set to a value slightly
higher that the expected values.

Bridges&Culverts\GWB\CTA 17
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Stage & Flow Hydrographs
Default (red) & Optional HTAB

Legend

Stllge t'+IV. De/id HI:Ib
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Stsge1'W·100Y1Evrt

2.1 L-04

•
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18

The Stage hydrographs are shown for the two solutions at the bridge. The curve
in red (dark) is the created using "optional" values for the HTAB processor. The
results are essentially the same except during the transition into and out of pressure
flow. The transition into and through pressure flow is often the most difficult
portion of the solution.

Here you see that using the more "refined" hydraulic properties results in a more
abrubt transition through pressure flow. The answer may be more accurate but
result in a less stable model.

Bridges&Culverts\GWB\CTA
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• Cross Section Properties with
Normal Effective Area Option

2.1 L-04

ViewHYdrauliCP~opertyTables ~ ~- -~:~--- -- - - -,- --~t!J~~

Fie Type VIew
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R"'" !o....... Cook ::::J Po,..... J 4110.29.205.64

R._ !'''''wood ::::J Riv St" !5... 3 .!J.!J -"aria.blos:::.!
PIo<I~ •

Legend
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r7~---=========::::::==mSI,,~qAte~('058.82. 215.78)

£
.5

~ 210

208

206

""
202

a

Property Table
RS-S,41

Convey!lll'lCenooo (cIS) Stor8ge (sq ttl

• The effective area option also impacts on the transition through pressure flow
and into weir flow. The red (bold) curve shows the storage for the Normal
Effective Area option. Once the controlling elevation is exceeded, the option
disappears, the storage zone becomes conveyance, and there is a sharp increase in
conveyance. The transition between the option being on and off is a zone of
potential instability, similar to exceeding the Levee Option elevation. One solution
to this problem is to raise the Manning's n values in the ineffective area zone, so
when they tum off the transition is not so abrupt. This also gives more reasonable
flow conveyance for flow going over the bridge embankment in the overbank areas .

•
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Cross Section Properties
Permanent Ineffective Area Option

2.1 L-04

•
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The Permanent Option keeps the Storage Area for all elevations exceeding the
control elevation. Below the controlling elevation, the two options are the same.
When the elevation is exceeded, Conveyance is only computed above the storage
area. This option reduces the shock from the storage area suddenly disappearing.
The following slide shows the application of Permanent Storage compared to the
Normal option with the Default settings.

Bridges&Culverts\GWB\CTA
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Head.water - Tailwater Stage
Normal & Permanent Ineffective Area

!).~..t_
~H"'f.P",lIlflt<!(l

&~1W.~f.rf~

Sc~1W·.f*A

While the Permanent Option would seem to reduce the transition problem, it
often does not. The problem comes from the limited conveyance available with the
over-bank area treated as permanent storage. The upstream energy is higher for the
high flows, but the increased upstream energy goes to Velocity Head. The water
surface does not smoothly increase. The result, above, shows an upstream water
surface dropping and rising as the solution progresses. Also, the upstream water
surface around the peak is much higher because the cross section has less
conveyance with the permanent storage.

•
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Multiple Blocks Ineffective Area

Ineffeclive Flow Areas

~!-.---=------:::::,~,.-----=------;;!.
St._I")

22

A second approach could set the effective area option at several elevations. The
zone near the channel would disappear first providing a limited increase in
conveyance. Then, as the flow-stage goes higher, the second block would become
conveyance. This should reduced the shock of the storage changing to conveyance
and it seems reasonable that the area near the channel would become active
conveyance before the fringe area would. This approach is demonstrated in the
next slide.
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Cross Section Properties
Blocked Ineffective Area Option
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The storage for the multiple block option is shown above for the downstream
bounding cross section. The storage decreases in two elevation steps, instead of
one.

2.1 L-04
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Headwater - Tailwater Stage
Normal & Blocked Ineffective Area

2.1 L-04

•
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The bridge stage hydrographs are shown for the Default and the Multiple
blocked effective area option. The results do not significantly vary for this
example. However, the approach has potential application for wide cross-sections
where total over-bank conveyance does not make sense..
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• High n values for Ineffective
Area

.......... -
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2.1 L-04
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At times, the effective-area option may create computational instability that
cannot be resolved. An alternative is to use high n values to reduce conveyance.
This approach is often used in the bounding sections, with the effective-area option,
to better match over-bank flow with the roadway overflow from the bridge solution.
In this example, the effective-area option is not used. Therefore, in this approach
the high n values replace the effective-area option.
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Cross Section Properties
High n for Ineffective Area
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2.1 L-04

•

The HTAB results show no Storage. The storage area is all conveyance, but at a •
lower value due to the high n.

•
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Headwater - Tailwater Stage
Normal Ineffective Area & High n

The red (bold) Stage Hydrograph for the High n and the Default solution is
shown above. The transition zone is much smoother for the High n solution. Also,
the peak stage is higher due to the high n values. With this approach, care must be
taken to ensure that the high n values do not unreasonable raise the peak stage.

2.1 L-04
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Ineffective Area
Recommendations

• Set the Ineffective Area option to eliminate overbank
flow in the bounding sections where the flow is
blocked by the roadway, until significant roadway
overflow

• Use higher overbank n to "balance" overbank flow in
bounding sections with computed overflow
• Expect transition problems near controlling elevations
• Higher overbank n will tend to reduce compuationai shock

• If the ineffective Area option creates instability, try
Higher n only

• Review bridge solutions with Bridge Tables
• Document adjustments in Bridge Description Box

28

Generally, the bridge or culvert solution defines how flow moves through and
over the roadway crossing. The modeler must manipulate the bounding cross
section characteristics to reasonably match the bridge/culvert solution. The degree
these adjustments are made depend on the relative importance of the bridge solution
to study objectives.

The Bridge/Culvert hydraulics should be initially resolved with Steady-flow
solutions. However, there are usually additional adjustments required because the
unsteady-flow solution processes through the entire range of flow from low to very
high. The general approach listed above is the same as steady-flow applications.
Due to the complexity of the unsteady flow solution, there may be need for
additional adjustments to provide a stable solution.
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Internal Boundary
o.....er.I<K...-S.• 8R

•

•

•

Internal Boundary for Bridge with
Fixed Sluice Gate Coefficient

• If Pressure & Weir Rating creates a
problem:
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The variable gate-equation coefficient sometimes creates Head water shocks at
the start of pressure flow. Hydraulic texts often show the use of a constant
coefficient around 0.45 for the gate equation. In RAS, the Submerged Inlet Cd can
be defined, as shown in the example above. The results for this option is shown in
the next slide.

The sluice gate discharge coefficient computed by RAS is illustrated in Figure 5.5
of the Hydraulic Reference Manual.

2.1 L-04
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Default & Set Sluice Gate Coefficient
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The red (bold) stage hydrograph shows the fixed coefficient solution compared
to the default solution using the Coefficient Curve. While neither solution looks
ideal, the fixed coefficient shows a lower headwater for much of the transition
through pressure flow.
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• Convert Energy Method Bridge

2.1 L-04
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Bridges modeled using the Energy Method for both high and low flow can be
processed as cross sections with a lid. RAS will create interior sections with RS
numbers between the bounding sections. These cross sections will be represented
with Conveyance and Area Curves like regular cross sections.

You can process Energy Bridges as cross sections by selecting the Calculation
Options from the Options Menu in the Unsteady Flow Window. At the top of the
Calculation Options Menu is Convert Energy Method Bridges to Cross
Sections with Lids. This option will only affect the Energy Only bridges.

•
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Hydraulic Bridge Properties Energy
Only processed as section

2.1 L-04

•
• Check results

carefully

• Conveyance can
quickly decrease at
the bridge deck

• Better to process as
internal boundary if
conveyance solution
is a problem
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The Hydraulic Properties display shows the Bridge results as cross sections. The
red (bold) line shows the channel conveyance. One problem with this approach is
the sharp reversal as the water hits the low chord. The reversal of the functions
tend to cause computational problems in the transitions zone.

•

•
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The red (bold) stage hydrograph shows the Energy Only solution compared to
the Default options. Note the smoother transition through the pressure-flow zone.
However, the energy solution shows a much higher stage for roadway overflow.
The energy method is using the cross-section n values for computing the roadway
flow. The use of higher n values at the bounding sections will affect this solution.
The interior bridge sections can be edited to modify those n values.

•

•

•

Headwater - Tailwater Stage
Energy Only vs. Pressure & Weir

l ~....,.-...

!....-.~....,

• Note that energy method will use overbank and channel n
for high flows 33
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Profile Plots with Post
processing

2.1 L-04
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With post-processing, all the standard output options are available. The profile
plots can show the flow through the bridge by selecting rising, or falling stage
profiles. The animation option is a convenient way to look at the profiles, one at a
time.

•

•
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Profile Output - Bridge Only

--- ------- - -----

35

The Bridge Only Summary Table provides all bridge solutions at the post
processing interval. This table is useful to see bridge flow and weir flow. Note
when weir flow begins and overflow magnitude. This information will be
compared to the flow distribution in the bounding cross sections.

2.1 L-04
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Profile Output 6 Sections
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•

lOFEBI9~ 2100
IOfEBI9~ 2200 215.26'
10FEB19~ 2300 215.33'

Ken/wood 5.425
Kentwood 5.425

Reach Ri....er Stll Ptofilo

Kentwood 5.41

Kentwood 5.41

Kentwood 5,4

Kentwood 5.41

Ken/wood 5.425

Kentwood 5.4

Kentwood 539
Ken/wood 5.39

Kentwood 5.4

Kentwood 5.39

Kentwood 5.4

Kentwood 5.4
Kentwood 5.4

Ken/wood 5.37
Kentwood 5.37
Kentwood 5.37

36

The 6-Section Summary Table shows the flow distribution upstream and
downstream from the bridge. Also, the components of energy loss are shown for
the steps through the bridge and transition sections. •

•
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Profile Output - Bridge Comparison
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.. ......• if9.1!i· 217.36
·•.. 2i936Cl.1..18i···

219.82' 217.48i
22{)47L217~i

1.13, 217.61;

····,·:·~~··~~··~~·~~I~r ...·..····
221.66 217.67;

... j 221.65 217.66

.L~·""'??!·':'~M(".~·"".~·".?!.i¥~t~ .
.......,. 221.29· 217.63

, 220.88' i1 7.59:

.L. ~.~ r,;~i£

I,;,.. ---------~37

The Bridge Comparison Summary Table shows the basis for each solution.
While the table is usually used to compare different solution methods, the unsteady
flow model should not be run using multiple methods. The decision should be
made on the appropriate method and that should be fixed.

2.1 L-04
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Detailed B~idge Output

••••••••••~Ei~t3 • Post processing
provides Interior Bridge
Data and Energies

El;-::,:~~:\\:\]~~il. Contraction &
Expansion is turned off

~l.•••••••••••••';jE[l::;~[~I. Notes & Warnings give
solution information

'--'-----1. Use summary tables to
get overview
Detailed for problems

38

Graphics and Summary Tables provide a good overview of the solutions. When
there appears to be some difficulties in a solution, the Detailed Output Table
provides the solution for a specific time. Also, the Notes section can be helpful
describing the assumptions and steps of the solution.

Bridges&Culverts\GWB\CTA
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2.2 W-03

Workshop
Modeling Bridges with Unsteady Flow

Introduction

This workshop will help students learn how to use HEC-RAS to: model bridges using
unsteady flow, and to review and understand pertinent bridge output. Sensitivity of
simulation results to model changes will be reviewed.

Background

Figure 1 shows the study region, Beaver Creek near Kentwood, Louisiana. Shown in
Figure 2 is a photograph of the river reach, which is looking upstream at the bridge
crossing. These two figures and the data for this study were taken from the USGS
study" Backwater at Bridges and Densely Wooded Flood Plains, Beaver Creek Near
Kentwood, Louisiana" by George J. Arcement, B.E. Colson, and C.O. Ming.

•

J1* _

C.o .', JI'

EXPLANATION

•Site ~ocation

. 31"

•
FIGURE 1.-1 DEX MAP OF STUDY SITES I THE RIDGE BACKWATER

INVESTIGATION PROJECT. ALABAMA. LOUISIANA. AND MISSISSIPPI.
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FIGURE 2-AERIAL VIEW LOOKING UPSTREAM AT BRIDGE
o STATE HIGHWAY ·1049 NEAR KEf TWOOD, LOUISIANA

Problem

A project file (BridgeModeling.prj) with the title "Bridge Modeling Workshop 
Unsteady Flow" has been loaded on your workshop computers. This file contains all
of the data for this workshop, except the bridge modeling data. The following is a
summary of the required tasks for each group:

1. Open the project and enter all of the necessary information to model the
bridge. Then save the data.

2. Create a plan file and compute steady-flow water surface profiles.

3. Review the results and make necessary adjustments.

4. Compare the computed results from the third profile with the observed
high water marks.

•

•

•
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2.2 W-03

Complete any required model calibration. Select a single method for low
flow and the appropriate high-flow method.

•

•

6. Review the steady-flow results and determine the appropriate settings for
processing the bridge data (HTAB).

7. Set up the model for an unsteady flow simulation with the 1974 flood
hydrograph.

8. Perform the unsteady-flow simulation and evaluate the results.

Tasks

1. Enter the Bridge Information

The bridge is located at river station 5.4 of Beaver Creek. A cross section of the
bridge is shown in Figure 3. The Bridge Design Editor can be used to enter the
deck and road embankment and the pier data.

• Road embankment is at a constant elevation of 216.93 feet.
• The bridge low chord is at elevation of 215.7 feet.
• The bridge opening has vertical walls at cross section stationing 450 and

647 feet. (A zoomed in view of the bridge opening is shown in Figure 4.)
• The bridge deck is 40 feet wide, and the upstream side of the bridge deck

is 30 feet from cross section immediately upstream of the bridge (section
5.41). The upstream and downstream sides of the bridge are exactly the
same.

• As shown in Figure 4, the bridge has 9 piers. The piers are 1.25 ft. wide
each and have a square nose. The piers are spaced 20.0 ft. apart on
center, starting with the first pier at station 470.0 ft.

Select a bridge modeling approach for both low flow and high flow. Enter the
necessary coefficients for the selected modeling approaches. Also, remember to
add ineffective flow areas at the cross sections that bound the bridge. SAVE
THE GEOMETRIC DATA.

Bridge Modeling Workshop 3 VRB/GWB/CTA
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Figure 3. Bridge Cross Section
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Figure 4. Zoom in View of Bridge Opening

2. Compute Steady-flow Water Surface Profiles

Once you have saved the geometric data, create a new steady flow plan. The
steady-flow file is set for three profiles: 5000, 10000, and 14000 cfs. Give the
plan a title and remember to enter a short 10 for the plan, and save the data. •

Bridge Modeling Workshop 4 VRB/GWB/CTA
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3. Review The Results

Review the results to ensure that the computed water surface profiles are
reasonable. Make necessary adjustments to the model.

4. Compare the Computed Results With Observed Data

The flow rate used in the third profile (0=14,000 cfs), is the same as an observed
event that occurred on May 22, 1974. The USGS obtained high water marks and
average values were estimated from the high water marks.

d H" h W t M kT bl 1 Oba e serve Ig a er ar s

Cross Section River Stationing Observed WS Elevation in Feet

5.99 220.0

5.76 218.4

5.61 218.1

5.44 217.8

5.41 217.8*

Bridge 5.40

5.39 215.2*

5.29 214.9

5.13 213.6

5.00 211.8

•

*Note: The observed high water mark at this location is questionable.
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5. Set up an Unsteady Flow Simulation.

Based on your review of the steady-flow simulation, determine the appropriate
settings for the bridge processing (HTAB). Set the HTAB values and save the
geometry file. You don't have to rename it.

The flood hydrograph used in the previous workshop will be applied here, along
with the downstream boundary and initial flow. The hydrograph represents the
May 1974 flood. An unsteady flow file has been saved with your project, you will
need to load it. The flow file is titled "May 1974 Flood" and is the
"BridgeModeling.u01" file

Set up an unsteady flow simulation. Decide the appropriate time interval and set
any required parameters. Save the plan as a new name and run the simulation.

6. Review the Results for the Unsteady-flow Simulation.

Review the results to ensure that they are reasonable. Compare the results for
the maximum stage to those from the third profile with the observed data. Make
any necessary changes and run the simulation again, until results look
reasonable. Keep track of the changes you make.

Questions

1. How do your steady-flow results compare to the observed data? What
methods did you use?

2. What settings did you use for HTAB on bridge model processing?

3. What changes did you make to the unsteady flow model, after you were
satisfied with the steady flow solution?

4. How did the unsteady-flow simulation compare to the steady-flow profile with
14,000 cfs?

•

•
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Inline and Lateral
Hydraulic Structures

Gary Brunner

L-08(188-08)/2007IGWB/SAG
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Overview

• Introduction
• Inline Structures
• Entering Inline Structure Data

• Lateral Structures
• Entering Lateral Structure Data
• Controlling Inline and Lateral Gate Settings

• Inline and Lateral Structure Output

L-08(188-08)/2007IGWB/SAG
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Introduction--
• Inline or lateral gated spillways, uncontrolled

over-flow weirs, lateral culverts, and lateral
rating curve.

• Can be used to model the following:
• Large to Small Dams
• Run 'of the river Structures
• Detention ponds
• Drop Structures or natural drops
• Lateral storage facilities
• Natural overflows to ponding areas

This version ofHEC-RAS allows the user to model inline gated spillways, overflow
weirs, drop structures, lateral gated spillways, lateral weirs, lateral culverts, and
lateral rating curves. HEC-RAS has the ability to model radial gates (often called
tainter gates) or vertical lift gates (sluice gates). The spillway crest of the gates can
be modeled as either an ogee shape or a broad crested weir shape. In addition to the
gate openings, the user can also define a separate uncontrolled overflow weir.

L-08(188-08)/2007/GWB/SAG
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Inline Hydraulic Structures

• Radial ga.tes (often called Tainter gates)

• Vertical lift gates (Sluice gates)

• Overflow Gates (Open air or closed top))

• Ogee, Broad Crested, or sharp crested Weir
shapes for both gated spillways and overflow weirs

• Gate equations can handle low flow, normal gate
flow (upstream submerged) or fully submerged
gate flow (both ends submerged)

• Up to 10 gate groups can be defined at any river
crossing. Up to 25 identical gates per group.

Gated Spillways within HEC-RAS can be modeled as radial gates (often called
tainter gates) or vertical lift gates (sluice gates). The equations used to model the
gate openings can handle both submerged and unsubmerged conditions at the inlet
and outlet of the gates. If the gates are opened far enough, such that unsubmerged
conditions exist at the upstream end, the program automatically switches to a weir
flow equation to calculate the hydraulics of the flow. The spillway crest through the
gate openings can be specified as either an ogee crest shape or a broad crested weir.
The program has the ability to calculate both free flowing and submerged weir flow
through the gate openings.

Up to 10 gate groups can be entered into the program at anyone river crossing.
Each gate group can have up to 25 identical gate openings. Identical gate openings
must be the same gate type; size; elevation; and have identical gate coefficients. If
anything about the gates is different, except their physical location across the
stream, the gates must be entered as separate gate groups.

L-08(188-08)/2007/GWB/SAG

2.3 L-05

4

•

•

•



•

•

2.3 L-05

L-08(188-08)/2007/GWB/SAG 5



2.3 L-05

•

•
L-08(188-08)/2007IGWB/SAG 6



• Cross Section Locations

2.3 L-05

The inline hydraulic structure routines in HEC-RAS require the same cross sections
as the bridge and culvert routines. Four cross sections in the vicinity of the
.hydraulic structure are required for a complete model, two upstream and two
downstream. In general, there should always be additional cross sections
downstream from any structure (bridge, culvert, weir, etc...), such that the user
entered downstream boundary condition does not affect the hydraulics of flow
through the structure. In order to simplify the discussion of cross sections around
the inline hydraulic structure, only the four cross sections in the vicinity will be
discussed. These four cross sections include: one cross section sufficiently
downstream such that the flow is fully expanded; one at the downstream end of the
structure (representing the tailwater location); one at the upstream end of the
structure (representing the headwater location); and one cross section located far
enough upstream at the point in which the flow begins to contract. ote, the cross
sections that bound the structure represent the channel geometry outside of the
embankment

EXPANSION

REACH

FLOW

Inline Weir River
Stationing is 2.5

_---.JLJ! o~.ow w.;,

~Gated Spillways

CONTRACTION
REACH

FLOW

•

•
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Radial Gates •

The flow through the gate is considered to be "Free Flow" when the downstream tailwater
elevation (ZD) is not high enough to cause an increase in the upstream headwater elevation for a
given flow rate. The equation used for a Radial gate under free flow conditions is as follows:

Where:

Q == C~2g WT TE
BEE HHE

H =Zu - Zsp

C =Discharge Coefficient, typically 0.6 - 0.8

•
Where: Q= Flow rate in cfs

C = Discharge coefficient (typically ranges from 0.6 - 0.8)

W = Width of the gated spillway in feet

T = Trunnion height (from spillway crest to trunnion pivot point)
TE = Trunnion height exponent (default 0.0)

B = Height of gate opening in feet

BE = Gate opening exponent (default 1.0)

H = Upstream Energy Head above the spillway crest Zu - ZSP

HE = Head exponent (default 0.5)

Zu = Elevation of the upstream energy grade line

ZD = Elevation of the downstream water surface

Zsp = Elevation of the spillway crest through the gate

•
L-08(188-08)/2007IGWB/SAG 8
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Radial Gates

L-08(188-08)/2007IGWB/SAG

2.3 L-05

9



Fully Submerged Gate Flow

Orifice Equation

Q=CA~2gH

Where: H =Zu - Zo

C =Discharge Coefficient, typically 0.8

L-08(188-08)/2007IGWB/SAG

2.3 L-05

10

••

•



•
2.3 L-05

40 -,---------------,.---,------,

35 

30 

25-I/)
'ti 20-(1

15 -

10 - -Free Flow

5 -Submerged
- Transition

1.00.80.60.4

Submergence (Zd/Zu)

0.2

O+-----,--------,-------r-......-l..----L----~

0.0

•

•
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Subm~rged Radial Gates

When the dqwnstream tailwater increases to the point at
which the upstream headwater is affected (downstream
submergence is causing a greater upstream headwater
for a given flow), the program switches to the
submerged form of the equation. This is assumed to
occur at 67 percent submergence.

Where: H =Zu - ZD

Submergence begins to occur when the tailwater depth above the spillway divided
by the headwater energy depth above the spillway, is greater than 0.67. The
Equation above is used to transition between free flow and fully submerged flow.
This transition is set up so the program will gradually change to the fully submerged
Orifice equation when the gates reach a submergence of 0.80

L-08(188-08)/2007/GWB/SAG
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Where:

Sluice Gates

I

Q=CWB~2gH

H =Upstream energy head (Zu - Zsp)

C = Coefficient of discharge, 0.5 to 0.7

2.3 L-05
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Sluice Gates
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• Submerged Sluice Gates

Q==CWB~2g3H

2.3 L-05

Where:

•

•

Transitions to fully submerged Orifice flow at 0.8
submergence:

Q CA~2gH

Submergence begins to occur when the tailwater depth above the spillway divided
by the headwater energy above the spillway, is greater than 0.67. The above
Equation is used to transition between free flow and fully submerged flow. This
transition is set up so the program will gradually change to the fully submerged
Orifice equation when the gates reach a submergence of 0.80.

L-08( 188-08)/2007IGWB/SAG 15



Where:

Overflow Gates

----'---=-=- Z D

~~.dr~

Q= CLH 3JL
H = Upstream energy head (Zu - Zsp)

C =Coefficient of discharge, 3.1 - 3.3

2.3 L-05
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•

•
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Low Flow Through Gates

Q C LH3
/
2

When the upstream water surface is equal to or less than the top of the gate opening,
the program calculates the flow through the gates as weir flow.

The user can specifY either a broad crested or ogee weir shape for the spillway crest
of the gate. If the crest of the spillway is ogee shaped, the weir coefficient will be
automatically adjusted when the upstream energy head is higher or lower than a
user specified design head. The adjustment is based on a curve (Bureau of
Reclamation, 1977). The curve provides ratios for the discharge coefficient, based
on the ratio of the actual head to the design head of the spillway.

The program automatically accounts for submergence on the weir when the
tailwater is high enough to slow down the flow. Submergence is defined as the
depth of water above the weir on the downstream side divided by the headwater
energy depth of water above the weir on the upstream side. As the degree of
submergence increases, the program reduces the weir flow coefficient.
Submergence corrections are based on a trapezoidal (broad crested) or ogee shaped
welL

L-08(188-08)/2007/GWB/SAG
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Uncontrolled Over-Flow Weirs

• Can represent Emergency Spillway or
flow over entire Embankment.

• Uses Standard Weir Equation

• Can have Ogee, Broad Crested, or
Sharp Crested weir shape

• Weir flow submergence is calculated

In addition to the gate openings, the user can define an uncontrolled overflow weir
at the same river crossing. The weir could represent an emergency spillway or the
entire top of the structure and embankment. Weir flow is computed using the
standard weir equation. The uncontrolled overflow weir can be specified as either a
broad crested or ogee shaped weir. If the weir is ogee shaped, the program will
allow for fluctuations in the discharge coefficient to account for upstream energy
heads that are either higher or lower than the design head. The program will
automatically account for any submergence of the downstream tailwater on the
weir, and reduce the flow over the weir. The modeler is referred to Chapter 5 of the
Hydraulic Reference Manual for additional discussions concerning uncontrolled
overflow weirs, including submergence criteria and selection of weir coefficients.

L-08(188-08)/2007/GWB/SAG
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• Entering Inline Structure Data

2.3 L-05

Ele l1iew Qptions tjelp

River: IN~lanjl River ::J t<(;ply D"i~

Reach: IWeir Reach ::J River Sta·:141.75

Upsl,eamXS: 41.76 I Upslream channel lenglh: 9O(ft)

Descriplion Iinline Weir andGaled Spillway 0
Pilot Flow 10 Breach {plan dala)... Rules (unsteady data) .. I

'Weir /
fmD3llcmtnt....... Inline Structure with 3 Gate Groups 41712006 10:47:55 AM

Inline structure data are entered in a similar manner as bridge and culvert
data. To enter an structure press the Inline Structure button from the
Geometric Data window.

DU][IJJIlJJJ][IJD

LegendGround
----4----

Ineff
•

Sank sta

1000800600

station (n)

400200

30

20

10

-10

•

•
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Weir and Embankment Profile

2.3 L-05

•

1----:1+0"~ , ,.,,}?
2 57. 13.5

ElevationStation

Clear Del Row I Ins Row I
'~j¥J'l!,J.'I,I.I$Mii·I"§':II{.ltftm~

361, 9.54 ·190~ .. ---_ ......._---..... _... -i5......_.._ ..---.._-_ ...._...
5 194. i13.561OOO.:::=-......_~..:TiI-.......-.......-:=::::-....._-....===:
7 'R - - _ _ -i--..- - -- _ ....:J

0.5 Embankment 55 rr--U.S Embankment 55
,Weir Data------------------,
iWeir Crest 5hape
JOB road Crested
!@ 0 gee 5pillway Approach Height:

Design Energy Head:

OK Cancel

[Enter distance between upstream cross section and deck/roadway. (ft] •The Embankment and Weir data are entered together, and are used to
describe the embankment blocking the stream as well as any uncontrolled
weirs. To enter the weir and embankment data, press the
Weir/Embankment button and the editor will appear.

•
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• Gate Editor

2.3 L-05

"'~ ~ • .., ~N'''' _~ ~ --

Inline Gate Editor ,£~_ .4~$;f®"'*

Gate G,oop: ILeil G.O<lP

To add gated spillways to the structure, press the Gate button on the Inline
structure data editor. Once this button is pressed, the gated editor will
appear. The Gated Spillway editor is similar to the Culvert editor in concept.
The user enters the physical description of the gates, as well as the required
coefficients, in the Gated Spillway editor. The functionality of the gates is
controlled from the Unsteady Flow Data editor. Please see Chapter 6 of the User's
Manual for a complete description of the data contained in this editor.

........................_ •••••__._••••••• ~•••fi ••••••• "

'Wei Flow Over Gate Sib {gate ali of wate'r·~··· ..···········_··_······

We. Shape: IO\JOe :::oJ!

~i

Cd ... 11

Head Reference:

We. Coefr~ient:

SpilwayApproa<:hHeigh!:~
Oesigl Enetgy Head: r;-o--

, Rodal Gale Flow - OV~liow (closed top)
i Radial Discharge Coelfic' Overflow (open al)
j User Defi'led ClIves

,,~,- Ii Opening E,ponent: P-
, Head E,ponent: ~

i T.unnionHeight ~
, eROw................. .....•...]

{typicaMy O.B}: ro:a-
IS~ Iinvetl] :::oJ

Height: ~

Width: W-
Invert: ~

nOpenings: ~

MltMtflti,ri!..i;tW
Station

1 220.
2 255.
3 290.
4 325

5)~IJ. .,
6 ......................•...._..._._.
7
B
9

, 10
i 1'"

12::=-=.1

•

•
L-08(188-08)/2007/GWB/SAG 23



Overflow Gates Data
" "" ~ - -",,- , «>V ~_~ _ ~w==m='" '"'"

Inline Gate Editor '~ ,," ')

2.3 L-05

•
Ga,e G,eup: ILeft G,oup

Gale ,ype (or melhodologyl JOv.,II"", (open ail) :::J
r Geometric Properties --_.. Flow Over Gate

i Height

!W<!th:

I Invert

i nOpenings:

Stalion
, 220,
2255 m

••

329ii

Wei, Shape 'Sharp Creded :::oJ
Weir Method: fUse, entered coefficient ::::J
'WefF Coefficient Co~te wah R~hbock eqn

Co ute with Kindsvater-Cartel e n

4 325.
5360.6 -- ----.. -

_._..._._...._-_.._....
7 ........................_...._._.....
8

, 9 ....
j 10 ---------

i "

Rises and falls from the bottom rather than the top (as the sluice and radial options
do)

The invert varies rather than the high chord

Can also be used for inflatable weirs and slat gates

Can use standard weir equation, Rehbock equation, or Kindsvater - Carter equation.
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User Defined Curves

:::J.!l..!J .QJ~~~
Mnmet¢t5i1!iI W'·!4I· ~t'·!jd5m !,,0,1I*" tffl19b\1,;u:milti.-,
~ ~ ~ ~ ~ ~

1 G~e Open Ht\H\llj 581 ..~:.. 59J~ 595 ....~ 61 0:
Select Curves Set J

--..::.J! .

lnveft

••min:I@I.",. ! !
St"tion ... ! 1

, 220. ! !
2255." I
~.~. ;1
5 360.
6
7
8'
9····

lD .

1'·····

12

Gale type (or methodology); IUser Defined r

,... Geometric PtOperties ._-, rU$er Defiled Curve$ ----.--.p---

I Height r;o--
Wodlh ~

ro-
~

•

•
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Lateral Structures

• Radial, Sluice, and Overflow Gates

• Culvert groups

• Uncontrolled Overflow Weir

• Rating Curves

• Same Hydraulic Equations for Gates as with
Inline Structures

• Lateral structure Can handle a sloping water
.surface as .well as irregular weir profile.

HEC-RAS has the ability to model lateral structures that contain overflow
spillways, gated spillways, culverts, and diversion rating curve. The user can set up
a lateral structure that is any combination of the available opening types. The gated
spillways can have either radial gates (often called tainter gates) or vertical lift gates
(sluice gates). The spillway crest of the gates can be modeled as either an ogee
shape or a broad crested weir shape. Culverts can have flap gates, which will
prevent flow from going in both directions. The user can specify which flow
direction the culvert is limited to. A Diversion rating curve can also be added to the
lateral structure in order to model a hydraulic element that is not available in HEC
RAS.

L-08(188-08)/2007/GWB/SAG

2.3 L-05

26

•

•

•



• Cross Section Layout

2.3 L-05
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Lateral -c:
Weir
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Main
Channel

•

•

At a minimum there must be a cross section upstream of, and a cross section
downstream of the lateral structure. The upstream cross section can either be right
at the beginning of the structure, or it can be a short distance upstream. The
downstream cross section can be right at the downstream end of the structure or it
can be a short distance downstream. The user can have up to 98 additional cross
sections in the middle of the structure. The river stationing of the structure must be
based on the upstream end of the structure. For the example above, one could have
assigned a river station for the lateral structure as 5.25 .
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Lateral Weirs can be used to control the exchange of flow between channels in RAS
and can be specified in Geo-RAS

•

•

•
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• Lateral Structure

2.3 L-05

Overflow
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Gated
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Invert

•

•

If there are gated openings in the structure, the hydraulic computations for lateral
gated spillways are exactly the same as those described previously for inline gated
spillways. The only difference is that the headwater energy is computed separately
for each gate, based on its centerline location along the stream. The headwater
energy for each gate is interpolated linearly between computed points at each cross
section.

Culvert hydraulics are computed with the same principles and equations as inline
culverts. The only difference is that the program interpolates on the water surface
in the river to figure out the water surface at the centerline of each individual
culvert.

The water surface across the weir has a slope to it. Additionally, the weir itself
could be on a slope. Because of this, an equation for weir flow with a sloping water
surface and weir sill had to be derived.
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•Lateral Weir Calculations

•The equation for a sloping line representing the water surface and the weir segment are shown. The
constants a

ws
and a

w
represent the slope of the water surface and the weir segment, respectively,

while the variable C and C are constants representing the initial elevations.
ws w

The standard weir equation assumes that the weir is parallel with the water surface (i.e. that the
depth of water is constant from one end of the weir segment to the other). The above general
equation is derived for a sloping weir and water surface by integrating the standard weir equation.
The above equation is valid as long as a, is not zero. When a, is zero, this implies that the water
surface and the weir segment are parallel. When this is true, the original weir equation is used.

Within HEC-RAS, flow over a lateral weir can be computed from either the energy grade line or the
water surface elevation. The standard weir equation is derived with the upstream energy head being
based on the distance from the weir sill to the upstream energy gradeline. The water surface is the
default for a lateral weir computation. However, the user has the option of instructing the program
to use the energy gradeline elevation when computing the head term of the weir equation. Using
the water surface would be most appropriate when the weir is located close to the main channel. In
this situation the energy due to the velocity head is in the downstream direction, and not over the
top of the lateral weir. Therefore, the computation of the energy head over the lateral weir is best
depicted by using the water surface of the flow in the chalmel. •
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• Entering Lateral Structure Data
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•

Lateral structure data are entered in a similar manner as bridge and culvert data. To enter data for a
lateral structure press the Lateral Structure button from the Geometric Data window. Once this
button is pressed, the Lateral Structure Data editor will appear.

The user selects "Add Lateral Structure" from the Options menu. A river station just downstream of
the cross section upstream of the beginning of the lateral structure should be used to define the
location of the structure. A position of the structure should be entered. This tells the program if the
structure is located at the left overbank, next to the main channel bank on the left or right side, or in
the right overbank. The user must then connect the lateral structure to either a storage area or
another river reach.

Additional options for the lateral hydraulic structure are to set the routing type and flap gate control
for culverts. The routing type can be either "WeiriGates/CulvertsfDiversion Rating Curve" or
"Linear Routing". The linear routing option is used to specify a simple storgage routing option using
a linear reservoir routing method. The user enters an elevation for an assumed weir and linear
routing coefficient. The flap gate option allows the user to control the direction of flow through the
culverts. The default is no flap gates, and flow can go in both directions. If the option for "No
negative flow flap" is selected, this means that flow can only go through the culvert in the positive
flow direction, which is away from the river. If the option" 0 positive flow flap" is selected, then
no flow will go away from the river through the culvert, but it will be allowed to come back out once
the river stage is lower than the stage that the lateral structure is connected to. The rating curve
option allows the user to specify an elevation versus flow relationship for taking
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Lateral Weir Embankment Data
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•
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~

Cancel I

.............

OK

Weir Crest Shape:
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:"IffiRf',[,lt:l(I1'9'jWlfM lIB..

i Weir Computations: 1.""mBa..:..] i lQ:l 225.

i ,Standard Weir Equation Par'::.ame~terr::s==::;: j 2 10.[225: -J 1 541 RS Weir Sta :J
I[::::=:~ IW'"'S·;~iJJI~==i"-=ij~ 1-'1+!:::.:l:::.1----j .._ ~ ..

i1-2_.._}~~+-- ..-_~~~ 65.31

r::'18-roa~d":"C'~es~te~d---::::oJ"""lT i :~j§qt??$ ~ ;~~4
i 10 360. 225. 9 5.258

i :~-_=~~~_._.'= l--,'i~01,i:::.:.~::::~:::..~--I- --

i 14 135.194
____________""'i I~ 145.178

,"Weir Stationing Refe,ence'---"---'-'---: l-.!g 1-:-:15:1'5"".1=-=62=---I .-

i § i I~ 16 5.146
, , 175.13
i HW Distance to UpstreamXS: ~ 1--;.:1901----+-----1 , 185113
, ~ Tj'

The Lateral Weir/Embankment Data editor is similar to the Deck/Roadway editor
for bridges and culverts. The user enters a distance between the upstream end of the
structure and the upstream cross section, the lateral width of the structure (used for
drawing purposes only), weir flow reference (to use the water surface or energy
gradeline to calculate the lateral weir flow), the weir flow coefficient, weir shape,
and the station and elevation data describing the embankment and weir profile.
Additionally, the user can select between the Standard Weir equation and Hager's
Lateral Weir equation (Weir Computations drop down box).

•
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• Hager's Lateral Weir Equation

2.3 L-05

If Hager's Lateral weir equation is selected from the "Weir Computations" field, then the following
additional fields will appear:

WeirSla

OK Cancel

8250.'
9 200.'

3500."

1 GOO.'

6 350.'

4 450.'

RS

7 300.'

5 400.'

10150.'
11 100.'

10

16

14

12 50.0000"
130

18

15

17

. 2550.'

5
6
7
8·······

9
10 .................................................._....

11
12
13
14=---t--
15

Weir Cresl Shape: ISroad Crested

Weir Computalions: IHager's Eqn

Hagers Weir Equalion Parameters--
Default Weir Coefficient (Cd) ~

Weir Average Heigh!: 10

Average 8ed Slope (optional):

Weir Angle in Degrees (oplional):

16
Weir Stalioning Reference-------, 1--'-l:Of7 _-..-_._-..-.._-_-_-:--_-_-_-_-_~-1

1m 18 +- 1ro- 19
20

HW Distance 10 Upslrearn XS:

•
Default Weir Coefficient (Cd) - This weir coefficient will be used for the first iteration of trying the
Hager lateral weir equation. The equation is iterative, and requires hydraulic results in order to make
a weir coefficient calculation. The default weir coefficient is only used for the first guess at the
hydraulic computations.

Weir Average Height - This field is used for entering the average height of the weir above the
ground.

Average Bed Slope (Optional) - This field is used for entering the average slope of the stream bed in
the reach of river that contains the lateral weir. If the user does not enter this field, the HEC-RAS
program will compute the slope by estimating an average bed elevation for each cross section, then
computing the slope of the average bed elevation. Average bed elevation of an irregular cross
section is obtained by subtracting hydraulic depth from the water surface elevation.

•
Weir Angle in Degrees (Optional) - This field can be used to enter and angle for the weir. If the
weir is parallel to the stream, the angle is assumed to be zero. If the weir is angled inwards towards
the center of the river, an angle (beta) is required. This is used for channels that have a contraction,
and weir flow is allowed to go over the contracted section.
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Hager's Lateral Weir Equation 
Continued

Q= CLH3/2

2.3 L-05
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•

•
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• Lateral Gate Editor
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[SUbmerged Orifice Flow j
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,~,,~~-- ..- _~-~-,___._-
Head Reference: ISill!lnve.t) 3

··Weir Flow Over Gate Sill (gate out of waterl···::":":":::.::::.:::::c;I
We, Shape: IBroad C.esled 3
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3 '240. 
426iJ .
5 '280-.----
s 300.
7

Height r-
Width: ~
Invert 1205 .. .

" Openings: W--
Mliifflfi-mlt;JUW

Station

Gate lype [or methodologyJ: JSluice

.. Geometric ProD,..ties-..· ··, .. Gate FIDw .

SluiceGaleFlow--~-~--~,

Sluice Discharge Coefficient (0.5·0.7):

Weir Coefficient:

•
10 _....._--_._.._._.-
11
12

The Gated Spillway editor is similar to the Culvert editor in concept. The user
enters the physical description of the gates, as well as the required coefficients, in
the Gated Spillway editor. Controlling the gate openings is accomplished from the
Unsteady Flow Data editor. Please see chapters 6 and 8 of the user's manual for a
complete description of this data.

•
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Lateral Culvert Editor
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Culvert Data Editor ' Milici;"", :f(iiwC~
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Solution Criteria:

Add···l~ Delete .. ·1 CulvertlD iii. ~ll n U~
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•
HelpCancel

Cenler~ne SlatlOr.sExit Loss Coefl:

Chart II: 11 .Concrete Pipe Culvert

Scale II: F.Square edge entrance with headwall

Upstream Invert Elev: 1210
Culvert Length: 1'-50--- Downstream Invert Elev: :-121-0--
Entrance Loss Coeff: ~.!JJ II identical banels : 12

11
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OK

Manning's n for Top:

Manning's n for Boltom:

Depth to use Boltom n:

Depth Blocked:

This editor is almost identical to the normal inline culvert editor. All of the culvert
shapes are available.

•
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• Lateral Rating Curve
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Controlling Inline and Lateral
Gates

• For unsteady flow simulations the
following ·gate controls are available
from the HEC-RAS unsteady flow data
editor:
• Time Series of Gate Openings

• Elevation Controlled Gates

• Navigation Dam Control

• Rules Editor

Controlling gate openings is an event specific operation. For this reason, the
options for controlling the gate setting are contained in the Unsteady Flow Data
Editor.
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• Time -Series of Gate Openings

2.3 L-05
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• This option allows the user to enter a time series of gate openings for an inline gated
spillway, lateral gated spillway, or a spillway connecting two storage areas. The
user has the option of reading the data from a DSS file or entering the data into a
table from within the editor.

Warning: Opening and closing gates to quickly can cause instabilities in the
solution of the unsteady flow equations. If instabilities occur near gated
locations, the user should either reduce the computational time step and/or
reduce the rate at which gates are opened or closed.

•
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Elevation Controlled Gates
-"*7t~-'.

Elevation Controlled Gate5,~" *_lit""<"I_1%#l
River:Nillan River Reach:Vleir Reach RS:41 ,75 IS <

Gate Group: ILeft Group

Reference: IBased on upstream VIS

Upstream VIS Elevation Reference------;::===1
Upstream VIS elevation at which gate begins to open: 16
Upstream WS elevation at which gate begins to close: 14

2.3 L-05

•

Gate Opening Rate:[ft/min): 10.1

Gate Closing Rate:(ft/min): 10.1

Ma><imum Gate Opening: 110

Minimum Gate Opening: 12
Initial Gate Opening: 12

OK Cancel

•This option allows the user to control the opening and closing of gates based on the
elevation of the water surface upstream of the structure. A gate begins to open
when a user specified elevation is exceeded. The gate opens at a rate specified by
the user. As the water surface goes down, the gate will begin to close at a user
specified elevation. The closing of the gate is at a user specified rate (feet/min.).
The user must also enter a maximum and minimum gate opening, as well as the
initial gate opening.
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• Navigation Dams

2.3 L-05

The Navigation Dam option is used to have the program figure out appropriate gate
settings to maintain specified water surface elevation within the Dam pool or an
upstream hinge point location. This is a new feature for version 3.1.

OK Cancel
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Operation Rules for Gated
Structures
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• Unsteady Flow Editor
"Rules" boundary
condition

• Inline/Lateral
Structures

• Storage Area
Connections

Controls
• Gates
• Weir Coefficients
• Min/Max Flow

• Rules are evaluated at
every time step

•
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• User Defined Rules Editor for
Operating Gated Structures
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The operating procedures for determining and controlling the releases from
reservoirs and other types of hydraulic structures can be quite complex. HEC-RAS
allows flexibility in modeling and controlling the operations of gates at hydraulic
structures through the use of rules (Figure above). Examples of variables that could
be used to control releases from a hydraulic structure are: current flows and water
surfaces at the structure, current flows and stages at a downstream or upstream cross
section location, time considerations (winter, morning, etc), and/or previously
computed values (accumulated outflows, running averages, etc). Rule operations in
HEC-RAS are available for inline hydraulic structures, lateral hydraulic structures,
and storage area connections that contain gates.
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Inline and Lateral Structure
Output

-=-

• The following types of output are available
for inline and lateral spillways/weirs:
• Stage and Flow Hydrograph Plots
• Time Series Tables
• Profile Plots
• Cross Section Plots (lnline Structures only)
• Detailed Output Tables
• Profile Summary Tables
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• Example Stage and Flow
Hydrographs for an Inline Structure
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Stage and Flow Hydrograph for
Lateral Structure
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Legend

~
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St~eTW

Flow HVVUS

Flow t-NlfDS

j:k;..·L~vhj

•

•
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• Time Series Table for an Inline
Structure

2.3 L-05

Riv",: IN~tanyRiv.. :::J ~I
Reach: IWeifReach 3 River St•.: 14175 IS :::J.!J.!J
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•
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Example Profile Plot With a
Lateral Structure

2.3 L-05

•
flo QpOOns t1«>
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• Example Cross Section Plot of
Inline Structure

2.3 L-05

!:jle Qptlons tlelp

River: INiUarljl River
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Example Detailed Output
Table For a Lateral Structure

2.3 L-05

•
Eile lype Qptions tielp

River. J8e~ver Cr~ek

Reach IKentwood
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II-=Q":CU"'s:-'::el""',"------\ "'i39iiifs9 WeH submer [1'9ii"

II";;Q7Le"-a""vin"'-;cTot7 ",77ci-'-,"--}--j .1..2.a.. I~Mc;,in""E"'IW~ei,~FI~ow-;(""ft}---+ 2,200
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• Example Profile Output Table for
Lateral and Inline Structures

2.3 L-05

Reach River Sta Profile

Kentwood 5.4
Kentwood 5.4
KenlwoodS.4
Kentwood 5.4
Kentwood 5,4
Kentwood 5.4
Kentwood 5.4
Kentwood 5.4

09FEBl999 2400 504~5(f

llFEBI999lm1 S055.50
llFEBI999I200-a.2ilSO·
llFEBI9991BOO 11215.i9 .
llFEBl999 2400 13334.00'··
llFEBI999tmJ 1397~Bt

11FEBI9991200 12914.15;

E'e Qptions 2ld. Tables U.ser Tables local:k>ns tjelp

•

•
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•
Overview of Storage Areas and

Storage Area Connections
-

Cameron Ackerman, P.E.

•

•
Storage Areas and Connections/MRJ/CTA

2.4 L-06
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Introduction

• Storage Areas

• Purpose

• Data Entry

• Output

• SA Connections

• Purpose

• Data Entry

• Output

.... 191953.2
·..........'lM(lS.S

2.4 L-06

•

The output from an unsteady flow run are stage hydrographs, flow hydrographs,
and basic stage profiles. These hydrographs and profiles are stored in DSS.

For more detailed output you must run the post processor. The post processor reads
the hydrograph and profile information in the DSS file and creates detailed output
data for the maximum stage computed and series of snap shots in time on a selected
"Detailed Output Interval".

Storage Areas and Connections/MRJICTA

•

•
2



• Storage Areas - Purpose
-

• Good for areas that are either inline or off line storage
areas

• Stabilizing influence on computations
• Continuity equation is used to account for volume of

storage areas
• Momentum is not computed
• Can be connected to:

• Lateral structures
• Top or bottom of a reach
• Another storage area (with a SA Connection)

2.4 L-06

•

•

3

Storage areas are more stable in computations (and faster) than representing a
region with cross sections.

Storage Areas and Connections/MRJ/CTA 3



Storage Area - Creating

• Created on the ~:;~.=-~;~~i-·~"iPJ~~~~g..~~-~....~...~,~..~~~~~:
geometry schematic ~ -2!l /'\

using the Storage :: L__\ '-,.f"

Area editor
t.J

4

Storage Areas are created on the geometry schematic with the "Storage Area" tool.
Press the button and the mouse cursor changes to a pen, draw the storage area and
double click to end drawing.

Storage Areas and Connections/MRJ/CTA

2.4 L-06

•

•

•
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• Storage Area - Connecting

2.4 L-06

• When you connect
the river to the SA a
"node" is formed

• Upstream
• Inline Structure with

2 cross sections u/s
of structure

• Downstream

.~

Do you want to COl'W'le:t the upslreaTl 8'.lC! of INs reach to !toraoe area: l'pper Kap.ah: Res

g",.

•

•

5

In order to connect a storage area to the upstream or downstream end of a river
reach, select the Edit IMove Object menu item. Then grab the end of the river
reach and move it into the storage area. RAS will ask you if you want to connect
the river reach and storage area. If you accept Yes, then a node will be formed at
the boundary of the storage area and the river line.

When using a storage area for an upstream boundary, there must be 2 cross sections
placed upstream of the an inline structure.

Storage Areas and Connections/MRJ/CTA 5



Storage Area - Connecting

• Lateral Structure

6

To connect a storage are to a river, you do so using a lateral structure. A new lateral
structure is added similar to adding a bridge, by selecting a river and reach and
specifying a river station. The lateral structure has several options, but for a storage
area you are connecting from the river (Headwater) on the right or left side to the
storage area (Tailwater)!

Storage Areas and Connections/MRJICTA

2.4 L-06

•

•

•
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•

•

•

Storage Area - Geometry Data

• Open editor
• Floating menu

from left mouse
click

• Button

The data editor for storage areas can be accessed by clicking on the "Storage Area"
button on the schematic editor or clicking on the storage area with left mouse
button, this will display an popup menu with the option to edit .

2.4 L-06
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Storage Area - Geometry Data
_ "_ wM ~

Stordg~Ared fditor ,

2.4 L-06

•

The only data needed for storage areas is a method of computing storage verses
elevation. Two methods are available, a surface area times a depth or interpolation
from a rating curve.

5'",ogeAl..: IlIm$:tt$ ..:.l.!J.!J
[=:I»~7feienc~ 10 tm~Olagef.J~.--_ ..]

r Area tines depth method Ar~lbCte$~ r
MnE~v: r

r. EIev.woo versus Volme a..veE""__~
rn$! ~ev.ooon tnl'Jtlti:aw':tete VQfJIM'

E~volian VoLme lac,e-itl ~

~:l .... .J
3 330. 13.
4335. : 32.
5 340. . 64.
6 346 ············;ris
73.7: ·····················112:
B 3.8:···········T,2iJ ..
9350: ··········1n.5··

10351····················'.3····
11·353.·········'59.5-··
12 354. •lin
13356. ',90.
14 js7.·2iii.
15 359' ... ·············2225

L.--........:.:a'6 .·J.iiiL '.;2~::::~

~~

Storage Areas and Connections/MRJ/CTA

• Volume Methods
• Area times depth

• Elevation - Volume
Curve

• Plot

•

•
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• Storage Area - Unsteady Flow Data

2.4 L-06

• Initial Conditions
(Required)

""_ ...
......."""'-rmt=;l

~=~~~ r-l-----!<!l
,ll~w.a.I"~

•

•

9

The initial elevation of the storage area is required for simulation, this is specified
on the unsteady flow data window on the "Initial Conditions" tab.

Storage Areas and Connections/MRJ/CTA 9



Storage Area - Unsteady Flow Data

2.4 L-06

•

A time series of lateral inflows can also be entered for a storage area, this would be
entered on the same window, but on the "Boundary Conditions" tab.

• Boundary Conditions
(Optional)
• Lateral Inflow

Hydrograph

Storage Areas and Connections/MRJICTA

"'~'ti<\>

~C:¢twQo"li:llMi.j~,1

•

•
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•

•

•

Storage Area - Output

• Stage Flow Plot
• Stage

• Net Flow

2.4 L-06
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Storage Area - Output

• Profile Output Table

12

Storage Areas and Connections/MRJICTA

2.4 L-06

•

•

•
12



•

•

•

SA Connection - Purpose

• Convey water from storage area to storage
area

• Four types:
• Inline Weir

• Inline Weir with Gates

• Inline Weir with Culverts

• Linear Routing Method

13

2.4 L-06
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SA Connection Computations
-

• Inline Weir Type
• Can use the weir equation in computations

• Can use a family of curves

• Inline Weir Type with gates
• Uses the weir and gate equations in

computations. Cannot use curves because
the gates change the properties over time

14

The data for storage area connections is a combination of things that are available
elsewhere in the program. For example the culvert data for a storage area
connection is similar to the normal culvert data at a bridge/culvert crossing.

Storage Areas and Connections/MRJ/CTA

2.4 L-06

•

•

•
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• SA Connection Computations

2.4 L-06

:.:oJ .!J.!J V.n.bles ... I
Po",,", I

Internal Boundary
G.1t~::1 Conn CV

• Culvert Type
• Makes a

family of
rating curves
similar to
bridges and
culverts

•
-'-L .._.... __ ...._... ...

The family of rating curves can be viewed from the "View Hydraulic Properties"
window. Select "SA Connections" under the "Type" menu option.

•
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SA Connection Computations

• Linear Routing Type
Q = k(Available Storage)

Available Storage = Surface Area(&)

k has units of hours-1 and is in range of 0.0 -1.0

with a typical value of 0.2

2.4 L-06

•

SA#1 SA#2
16

Another method of computing flow between storage areas is with linear routing.
Linear routing computes the flow between storage areas by a simple fraction of the
available storage difference between each storage area for each time step. The
fraction, k has units of l/hours.

Storage Areas and Connections/MRJ/CTA

•

•
16



• SA Connection Creating

2.4 L-06

• Created on
the geometry
schematic

• Ends snap to
the nearest
Storage Area

•

•

17

Press the SA Conn tool button on the top row of the schematic editor, and the mouse
pointer will change to a pen. Draw the connection and double click to finish the
polyline. SA connections snap to the nearest possible end point so start and end the
connection near the desired storage area.

Storage Areas and Connections/MRJ/CTA 17



SA Connection - Geometry Data

2.4 L-06

•
• Open editor

• Floating
menu from
left mouse
click

• Button

Storage Areas and Connections/MRJICTA

•

•
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•

•

•

SA Connection - Geometry Data

• Connection Selection
drop down list

• Description
• Editor Shows

connections "From"
and "To"

• Pick Type

19

When the SA Connection editor is opened the plot will initially be blank:. The
description can be entered and the "From" and "To" ends of the connection.

The buttons on the left, load sub-editors for the components of the connection.

2.4 L-06
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SA Connection - Geometry Data

• Inline Weir
• Weir/Embankment

• Inline Weir with Gates
• Weir/Embankment

• Gates

• Culvert Type
• Weir/Embankment

• Culvert
• HTab Parameters

• Linear Routing - (Coefficients Only)
20

Storage Areas and Connections/MRJ/CTA

2.4 L-06

•

•
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• SA Connection - Geometry Data

2.4 L-06

• Inline Weir
• "On the fly"

computations
• Family of Curves

SA Corn IGated Com
0=",... I;------=:.=.:=~=

From: !Storage area: Black HOlte

r0: 10l'agtl: area: Blue Bid P

Slluctl,le Type: IWeil , fe-
W"I

¥
HTob
P""",.

10 20 30 40 S{)

Sttllicn{tt)

.!.J::::", __

•
21

•
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SA Connection - Geometry Data

2.4 L-06

•
• Weir/Embankment

• Weir Width (Optional)

• Flow Reference

• Weir Coefficient
range 0-4, default = 3
(maybe 2.6 would be
better)

• Weir Crest Shape

• Weir Profile

Weir Coefficients range from 0 to 4.

'WerCoefficiertlCdl ~
We.. e,et! SMoe
@" Broad C,esled
OOgee

10

1'".".".."......•."."""""".".".".."""..."_._."..."",,.)1 11 ...:l
~~

:Entc! ¥o/idlh';;(~'weifnThe~direct1or;of floW"{used 101 otplavL

22

•Application

For a levee

Broad Crested Weir

Natural ground

Storage Areas and Connections/MRJ/CTA

Weir Coefficient

2.6

2.6

<2

•
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• SA Connection - Geometry Data

2.4 L-06

• Gate Editor
• Same editor for Inline

and Lateral Structures

~ _, .,,-_=w '"''' __ ..

Connection Gate Editor ""~" , ~, M

~ Copy I Delete I Gele Gm•." IGele ~1 -=J
R."...,,, 1.!J.!J

H.;ght ~ Wodll< po--- I""..t ~
"G<!IleOd:,,'" ·····························_...c *,OperWIgs:~

Oisdwge Coefracient ro.s- MMffij.,ti!MW
Gele Two; ISUee :::J S'elion·

. TrurrionElCPonert: ~
i Opening E><ponent r;--
i HeedE,pon.,;; ~
! Tl\'(!'J'~oflH..",,;ht ro-
! OlflCe Coefficient ro.e-
l...~~,~..~~~!.~~: ......fSill [Inveft) 3 .. 1-',1··········..···············
rWei Od:a······
i Weir Coefficient,
: Weir Vest SMQe
l (i, Bload Deste<!
: 00,..

~~~
EdCtheiM~~of theg<!te"openng ----

•

•

23

The data for a gate editor is the same as for an inline weir. Refer to the inline weir
section of the HEC-RAS Users Manual starting on page 6 -57.
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SA Connection - Geometry Data

2.4 L-06

•
• Culvert Editor

• Same editor for
Bridge/Culverts and
Lateral Structures

~ Copy I Odele:.J Uhelt 10 ltd'" iJ
ScUionCli"", IH.....,US.EG :::J ReMm•... I ..!.J.!.I
Shope, ICiocula :=:Jg;j $p,n r-:-. D;.m rs--

CI,.., U, 11 .C""".,. Pipe C""'" :::J
Scale h: 11 -S~e edge enhance w~h headwal ~

Upsbe.vnlnvelt Elev: ~

Cliver! len~h: rso-- DO\'IIl"lstteMn Invert EIev:~
EnlJancelouCoefl: ro.s-.!:?J hidentic:a1barlels: P-
ExilLouCoeff: ~ titti1M.~__'W
Marring'snlorTop: ~1?J U str~m OCl'M1$UeMf'l'"

~:~'::';:,:,": 1~·016 ~ '~.'.'.'.'.'.'.'.":~:".'.'.'.'.'
D.pth Bk>ck.d: ro-- 4 ....

~~~- -

24

The data for a gate editor is the same as for an inline weir. Refer to the inline weir
section of the HEC-RAS Users Manual starting on page 6 -42.

Storage Areas and Connections/MRJICTA
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• SA Connection - Geometry Data

2.4 L-06

• HTab Parameters
• Headwater maximum

(required)

• Tailwater maximum
(optional)

• Maximum Swell
Head (optional)

• Maximum Flow
(Optional)

Number of points on free flow curve:

Number of submerged curves:

Number of points on each submerged curves:

Apply number of points to all Conneclions

Head water maximum elevation: 192

Tail water maximum elevation (Optional): 1"""""'--
Maximum Swell Head (Optional): 1

. Maximum Flow (Recommended): '-1--

OK Cancel

•

•

25

The HTab data is only needed for the culvert type connections. The data required
here is the same as covered for bridges and culverts, covered earlier in this course.

The maximum swell head parameter is the largest difference between head water
and tailwater.

All four parameters maximum headwater, tailwater, swell head and maximum flow
are used to limit the range of the family of rating curves. It is important to keep the
curves in the possible flow and stage ranges to minimize the errors in interpolation

The only parameter required for connections is the headwater maximum, the
program computes default values for the others.

Storage Areas and Connections/MRJ/CTA 25



SA Connection - Geometry Data

2.4 L-06

•

<'-~~"""""""- _.~ • ~

SA Cont)(!(:tlon Unear Routing Edllor .'

0" \lew tlw

SA Com: Pi'iMU';;C ~~~"" B .!.J.!J A..... Del. I
D."",,",," I 0
From: JSI<.:,,,,:::,,,,~••=,••::0,S;::leck'"H=",,=-.---~

To: IStol'l!lgearea:BkJeBidPond ~

Sbuch.re Type: JUneal Routing 3
Uneer

Routing Q* k(A~·~llbl'tS~.>'ho~· ~
A.n.iLlbJ.!t;):::q,,·6Z(3~A1-u) ~

~ Q ··_···ru······ ~
~ ~ ~
~ ~ ~
~ S'o~ Arw! ~ ~ Sta-q. Arro 2 ~
~ ~ ~ ~I ~ ~ ~

lineal AoWlg CoeI fa fbw frorn Storage area: Black Horse to Ip]i5_vv~
.. Star., ar~ Blue Bid Pond

'SeieCl"c.o;y;;;ctiOn·io~t Unem Aouti'lo Coef fOf flow from SIOf. «ea: SkJe Bid Pond ro.os
to Storage area: Black Hone

• Linear routing

• Coefficient used to
compute change in
Q per hour.
Modified by the tim
step

Elevation d spilw4y aest

The linear routing coefficient is direction dependent, so one for each flow direction
must be entered. The "elevation of crest" is a reference that determines when water
will start flowing from one storage area to the next. •

•
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• SA Connection - Unsteady Flow Data

2.4 L-06

:fiN.1!!&£iZ!iii!··

:::J
..:J RivefSIa.: !253339.0 iJ AO:hBClI..nd.!lIyCOI"IClIaonlocetionJ

River. ISlaridaus

A."" JA1

fie Ql>_ t!'!:>

B~CondIK>N !Inliolc-.I·• Gated
Connections
• Time series of

Gate Openings

• Elevation
Controlled
Gates

• If a SA Connection has gates, then boundary condition data will need to be entered
on the unsteady flow data editor. The lower portion of the boundary condition
editor is where the connection is added to the table. Two types are possible, a time
series of gate openings and elevation controlled gates.

The data for these boundary conditions are the same as for the gates on inline and
lateral weirs .

•
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SA Connection - Tabular Output

2.4 L-06

•
• Culvert Type

,..

, ,"
# Batfels
aBalle! cis

11-2E.""G,,,,,uS,...,I:;;'__--j l1,61l1-;?;:7"~~_-I

1I-i'~""GS~~S"'S,f.',,"'----+"'" :~~I-;?;~~~--I
\I/.S.os I

DebEG ft
DeRaWS ft

117E."'G'.;;;'c"''';,-_--I ".64
1I~~~7"G~""~~"".,:,,c-'~-;----j·:::::::·::·::·:::::::·::·::·::::::·~L:·

1I-=~~"":":~::-;D~""7'-"~~r~,.----+····· ... ··········1~~'I:~~~~~
16.51

•

•
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• SA Connection - Tabular Output

2.4 L-06

• Inline Weir with
Gates

•

•
Storage Areas and Connections/MRJ/CTA
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SA, Connection - Stage Flow Plots

2.4 L-06

•
~I HWP,,"S'...

Com: 1",,_,oE* 3.!J.!J TWP~";,'"
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• SA Connection - Stage Flow Plots
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Schematic Editing

2.4 L-06

•
• Select "Move

Object" under
"Edit"

• Move individual
points

• Move whole SA
with centroid

• Move Text
• SA Conn snap to

nearest point ""'"_...

Once the outline is created, it can be edited by selecting the "Move Object" menu
item under "Edit", The schematic will change its appearance and allow features to
be moved.

Storage Areas and Connections/MRJ/CTA
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Storage Areas & SA Connections

• Questions?
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2.5 W-04

Lateral Structures, Storage Areas, and SA Connections
Workshop

Introduction

This workshop will help students learn how to use HEC-RAS to create storage
areas, lateral structures with gates, and storage area connections. Students will learn how
to connect storage areas to river reaches and other storage areas using Storage Area
Connections. While this data is from a USGS study, the model and results ofthis
workshop do not represent current or future conditions ofthe river.

Background

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. The bridge crossing is located along State Highway 1049, near the middle of the
river reach. The bridge, cross section geometly, and high water flow data were used to
evaluate the flood that occurred on May 22, 1974 with a peak of 14000 cfs. Figure 1 displays
a geo-referenced map of the area with the surveyed cross sections.

Figure 1 Beaver Creek Located Near Kentwood, Louisiana

P-04( 188-03)/Apr 2006/MRJ I
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Problem Description

A project file (BeaverSA.prj) with the title "Beaver Cr. SA - and SA
Connection" has been loaded on your workshop computers. The file contains all the
data for this workshop. The goal of this workshop is to evaluate a proposed plan to stop
the overtopping of the bridge located at River Station 5.4 during a design event that peaks
at 14000 cfs. It is proposed that two areas located to the west of Beaver Creek, labeled
Site 1 and Site 2, be used for off-stream storage during peak flood events to prevent the
bridge from overtopping. Site 1 is 80 acres and Site 2 is 85 acres. Each storage area will
be connected via a lateral structure to Beaver Creek. The storage areas will be connected
to each other with a storage area connection. The downstream lateral structure will be
equipped with gates to control the release of stored water. The unsteady flow file already
contains the design hydrograph.

Tasks

The following is a summary of the required tasks for each group:

1. Develop Storage Areas, Lateral Structures, and SA Connections

Utilizing the storage area, lateral structure, and storage area connection
options within HEC-RAS evaluate the proposed plan to develop the available area
to the west of Beaver Creek for off-stream storage. Remember that the goal of the
design is to prevent the highway bridge from being overtopped. Some design
information is unknown and should be evaluated by the modeler.

a. Construct storage areas for Site 1 and 2. Site 1 has an average minimum
elevation of 209 feet and Site 2 has an average minimum elevation of 207
feet.

b. In the Unsteady Flow Data Editor set the initial water surface elevations
of the storage areas.

c. Connect the storage areas to each other with a storage area connection.
The connection should consist of a weir and culvert. The proposed weir
length and elevation are 100 feet and 217 feet, respectively. The weir
width is 20 feet. The culvert is a concrete pipe with a square edge
entrance from the headwall, 7 feet in diameter and 30 feet long. The
culvert is located along the centerline of the weir with an upstream invert
elevation of 209 feet.

In the SA Connection Data Editor select the HTAB Parameter button,
set the maximum headwater elevation to 220 feet.

•

•

•
P-04(188-03)/Apr 2006/MRJ 2
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d. Connect the two storage areas to the reach with lateral structures. (Note:
Do not try to use a storage area connection to connect the lateral structures
from the reach to the storage areas.)

The proposed upstream weir is located at River Station 5.9 and is 400 feet
in length. The proposed downstream weir is located at River Station 5.570
and is 200 feet in length. The correct elevation of the weirs in unknown
and must be evaluated by the modeler. The height of each weir will most
likely fall within the range of 213 to 218 feet.

e. Save the geometry file as a new file. Make a new plan with the new
geometry file and proceed with the simulation.

f. Evaluate the bridge for weir flow by viewing the output tables, or by
examining the Profile Plot to see if the energy grade line rises above the
bridge deck. Make adjustments to the weir elevations and storage areas
until the bridge is not overtopped.

2. Place Gates on the Downstream Lateral Structure

After the flood wave has passed, re-route the stored water back into Beaver
Creek. To accomplish this task, place gates along the downstream weir. (The
upstream storage area should empty into the downstream storage area through
the storage area connection).

a. Construct sluice gates along the lateral structure. The sluice gates have a
discharge coefficient of 0.6. Save the geomeh'y file as a different file for
Task 2.

b. In the Unsteady Flow Data Editor develop a time series of operation for
the gates that will release the water in the downstream storage area after
the flood wave. Save the unsteady flow file as a different file for Task 2.

c. Save a new plan for Task 2 with the new geometry and unsteady flow files
and then proceed with the simulation.

P-04( 188-03)/Apr 2006/MRJ 3
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Questions

1. Did your design meet the requirement to prevent weir flow over the highway
bridge?

2. When did the maximum flowrate occur in the storage areas? What was the
maximum stage of both storage areas? What was the maximum flowrate
between the two storage areas? What was the maximum flowrate over the
lateral structure located at River Station 5.9?

3. How did the stage and flow hydrographs change from Task 1 to Task 2? Did
any numerical oscillations occur in the stage and flow hydrographs? If so,
how can these oscillations be smoothed?

4. What are some other alternatives, besides off-stream storage areas, to keep the
bridge from being overtopped?

•

•

•
P-04( 188-03)/Apr 2006/MRJ 4



•

•

•



•

•

•

Common Model Stability
Problems When Performing
an Unsteady Flow Analysis

Gary W. Brunner, P.E.

~1E!:31 Hydrologic Engineering Center

3.1 L-07
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Objectives

• For students to have a better understanding of
model stability problems.

• To become familiar with the available parameters
and techniques within HEC-RAS that will allow
you to develop a stable and accurate model.

• To learn how to detect, find, and fix model
stability problems.

~ Hydrologic Engineering Center

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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Overview
• Model Stability
• Factors Affecting Model Stability

• Cross section spacing

• Computational time step selection

• Theta weighting factor

• Calculation tolerances and iterations

• Lateral Structures/weirs

• Manning's n values

• Initial/Low flow conditions

• Steep Streams/Mixed Flow regime

• Drops in the bed profIle

• Bridge/Culverts

• Cross section geometry and table properties

• Breach characteristics

• Detecting and flXing Stability Problems
~ Hydrologic Engineering Center

3.1 L-07
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Model Stability

• An unstable numerical model is one for which
certain types of numerical errors grow to the extent
at which the solution begins to oscillate, or the errors

become so large that the computations can not
continue.

Plan: Unstelld hIt Rlv8f: Beaver Creek Reach: Kentwood RS: 5.97

I ... I

•

Developing a stable model is a common problem when working with an unsteady flow model of
any size or complexity. Modeling a dam break flood wave is one of the most difficult unsteady
flow problems to model.

""lOF..199l11

m1 Hydrologic Engineering Center

""12F..,1,"
11100 2«:10

I

4 •

•
L - Common Model Stability Problems for Dam Break Analysis/Brunner 4



•
3.1 L-07

Cross Section Spacing
160000
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Hydrologic Engineering Center

850000
111 1 1

MalnChannelOislanee(tI)

Not enough cross sections: When cross sections are spaced far apart, and the changes in
hydraulic properties are great, the solution can become unstable. In general, cross sections
spaced too far apart will cause additional numerical diffusion, due to the derivatives with
respect to distance being averaged over to long of a distance. Also, if the distance between
cross sections is so great, such that the Courant number would be much greater than 1.0, then
the model may also become unstable.

•
Cross Sections too Close. If the cross sections are too close together, then the derivatives with
respect to distance may be overestimated, especially on the rising side of the flood wave. This
can cause the leading edge of the flood wave to over steepen, to the point at which the model
may become unstable.

•
L - Common Model Stability Problems for Dam Break Analysis/Brunner 5
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XS Spacing
Maximum and Minimum

Use Dr. Fread's and Samuals equations as a guide for maximum spacing.

Dr. Fread's Equation: Samuals Equation:

•
A v CT,.Ll,;\..<--'

20
Where: f1x

c

o

A. 0.15D
uX'<---

So
= Cross section spacing (feet)

= Time of rise of the main flood wave (seconds)

= Wave speed of the flood wave (tUs)

= Average bank full depth of the channel (ft)

= Average bed slope (tUft).

One of the first steps in stabilizing a dam breach model is to apply the correct cross section
spacing. Fread's equation and Samuel's equations are good starting points. Samuels equation
is a little easier to use since you only have to estimate the depth and slope. Frequently, bank
full depth is used. For Fread's equation, although the time of rise of the hydrograph (Tr) is easy
enough to determine, the wave speed (c) is a little more difficult to come by. Once a cross
section spacing is decided upon, apply it to the entire reach using the HEC-RAS cross section
interpolation routines. Make sure that the reach-wide method is applicable. At areas of extreme
contraction and expansion, at grade breaks, or in abnormally steep reaches, further localized
interpolation may be necessary.

Minimum spacing for a dam break model should be in the range of 50 to 100 ft.

Hydrologic Engineering Center 6 •

Fread, D.L. (1988) (Revision 1991). "The NWS DAMBRK Model. Theoretical Background
and User's Documentation." National Weather Service, Office of Hydrology, Silver Spring,
Md.

Fread, D.L., Lewis, lM. (1993). "Selection of Dx and Dt Computational Steps for Four-Point
Implicit Nonlinear Dynamic Routing Models" ASCE National Hydraulic Engineering
Conference Proceedings, San Francisco, CA.

Samuels, P.G. (1989). "Backwater lengths in rivers", Proceedings -- Institution of Civil
Engineers, Part 2, Research and Theory, 87, 571-582.
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Cross Section Interpolation

Maxirrun Dist~ between XS't:

~ ~~ ~ ~_ ~ v

XS IIIle'l"'latiDII by Reach , "~, """ _~_

Riv.r: IS.IdE.lieCr. 3
Reach: Ir.-Loc-,-k:-:-H.v-en-----"3=;·

Up."e.mRivSt.: 1137520 3

Down.lr••mRiv SIa: >.;1·,86:::::7---3'·
I=80:1::;---

• Apply the XS interpolation to
. ..

ensure a maximum spacing is
not exceeded.

,Cut Line GIS COOldin.h'.······----·---··--·····-··-·---·-·---·---.

A bl d i r; linearlyi"lte,polaleClt'nesf!omboundingXS's ~!• t pro em areas you may nee i (on~.vailabl.whenboun<in9XS'••r.G.or.l.r.nc.dl :

j r Generate fO! display as pelpendicular segments to leach invert

to use tighter spacing: . (Winb.r.po.'ion.d.SCfO....ctiondot.isch.n,..,..god=-J_--.

Decimal places i:l ilterpolalod SlaiElev: 10.00:3

• Steep reaches De1et.lnterpolatodXS'. I Int.rpolat.XS'. I
~

• Transition zones

In general, it is always better to use real cross sections rather than interpolated. However, if
acquiring more cross section data is not possible, then the cross section interpolation routines in
HEC-RAS should be used to ensure that the cross section do not go over a maximum distance
estimated from Samual's, or Fread's equation.

•
• Grade breaks

Hydrologic Engineering Center 7
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Computational Time Step •

Too large of a time step: When the solution scheme solves the unsteady flow equations,
derivatives are calculated with respect to distance and time. If the changes in hydraulic
properties at a give cross section are changing rapidly with respect to time, the program may go
unstable. The solution to this problem in general is to decrease the time step.

River: Tesl Reach: 1 RS: 0

•8

!:1X = 2000 ft

Vw = 20 ft/s

\
\

'..

" ;-~~:'''' ...

" .'";;~ ... "'-""

\ \
\'
\~;

0400 0500 0600 0700 0800
01Jan2007

Time

'\

/ /".~., \

f "',,,,\\

0300

i
! .

i

Ji

60000

40000

80000

20000

120000

100000

• To large a time step
will cause numerical
diffusion (attenuation
of the peak) and also
model instability.

• To small of a time step
can also lead to model
instability as well as
very long computation
times.

• For this example a 5
sec time step caused
the model to go
unstable.

••• ,. Hydrologic Engineering Center

Too Small of a Time Step. If a time step is selected that is much smaller than what the
Courant condition would dictate for a given flood wave, this can also cause model stability
problems. In general to small of a time step will cause the leading edge of the flood wave to
steepen, possible to the point of oscillating and going unstable.

•
L - Common Model Stability Problems for Dam Break Analysis/Brunner 8
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Computational Time Step 
continued

Stability and accuracy can be achieved by selecting a time step
that satisfies the Courant Condition:

C, =Vw : <1.0

For most rivers, the flood wave velocity is calculated more
accurately by:

vw = The flood wave speed, which is normally greater than the average velocity.

V = Average velocity of the flow

6x = Distance between cross sections

6t = computational time step

Q= flow rate

A = Flow area

• Where:

An approximate flood wave velocity can be calculated as:

V = ~v
11' 2

Hydrologic Engineering Center 9

•

User's should pay close attention to the Courant condition for selecting the
computational interval.

L - Common Model Stability Problems for Dam Break Analysis/Brunner 9



Practical Time Step Selection

• For medium to large rivers the Courant condition
may yield time steps that are to restrictive (i.e. a
larger time step could be used and still maintain
accuracy and stability). Tr

• A practical time step is = ~ t <
20

• Remember that for Dambreak models, typical time
steps are in the range of 1- 60 seconds due to the
very fast flood wave velocities..

r.m
~ Hydrologic Engineering Center

Where: Tr = Time of rise of the flood wave.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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Theta Weighting Factor

• Theta is a weighting applied to the River. Test Reach: 1 RS: 0

finite difference approximations
ooסס12 legend

when solving the unsteady flow
theta 0.6

100000
theta 1.0

equations.

• Theoretically Theta can vary from 0.5
80000

to 1.0. However a practical limit is
from 0.6 to 1.0 _60000 Ii

• Theta of 1.0 provides the most ~ r

~
J.

stability. Theta of 0.6 provides the Ii40000 ""
most accuracy. j'

• The default in HEC-RAS is 1.0. 2000 f I
!

Once you have your model I

developed, try to reduce theta ""I

towards 0.6, as long as the model
stays stable. -20000

0300 0400 0500 0600
01 Jan2007

Time

.
Hydrologic Engineering Center 11..

Larger values of theta increase numerical diffusion, but, by how much? Experience has shown
that for short period waves that rapidly rise, theta of 1.0 can produce significant errors.
However, these errors can be reduced by using smaller time steps.

When choosing theta, one must balance accuracy and computational robustness. Larger values
of theta produce a solution that is more robust, less prone to blowing up. Smaller values of
theta, while more accurate, tend to cause oscillations in the solution, which are amplified if
there are large numbers of internal boundary conditions.

L - Common Model Stability Problems for Dam Break Analysis/Brunner 11
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Calculation Options and Tolerances •

Water Surface, Storage Area, and Flow Tolerances: Three solution tolerances can be set or changed
by the user: Water surface calculation (0.02 default); Storage area elevation (0.05 default); and Flow
calculation (Default is that it is not used). The default values should be good for most river systems. Only
change them if you are sure!!!

Making the tolerances larger can reduce the stability of the solution. Making them smaller can cause the
program to go to the maximum number of iterations every time.

Maximum Number of Iterations: At each time step derivatives are estimated and the equations are
solved. All of the computation nodes are then checked for numerical error. If the error is greater than the
allowable tolerances, the program will iterate. The default number of iterations in HEC-RAS is set to 20.
Iteration will generally improve the solution. This is especially true when your model has lateral weirs and
storage areas.

Warm up time step and duration: The user can instruct the program to run a number of iterations at the
beginning of the simulation in which all inflows are held constant. This is called the warm up period. The
default is not to perform a warm up period, but the user can specify a number of time steps to use for the
warm up period. The user can also specify a specific time step to use (default is to use the user selected
computation interval). The warm up period does not advance the simulation in time, it is generally used
to allow the unsteady flow equations to establish a stable flow and stage before proceeding with the
computations.

Time Slicing: The user can control the maximum number of time slices and the minimum time step used
during time slicing. There are two ways to invoke time slicing: rate of change of an inflow hydrograph or
when a maximum number of iterations is reached.

• Theta

• Water surface/SAl flow tolerance

• Maximum Number of Iterations

• Warm up: duration and time step

• Time slicing

• Lateral/Inline Structure Stability

• Weir/Gate flow submergence

, ,
"... Hydrologic Engineering Center

- -- ~ ~ -" ,- -- -~- ---- --
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Inline/Lateral Structure
Stability Issues

Inline and Lateral Structures can often be a source of instability in the solution. Especially lateral
structures, which take flow away or bring it into the main river. During each time step, the flow over a
weir/spillway is assumed to be constant. This can cause oscillations by sending too much flow during a
time step. One solution is to reduce the time step. Another solution is to use Inline and Lateral Structure
stability factors, which can smooth these oscillations by damping the computed flows. However, using
these stability factors can reduce the accuracy of the computed values. The Inline and Lateral Structure
stability factors can range from 1.0 to 3.0. The default value of 1.0 is essentially no damping of the
computed flows. As you increase the factor you get greater dampening of the flows (which will provide
for greater stability), but less accuracy.

Long and flat Lateral Weirs/Spillways: during the computations there will be a point at which for one
time step no flow is going over the lateral weir, and then the very next time step there is. If the water
surface is rising rapidly, and the weir is wide and flat, the first time the water surface goes above the weir
could result in a very large flow being computed (i.e. it does not take a large depth above the weir to
produce are large flow if it is very wide and flat). This can result in a great decrease in stage from the
main river, which in tum causes the solution to oscillate and possible go unstable. This is also a common
problem when having large flat weirs between storage areas. The solution to this problem is to use
smaller computational time steps, and/or weir/spillway stability factors.

Opening gated spillways to quickly: When you have a gated structure in the system, and you open it
quickly, if the flow coming out of that structure is a significant percentage of the flow in the receiving
body of water, then the resulting stage, area and velocity will increase very quickly. This abrupt change
in the hydraulic properties can lead to instabilities in the solution. To solve this problem you should use
smaller computational time steps, or open the gate a littler slower, or both ifnecessary.

13

5.1

- ----- - 5.2

t--1J------

( j

Hydrologic Engineering Center

• Long and flat lateral weirs can often
be a source of model instability.
• Small change in stage in the river results

in big change in flow going out the lateral
structure

• Flow is assumed to be constant over the
time step

• Solutions:
• Reduce the computation interval

• Put a small slope on the lateral weir

• Use lateral structure stability factors

• Opening and Closing Gates Quickly
• Reduce the computational time step

• Open and close gates slower

•

•

L - Common Model Stability Problems for Dam Break Analysis/Brunner 13
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Weir/Gate Submergence
Exponents

Weir/Gate Submergence Factors

•

To reduce the oscillations, the user can increase the Weir/Gate Submergence decay exponent.
This factor can vary from 1.0 to 3.0. A factor of 1.0 leaves the submergence criteria in its
original form. Using a factor greater than one causes the program to use larger submergence
factors earlier, and makes the submergence curve less steep at high degrees of submergence. A
plot of the submergence curves for various factors is shown in the Figure above.

~IEiiJI Hydrologic Engineering Center

Degree of Submergence

__ Normal Curve

---1.3 Factor

1.5 Factor

··x 2.0 Factor

-- 3.0 Factor

14 •
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Manning's n Values
1) Manning 2) Higher n

Geom: Higher n yalues Flow: Base event

Jo-----~TesI1
• Manning's n values that are too

low can cause model instability

• Lower depths

• Higher velocities

• Supercritical flow

• Flow transitions

• Manning's n values that are too
high will locally increase stage
and attenuate the hydrograph
more as it moves downstream

6.5

6.0

5.5

5.0

legend

ws Low n

WS High n- ,- --
CriticalDp

CriticalDp

Ground

Manning's n values can also be a source of model instability. Manning's n values that are too
low, will cause shallower depths of water, higher velocities, and possibly even supercritical
flows. This is especially critical in steep streams, where the velocities will already be high.
User's should check there estimated Manning's n values closely in order to ensure reasonable
values. It is very common to underestimate Manning's n values in steep streams. Use Dr.
Robert Jarrets equation for steep streams to check your main channel Manning's n values.

• Hydrologic Engineering Center

3.0\-.-~~ ~__~~_~

800 900 1000 1100 1200

Main Channel Distance (ft)

15

•

Over estimating Manning's n values will cause higher stages and more hydrograph attenuation
than may be realistic .

L - Common Model Stability Problems for Dam Break Analysis/Brunner 15
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Low Flow Conditions

• Low flows are often a source of model instability

• Pools and riffles (flow passes through critical depth)

• Very shallow depths (When flood wave starts the change in
depth/velocity is very large, therefore derivatives are large)

• Solutions

• Increase Base Flow of Hydrograph (change hydrographs directly or
use the Qmin option on the hydrograph editor)

• Rule of thumb: Start with 1% of peak, don't exceed 10% of peak

• Use a "Pilot Channel" to smooth our bed irregularities and provide
some artificial depth.

•

If any portion of an inflow hydrograph is so low that it causes the stream to go through a pool
and riffle sequence, it may be necessary to increase the base flow. The minimum flow value
must be small enough that it is negligible when compared to the peak of the flood wave. A
good rule of thumb is to start with a minimum flow equal to about 1 % of the peak flood (inflow
hydrograph, or dam breach flood wave) and increase as necessary to 10%. If more than 10% is
needed, then the problem is probably from something else.

Hydrologic Engineering Center 16 •
Very shallow depths of water: When starting a simulation it is very common to start the
system at low flows. If you have some cross sections that are fairly wide, the depth will be very
small. As flow begins to come into the river, the water surface will change quickly. The
leading edge of the flood wave will have a very steep slope. Sometimes this steep slope will
cause the solution to reduce the depth even further downstream of the rise in the water surface,
possible even producing a negative depth. This is do to the fact that the steep slope gets
projected to the next cross section downstream when trying to solve for its water surface. The
best solution to this problem is to use what is called a pilot channel. A pilot channel is a small
slot at the bottom of the cross section, which gives the cross section a greater depth, without
adding much flow area. This allows the program to compute shallow depths on the leading
edge of the flood wave without going unstable. Another solution to this problem is to use a
larger base flow at the beginning of the simulation.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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3.1 L-O?

Initial Conditions

Make sure that the initial conditions flow is consistent with the first time step flow, or minimum
flow value, which ever is greater. User's must also pay close attention to initial gate settings for
the reservoir, and the initial stage of the pool in the reservoir. The initial condition flow values
must be consistent with all inflow hydrographs, as well as the initial flows coming out of the
reservOir.

I-!;f--------;,:~;;;:--i·~ -----------...J
192 SotS
133 559.7

"" 595195 615.6

E'o Qption< tie\>

BW"ld81Y CondboN IrQ! Cordions I
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• Initial condition flows need to be
consistent with boundary
condition flows at time zero.

• If dendritic system - can leave
initial condition flows blank.

• Initial Reservoir elevations need
to be consistent with initial flows
and gate settings used.

• Too low of, or inconsistent,
initial conditions flow can often
cause the model to blow up right
at the start of the simulation

r:"l"l':1t.:..!:..J Hydrologic Engineering Center

•
Flows entered on the initial conditions tab are used for calculating stages in the river system
based on steady flow backwater calculations. If these flows and stages are inconsistent with the
initial flows in the hydrographs, and coming out of the reservoir, then the model may have
computational stability problems at the very beginning of the unsteady flow computations.

•
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3.1 L-07

Steep Streams and Mixed Flow Regime •

Model goes to critical depth: The default solution methodology for unsteady flow routing
within HEC-RAS is generally for subcritcal flow. However, the software does have an option
to run in a mixed flow regime mode. However, this option should not be used unless you truly
believe you have a mixed flow regime river system. If you are running the software in the
default mode (subcritical only, no mixed flow), and if the program goes down to critical depth
at a cross section, the changes in area, depth, and velocity are very high. This sharp increase in
the water surface slope will often cause the program to overestimate the depth at the next cross
section upstream, and possible underestimate the depth at the next cross section downstream (or
even the one that went to critical depth the previous time step). One solution to this problem is
to increase the Manning's n value in the area where the program is first going to critical depth.
This will force the solution to a subcritical answer and allow it to continue with the run. If you
feel that the true water surface should go to critical depth, or even to a supercritical flow regime,
then the mixed flow regime option should be turned on. Another solution is to increase the base
flow in the hydrographs, as well as the base flows used for computing the initial conditions.
Increased base flow will often dampen out any water surfaces going towards or through critical
depth due to low flows.

• Higher velocities and rapid changes in depth and velocity are more
difficult to model and keep a stable solution.

• As Froude number approaches 1.0 (critical depth), the inertial terms
of the St. Venant equations and their derivatives tend to cause model
instabilities.

• Model goe~ to critical depth - RAS is limited to subcritcal flow for
unsteady flow simulations, unless you turn on the mixed flow option.

• Solutions:

• Higher n values (n values often under estimated in steep streams)

• Increase base flow of hydrographs and initial condition flows

• Try turning on the Mixed Flow regime option

~ Hydrologic Engineering Center 18 •
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3.1 L-G?

Mixed Flow Regime Option for
Unsteady Flow

In order to solve the stability problem for a mixed flow regime system, Dr. Danny Fread (Fread,
1986) developed a methodology called the "Local Partial Inertia Technique." The LPI method
has been adapted to HEC-RAS as an option for solving mixed flow regime problems when
using the unsteady flow analysis portion ofHEC-RAS. This methodology applies a reduction
factor to the two inertia terms in the momentum equation as the Froude number goes towards
1.0.

The default values for the equation are FT = 1.0 (Froude Number Threshold) and m = 10
(exponent). When the Froude number is greater than the threshold value, the factor is set to
zero. The user can change both the Froude number threshold and the exponent. As you
increase the value of both the threshold and the exponent, you decrease stability but increase
accuracy. As you decrease the value of the threshold and/or the exponent, you increase stability
but decrease accuracy. To change either the threshold or the exponent, select Mixed Flow
Options from the Options menu of the Unsteady Flow Analysis window.
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Unsteady Mixed flow Options . '.

• HEC-RAS uses the Local Partial Inertia
techt:Jique to model mixed flow regimes.

• User's can adjust the LPI parameters

•

•
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3.1 L-O?

Drops In The Bed Profile
Un5te~withsmilllet8Yenl
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Significant drops in the bed profile can also be a source of model stability problems, especially
at low flows. If the drop is very small, then usually an increase in baseflow will drowned out
the drop, thus preventing the model from passing through critical depth. If the drop is
significant, then it should be modeled with an inline structure using a weir. This will allow the
model to use a weir equation for calculating the upstream water surface for a given flow, rather
than using the unsteady flow equations. This produces a much more stable model, as the
program does not have to model the flow passing through critical depth with the unsteady flow
equations. HEC-RAS automatically handles submergence on the weir, so this is not a problem.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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3.1 L-07

Bridges and Culverts

Bridge/Culvert crossings can be a common source of model stability problems when performing
a Dam Break analysis. Many bridges will be overtopped during such an event. Many of those
bridges may in fact be washed out during such an event. Common problems at bridges/culverts
are the extreme rapid rise in stages when flow hits the low chord of the bridge deck or the top of
the culvert. Modelers need to check the computed curves closely and make sure they are
reasonable. One solution to this problem is to use smaller time steps, such that the rate of rise in
the water surface is smaller for a given time step. Modelers may also need to change hydraulic
coefficients to get curves that have more reasonable transitions.

•

• It is very common to have rapid changes in depth and
velocity at Bridges and Culverts, however this can be a
source of model instability

• As flow transitions from low flow to pressure flow at
the structure the water surface upstream will jump up
very quickly.

• HEC-RAS pre-processes bridges/culverts into a family
of curves (tailwater/headwater vs flow). Common
Problems with the curves are:
• Curve extents not high enough (change default extents)

• Abrupt transitions in curves (adjust bridge parameters or use
smaller Ll1)

Hydrologic Engineering Center 21

•

An additional problem is when the curves do not go high enough, and the program extrapolates
from the last two points in the curve. This extrapolation can cause problems when it is not
consistent with the cross section geometry upstream and downstream of the structure.

L - Common Model Stability Problems for Dam Break Analysis/Brunner 21
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Bridge/ Culvert Family of Curves •

•

.:J
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Bridge/Culvert Family of rating curves:' The program creates a family of rating curves to
define all the possible headwater, tailwater, and flow combinations that can occur at a particular
structure. The user can control how many submerged curves get calculated (default = 50), how
many points in each curve (default = 20), and the properties used to define the limits of the
curves (maximum headwater, maximum tailwater, maximum flow, and maximum head
difference). By default, the software will take the curves up to an elevation equal to the highest
point in the cross section just upstream of the structure. This may lead to curves that are too
spread out and go up to a flow rate that is way beyond anything realistic for that structure.
These type of problems can be reduced by putting in specific table limits for maximum
headwater, tailwater, flow, and head difference.

•
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3.1 L-O?

Convert Energy Bridges to Cross
Sections with Lids

The option to convert bridges that have been modeled with the energy equation for low and high
flow is a good option if the structure and the road embankment are a small obstruction to the
flow. If the flow will have to contract greatly inside of the structure, then modeling the bridge
in this manner may lead to an unstable modeling solution through the structure. If you have
bridges and culverts that will cause the flow to contract greatly through the structure, and even
if you have chosen to use the energy equation for low and high flow, computing a family of
curves for the structure will produce a more stable model. When the family of curves is used,
the program does not solve the momentum and continuity equations inside of the structure, only
outside of the structure. The curves themselves are use to obtain a resulting headwater for a
given flow and tailwater, without solving for the hydraulics inside of the structure.

•

•

• HEC-RAS has on option to
model abridge as normal cross
sections with a lid instead of the
family of curves.

• Good option when
bridge/embankment are a small
obstruction to flow

• Bad idea when depth/velocity
will change rapidly through the
bridge (Will often cause model to
blow up)

Hydrologic Engineering Center
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3.1 L-07

Cross Section Geometry and
Table Properties

• Bad cross section properties, commonly caused by: levee
options, ineffective flow areas, Manning's n values, etc ...

• Cross section properties that do not go high enough, or are
way too high (curves are spread to far apart).

• Not enough definition in the properties tables .

.
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Bad cross section properties: All of the cross sections get converted to tables of hydraulic propetiies (elevation
versus area, conveyance, and storage). If the curves that represent these hydraulic properties have abrupt changes
with small changes in elevation, this can also lead to instability problems. This situation is commonly caused by:
levees being overtopped with large areas behind them (since the model is one dimensional, it assumes that the
water surface is the same all the way across the entire cross section); and ineffective flow areas with large amounts
of storage areas that are turned on at one elevation, and then tum off at a slightly higher elevation (this makes the
entire area now used as active conveyance area). There are many possible solutions to these problems, but the
basic solution is to not allow the hydraulic properties of a cross section to change so abruptly. If you have a levee
with are large amount of area behind it, model the area behind the levee separately from the cross section. This can
be done with either a storage area or another routing reach, whichever is most hydraulically correct for the flow
going over the levee or if the levee breaches. With large ineffective flow areas, the possible solutions are to model
them as being permanently on, or to put very high Manning's n values in the ineffective zones.

Cross section property tables that do not go high enough: The program creates tables of elevation versus area,
conveyance, and storage area for each of the cross sections. These tables are used during the unsteady flow
solution to make the calculations much faster. By default, the program will create tables that extend up to the
highest point in the cross section, however the user can override this and specify their own table properties
(increment and number of points). If during the solution the water surface goes above the highest elevation in the
table, the program simply extrapolates the hydraulic properties from the last two points in the table. This can lead
to bad water surface elevations or even instabilities in the solution.

Not enough definition in cross section property tables: The counter problem to the previous paragraph is when
the cross section properties in a given table are spread too far apart, and do not adequately define the changes in the
hydraulic properties. Because the program uses straight-line interpolation between the points, this can lead to
inaccurate solutions or even instabilities. To reduce this problem, we have increased the allowable number of
points in the tables to 100.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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3.1 L-O?

Breach Characteristics

If the user puts in a very large breach, over a very short period of time, and they use the linear
breach growth rate, the model will have a very abrupt change in flow starting right at the
beginning of the breaching process. This rapid change in flow at the leading edge of the flood
wave may cause an instability at the beginning of the breaching process, just downstream of the
dam. Some possible solutions to this are:

·Smaller time step

·Use the non-linear breach progression (sine wave or user entered)

•Increasing the overall breach time.
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• By default HEC-RAS
uses a linear growth rate
for forming the breach.

• Rapid change in flow at
the beginning of the
breach can cause
instability

• Try non-linear breach to
smooth out change in
flow (Sine Wave or User
entered values)

•

•
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3.1 L-07

Bad Downstream Boundary
Conditions

• Rating curve with bad points or not high enough

• Slope for normal depth to steep

Unsteady with smaller event
Geom: Beaver Cr.• bridge Flow.
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Bad downstream boundary condition: If the user entered downstream boundary condition causes abrupt jumps
in the water surface, or water surface elevations that are too low (approaching or going below critical depth), this
can cause oscillations in the solution that may lead to it going unstable and stopping. Examples of this are rating
curves with not enough points or just simply to low of stages for a given flow; and normal depth boundaries where
the user has entered to steep of a slope for the energy gradeline.
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Detecting Stability Problems

• How do you know you have a model stability problem?

• Program completely blows up during run.

• Program says matrix solution went completely
unstable during the calculations.

• Computed error in water surface calc is very large

• Program goes to maximum number of iterations for
several time steps in a row, with large errors.

• Program has oscillations in the computed stage and
flow hydrographs.

~ Hydrologic Engineering Center
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3.1 L-07

Detecting Stability Problems
Continued

• What do you do when this happens?

• I ote the simulation time and location from the computation window
when the program either blew up or fIrst started to go to the maximum
number of iterations with large water surface errors.

• Use the HEC-RAS Prome and Cross Section Plots as well as the
Tabular Output to fInd the problem location and issue.

• If you can not fInd the problem using the normal HEC-RAS output 
Turn on the "Detailed Output for Debugging" option and re-run the
program.

• View the text me that contains the detailed log output of the
computations. Locate the simulation output at the simulation time
when the solution fIrst started to go bad.

• Find the river station locations that did not meet the solution
tolerances. Then check the data in this general area.

~ Hydrologic Engineering Center 28
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3.1 L-O?

Computation Window

• First place to look for problems
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• When the maximum number of
iterations is reach, and solution error is
greater than the predefined tolerance,
the time step, river, reach, river station,
water surface elevation and the amount
of error is reported.

• When the error increases too much,
the solution will stop and say "Matrix
Solution Failed".

• Often the first RS to show up on the
window can give clues to the source of
instabilities

I I

..... Hydrologic Engineering Center•
The first place to look for instabilities and errors is the Computations Window
during and just after the simulation is run. The red progress bar indicates the model
went unstable and could not complete the simulation. The Computation Messages
window provides a running dialog of what is happening in the simulation at a given
time step in a given location. This allows the user to watch errors propagate during
the simulation. Once the simulation has crashed, don't close the Computations
Window. Instead, scroll up through the messages and try to determine where the
propagation of errors began, and at what time.

•
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3.1 L-07

Computation Window •
• Focus on larger
compounding errors.

•
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• Small errors are generally
riot problematic

• Try to find time and
location when errors first
begin to occur.

Computation Messages

Maxinun iterations ol2O at:
10SEP200403:28:45 P%mac River Kiz·Sava
10SEP200403:29:oo Polomac River Kilz·Sava
10SEP200403:29:15 P%mac River Kilz.Sava
lOSEP200404:48:30 Polomac River Kitz.Sava
10SEP200404:48:45 Polomac River Kilz·Sava
10SEP200404:49:00 Polomac River Kilz·Sava
10SEP200404:49:15 Polomac River Kilz·Sava
10SEP2004 05:10:30 Polomac River Kilz·Sava

Sometimes the first error to occur is at the beginning of the simulation and is just a
result of the model settling out after the transition from initial conditions to the first
time step. Particularly if the error only occurs once for that given river station. It is
better to focus on reoccurring errors or compounding errors first. The example on
this slide shows a relatively small error at river station 259106* that grows to 0.4 ft
in the next few time steps.

•
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•

Profile Plot

• Great visual tool for finding problem areas.

• Use the "Animation" option to look for obvious
instabilities. Zoom in to get a closer look.

• May need to refine the Detailed Output Interval
to see where and when the instability occurs.

• When the first hints of an instability is revealed,
click on that "node" and investigate further.

Hydrologic Engineering Center

The profile plot is typically the first graphical tool to use to try to pinpoint
instabilities. Obvious errors are shown distinctly in this plot and you can see what
is going on in the entire reach at the same time. Stepping through each profile using
the animation tool allows you to see changes over time, including the progression of
the flood wave as well as propagation of errors. The profile output is taken from the
detailed output file. Therefore, it is sometimes necessary to refine the detailed
output interval to adequately see the beginning of instabilities. The profile plot
allows the user to click on a given node to determine its river stationing. Find the
node where the instability first occurs and investigate further.

3.1 L-G?

31
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Profile Plot Animation

R.lood O.t. I
200 ft spacing

Geom: 200 ft spacing Flow:

Potomac River Kitz·Sava --;---1,----;-:=-;---, I
legend

, ,. ."'!:..1.0.S~P.~~~~ ?~~.
, ern 10SEP2004 0235
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•

Hydrologic Engineering Center
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32 •
The above slide was an animation of the profile plot, showing the progression of a
model instability problem. The profile plot can assist you in locating where an
instability is occurring and when. You may need to zoom in to get a closer look.
You may also need to set the Detailed Output Interval to a smaller value and re
run the simulation in order to see what is happening at a finer time step increment.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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Computation Level Output

When performing an unsteady flow analysis the user can optionally tum on the ability to view
output at the computation interval level. This is accomplished by checking the box labeled
Computation Level Output on the Unsteady Flow Analysis window (In the Computations
Settings area on the window). When this option is selected an additional binary file containing
output at the computation interval is written out. After the simulation the user can view
computation level output by selecting either Unsteady Flow Spatial Plot or Unsteady Flow
Time Series Plot from the View menu of the main HEC-RAS window.

, Dam (lnIine Structure) with breach data.. 1 sel to bfeach.

33

Sholt ID 1200 n

IL.. .. ~.-.__._._.----...:~..P.'!'~. __ - __ .---._. . ..,.,._!I

GeometJy Fie: 1200nspacing ::::J

Unslee<t> Flow Fie : r.:1NOl-m-:-oIP::-ooI7 ·"7shOl-:-t-'eech-:--------=:,::::J

r·PIOQtMltloRl.I'l-···-~PlanOesCliption:

P' GeotnelI.vPreproces$Of 11,..---------0
P Unstead}l flow SirnJlation ! ...
r;; Post PrOceSSOI j
r Waler Qually SimoJalKin j

I~:~~~~Wmow [:~:::::m ,mmmm~~:~~~:e-r:~~··-]
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f,1 ComPutalKln Level Output Oetailed Output Inle,vet [jO'M;:;;;;;:::J i
DSS Output Fien""", C\HEC Oe:eIHEC·RASlPn';ect.\JuI;.F,lz\JR_dambr ~i

I r M~ed FlowR~. (.ee"""", 'Upl<>nsIM~edFlow Options .,.'1 ,
~ .

Ei. Qpt;ons He~

PIon: /206 nspacng

.: Hydrologic Engineering Center

• Writes flow and stage at all
locations to a separate file.

• Tools available from the View
menu:
• Spatial Plots

• proftle
• schematic

• Time Series plots
• water surface, depth, flow
• WS and flow errors

• Warning: Can create large
output files when used with
large data sets for long times

•

•
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Computation Level Output
Visualization Tools

•
I~11iiI1~ Cro..·Sectkns ...

L::::S.Jj Wdter S4..ddl.cp,vI'"lh ...

Pr~ect Pi Gener<li P,oIle Plot ...
PI«t Jzl RolItlNJC""l~<.·.
Geometry. I2l X-V-! Perspective Plots ...

. 2"<je and Fbw Hydroor~phs ...
Steady Flew: ~ Hydraulic Property Pots ..•

Unsteady flow: I'" nl'it.>'iIM OIlt"llt TAnl-.< .

DesCliption; ~ Profle 5t.Jrr'lr'Mry T~e .

Sunrnary Err,Warn, \Jotes ...

........................... EC-RASlProjoct.\I"',fr'z\lR_deml>k_H.uO<

o I Version 4.0 Bet" Ius Cu~ome<y U.t.

Vcriabloo ... Aeloedfile

Visualization of computation level output can be accomplished with either Spatial Plots or
Time Series Plots. From the Spatial Plots the user can view either a profile plot, a spatial plot
of the schematic, or tabular output. The user can select from a limited list of variables that are
available at the computation level output. These are water surface elevation (XS WSEI); Flow
(XS Flow); computed maximum error in the water surface elevation (XS WSEL ERROR);
computed maximum error in the flow (XS FLOW ERROR); and maximum depth of water in
the channel (DEPTH). Each of the plots can be animated in time by using the video player
buttons at the top right of the window. This type of output can often be very useful in
debugging problems within an unsteady flow run. Especially plotting the water surface error
and animating it in time.

The other type of plot available at the computation interval output level is the Unsteady Flow
Time Series Plot. When this option is selected the user will get a plot as shown in the Figure
above. Some of the same options and variables are available for the Time Series Plots as were
available for the Spatial Plots.

i DSSD.~.e..:.:.................. . Plo I Tebl>!

l.un",,~eiiidYI.iFlo~W~Spet;i';'P1ot~(;com~P<J,t<t~"n~nt."Vlljiel)~..'~",IIH"t' 1-_C~\:HE~C:Da:ta~If-E~C='RAS\PrOjectS\JUlieF ril!\JR_dambrkJt. hydJ2

1'__[_~;'"'I~:T'1r_·~_,~_~_~_~_w;_}.¥_.m._?t_".5'_"".m_..P_·····~_J,._·······_·····"I ;x(~.;. 1=N~ ~I~=,,,I

i_....,.- 259052."
...... 258999.' ..{I.e: ... ..- ~ L . ~ .... ~ ..._ ..L.-........_:.. ...._.... ..... ;
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"... Hydrologic Engineering Center 34 •
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• Cross Section Plot

3.1 L-07

•

• Can help spot isolated
problems such as:

• Incorrect Bank Station locations

• Bad Manning's n Values

• Bad Station-elevation points

• Can help spot transition
problems

• Contraction/Expansion Areas

• Ineffective Flow Areas

• Levees
Hydrologic Engineering Center 35

•

Once a location for an instability is determined on the profile plot, the cross section
plot can be used to investigate the cause of the instability. The cross section plot
will show isolated problems such as incorrectly placed bank stations, poor n-values,
and bad station-elevation data. In addition, scrolling through its neighboring cross
sections can give you an idea of transition problems like contractions and
expansions that occur to abruptly, poorly defined ineffective flow areas, or
incorrectly handled levees or natural high ground spots.
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Cross Section Plot

3.1 L-07

•
• Wide, Horizontal Beds PMF Evenl with Breach of Dam

Geom: Existing GIS Data Nov 2006 Flow:

• Estimated XS?
."" +-.04-:-."" I

. legend

WS Max WS

c;;;;:;;;;-

• LIDAR, no bathymetry?
.

BankSla. .
;

• Prone to instabilities - Hi9h~
660

High Area:Depth ratio

• High Ground 655

• Levee Option 650·

• Ineffective Flows? Missing Data?

1000 1200 1400 1600 lBOO 200.

• Solutions? Statkln(ft)

I I •III" Hydrologic Engineering Center 36

Another typical source of instabilities occurs when the main channel has a wide flat
bed. This is usually found when cross sections are approximated or when terrain
data is used to develop cross sections exclusive of real bathymetric data. Many
times reaches are developed in GIS using LIDAR data or other aerial means. These
survey methods don't penetrate water surfaces so the main channel is left with a flat
horizontal bed equal to the water surface elevation. For shallow streams in dam
breach analyses, this is normally okay, since the dam break flood wave is usually
much greater than the depth of water. However, wide flat stream beds lend to
instabilities because at lower flows, the area to depth ratio is very high. Again this
presents the same problem of a small increase in depth amounting to a large relative
mcrease.

Additionally, in the cross section plot, high ground that is not appropriately
accounted for can be detected and fixed to remove sources of instabilities. High
ground can be modeled as levees or with ineffective flows to remove the abrupt
changes in storage and conveyance when the high ground is overtopped.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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• Cross Section Plot

3.1 L-07

37
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Hydrologic Engineering Center

The example in this slide shows an abrupt transition from a wide main channel to a
narrow main channel. If these cross sections are close enough, the flow man not be
able to contract so suddenly and the approximate numerical methods may not be
able to handle this situation. In this case, ineffective flow areas can be placed in the
wide cross section to help smooth the transition from wide to narrow. If these cross
sections are far enough apart, then perhaps additional interpolated cross sections are
warranted.

•
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Cross Section Plot •

•

legend
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r;-:c=--,I

38

PMF Event with Breach of Dam
Geom: Existing GIS Data Nov 2006 Flow:
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• Levee or Ineffective
Flow? Or Neither?

• Ineffective Flow Areas
PMF Event with Breach of Dam

Geom: Existing GIS Data Nov 2006 Flow:
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Ineffective flow areas are required up and downstream of bridges and culverts to
properly define the contraction and expansion zones. Unsteady flow models, and
particularly dam breach models, need these zones to be adequately defined. When
the bridge is overtopped, the ineffective flow areas will turn off. This sudden and
large increase in conveyance can cause model instability. One solution is to use
very high Manning's n values (.2 to 1.0) in the ineffective flow zones, so when they
turn off the increase in conveyance is not so great. This is also more physically
appropriate as the cross sections just upstream and downstream can not flow
completely freely because of the bridge embankment.

When an isolated high ground area is causing an instability problem, the user must
decide if this high ground is better modeled with the levee option or with ineffective
flow.

•
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• Profile Summary Tables

3.1 L-07

Reach River St. Ptofile

.Tetal now i1 croS$ section.•

• Sometimes visual clues are not
available. Tabular output help.

• lateral inflow/outflow

• Tributaries

• Interaction with storage areas

• Lateral structure flow

• Inline structure flow

• Flow inconsistency

• Main channel to overbanks

• Other internal boundaries

• Groundwater

Hydrologic Engineering Center

Kentwood 5.44
Kentwood 5.425
Kentwood 5.41
Kentwood 5.4
Kentwood 5.39
Kentwood 5.37
Kentwood 5.35
Kentwood 5.33
Kentwood 5.31
Kentwood 5.29
Kentwood 5.274
Kentwood 5.258
Kentwood 5.242
Kentwood 5.226
Kentwood 5.21
Kentwood 5.194
Kentwood 5.178
Kentwood 5.162
Kentwood 5.146
10" ... _.4 c:::,?

•

10FEB199921oo
10FEB199921OO
10FEB1999

212.53
21i03
21260
212.06

·····;111.57

39

•

Often times the graphical options alone are not adequate to determine the source of
instability. Another option is to go to the profile output table and analyze values of
hydraulic parameters from one cross section to the next or from one profile to the
next. Problems that don't always show up graphically are lateral inflows and
outflows, groundwater interaction and the effects of lateral structures. It is
imperative that the important hydraulic parameters (flow, depth, area, storage)
change as gradually as possible. Flow consistency between the overbanks and the
main channel is also important.
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Detailed Output Tables •

Detailed output tables are available for many types of nodes in HEC-RAS, including: cross
sections, bridges, culverts, inline structures, lateral structures, storage areas, and pump stations.
These detailed tables can be very helpful in seeing what is going on at that structure for a
particular time step.

Hydrologic Engineering Center 40 •

•
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Turning on Detailed Log Output
for Debugging

OK I li-cancer,1

41

Detoied Loo 0"""
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,
"... Hydrologic Engineering Center

As shown in the figure above, the section at the bottom half of this editor is used for controlling
the detailed log output. Three check boxes are listed. The first box can be used to tum on an
echo of the hydrograph input to the model. This can be used to ensure that the model is
receiving the correct flow data. The second check box can be used to tum on an echo of the
computed hydrographs that will be written to the HEC-DSS. This is a good option for checking
what was computed. However, if the user has selected to have hydrographs computed at many
locations, this could end up taking a lot of file and disk space. The third check box is used to
control the detailed output of results from the unsteady flow simulation. Selecting this options
will cause the software to write detailed information on a time step by time step basis. This
option is useful when the unsteady flow simulation is going unstable or completely blowing up
(stopping). Checking this box turns on the detailed output for every time step. The user has the
option to limit this output to a specific time window during the unsteady flow simulation.
Limiting the log output is accomplished by entering a starting date and time and an ending date
and time.

•

•
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Viewing Detailed Log Output •
. Help .

Plan:i 01' 2tage and Flow OUtput Locations ...

i Elow Distribution Locations ...

j Flow ~oughness Factors ...

'_PI~~~~so~~1 Roughness Eactors ...
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10000

12400
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Viewing Detailed Log Output: After the user has turned on the detailed log output option, re
run the unsteady flow simulation. The user can then view the detailed log output by selecting
View Computational Log File from the Options menu of the Unsteady flow simulation
window. When this option is selected the detailed log output file will be loaded into the default
text file viewer for your machine (normally the NotePad.exe program, unless you have changed
this option within HEC-RAS).

Ylew Computation Log File ...

:'1': Hydrologic Engfto!l'l'l'""'T'T':!'i'ml.,.....---------------'
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3.1 L-07

What is found in the detailed
Output

• DSS Data ~ shows all the data that was read from
DSS.

• Unsteady Flow Computations Output.,..- Detailed
unsteady flow calculations:
• Job control parameters

• Initial conditions calculations

• Detailed output for each time step

• TABLE Output - final hydrographs that are
written to DSS

Hydrologic Engineering Center 43

The detailed log output file will contain the following output:

DSS Output: Shows all of the hydrograph data that will be used as input to the model,
including data read from HEC-DSS.

Unsteady Flow Computations Output: Detailed unsteady flow calculations including:

Job control parameters

Initial conditions calculations

Detailed output for each time step

Table Output: Final computed hydrographs that are written to HEC-DSS.
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Initial Conditions Output

- .. .. ... ~2!J
!3Ie ~cIt "",mat t!o\>
Initial conditions from Backwater ¢j

:....J
Oiamond North

Riv. Sta. Flow WSEL cri't Depth EG slope Area Topwidth vel~~ji¥ Error converged
6.0 J.OO.O J.1. 21 0.0000036 320.88 43.21 0.00000 T
5.8 J.OO.O n.20 0.0000027 355.63 44.00 0.28J. 0.00000 T
5.6 J.OO.O n.20 0.0000020 391. OS 44.80 0.256 0.00000 T
5.4 J.OO.O n.20 0.00000J.5 443.55 J.00.40 0.225 0.00000 T

~
5.2 J.OO.O J.1. 20 O.ooooon 553.25 174.29 0.J.8J. 0.00000 T
5.0 J.OO.O n.20 0.0000008 720.29 230.22 0.139 0.00000 T
4.8 J.OO.O n.20 0.0000008 720.08 230.22 0.139 0.00000 T
4.6 J.OO.O n.20 0.0000008 719.88 230.22 0.139 0.00000 T
4.4 J.OO.O n.J.9 0.0000008 719.68 230.22 0.139 0.00000 T

~:4.2 J.OO.O n.J.9 0.0000008 719.47 230.21 0.139 0.00000 T
4.0 J.OO.O n.J.9 0.0000008 719.27 230.2J. 0.139 :

oiamond Northwest

Riv. st:a. Flow WSEL crit Depth EG slope Area Topwidth velg~6~~ Error converged
4.0 70.0 n.J.9 0.0000004 719.32 230.2J. 0.00000 T
3.8 70.0 n.J.9 0.0000004 719.24 230.21 0.097 0.00000 T
3.6 70.0 n.J.9 0.0000004 719. J.6 230.2J. 0.097 0.00000 T

~'
3.4 70.0 J.1.J.9 -0.5J. 0.0000004 498.62 45.00 0.140 0.00000 T
3.395 culvert
3.39 70.0 n.oo -0.5J. 0.0000005 489.99 45.00 O. J.43 0.00000 T
3.35 70.0 n.oo 0.0000005 489.99 45.00 0.143

oiamond Northeast

Riv. Sta. Flow WSEL erit Depth E:G slope Area Topwidth velocity Error converged
3.9999 30.0 n.oo O.OOOOOOJ. 675.21 230.00 0.044 0.00000 T
3.77768 30.0 n.oo O.OOOOOOJ. 675.J.9 230.00 0.044 0.00000 T
3.55547 30.0 J.1.OO O.OOOOOOJ. 675.17 230.00 0.044 0.00000 T

:~3.33326 30.0 J.1.OO O.OOOOOOJ. 675.14 230.00 0.044 0.00000 T
3.J.U05 30.0 n.oo O.OOOOOOJ. 675.J.2 230.00 0.044 0.00000 T
2.88884 30.0 J.1.OO O.OOOOOOJ. 675.J.0 230.00 0.044 0.00000 T
2.66663 30.0 n.oo O.OOOOOOJ. 675.08 230.00 0.044 0.00000 T
2.44442 30.0 J.1.OO O.OOOOOOJ. 675.06 230.00 0.044 0.00000 T

rm:
2.22221 30.0 J.1.OO O.OOOOOOJ. 675.03 230.00 0.044 0.00000 T

~"., ...................... N - ;,-;:1"';": • - - . -- - . -
44

The program lists the computed initial conditions from a backwater calculation for each of the
river/reaches. They are generally listed in an upstream to downstream order. However, they are
computed from downstream to upstream under the assumption of subcritical flow.
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Example Detailed Time Step
Output for cross sections

salving for T • -3.250

Iter River station E:lev 02 Storage Zsa
o Beaver creek 5.0 210.53 0.51156 Bayou 206.13
1 Beaver creek 5.0 210.22 -0.43984 Bayou 206.13
2 Beaver creek 5.0 209.94 -0.39653 Bayou 206.13
3 Beaver creek 5.0 209.6B -0.373B3 Bayou 206.13
4 Beaver creek 5.0 209.43 -0.35521 Bayou 206.13
5 Beaver creek 5.0 209.22 -0.30138 Bayou 206.13
6 Beaver creek 5.065' 211.02 0.62017 Bayou 206.13
7 Beaver creek 5.065' 214.64 5.17663 Bayou 206.13
~I EXTRAPOLATED ABOVE THE TOP OF THE PROPERTY TABLE AT XSEC(S):

Beaver Creek 5.065' 214 , 64 2090
8 Beaver creek 5.0 207.13 -1. 03604 Bayou 206.13
9 Beaver creek 5.0 206.04 -1. 55023 Bayou 206.13

10 Beaver creek 5.0 204.72 -1. 89683 Bayou 206.13
11 Beaver creek 5.0 203.50 -1. 73679 Bayou 206.13
12 Beaver creek 5.0 202.14 -1. 94 503 Bayou 206.13
13 Beaver creek 5.0 200.64 -2.13693 Bayou 206.13
14 Beaver Creek 5.0 199.25 -1. 98779 Bayou 206.13
15 Beaver creek 5.0 197.84 -2.01339 Bayou 206.13
16 Beaver creek 5.0 196.46 -1.97657 Bayou 206.13
17 Beaver Creek 5.0 195.08 -1.97219 Bayou 206.13
18 Beaver creek 5.0 193.70 -1. 96514 Bayou 206.13
19 Beaver creek 5.0 192.33 -1.95701 Bayou 206.13
20 Beaver creek 5.0 190.97 -1. 946B9 Bayou 206.13

DZsa River
0.01598 Beaver Creek
O. 00000 Beaver creek
0.00000 Beaver creek
O. 00000 Beaver creek
0.00000 Beaver creek
0.00002 Beaver creek
0.00005 Beaver creek
0.00076 Beaver creek

-0.00055 Beaver creek
0.00057 Beaver Creek
0.00053 Beaver creek

-0.00003 Beaver creek
0.00028 Beaver creek
0.00038 Beaver creek

-0.00013 Beaver creek
0.00001 Beaver creek

-0. 00006 Beaver Cr eek
-0.00002 Beaver creek
-0. 00002 Beaver Cr eek
-0.00002 Beaver creek
-0.00002 Beaver creek

station
5.0
5.0
5.0
5.0
5.0
5.0
5.0
5.0

5.065'
5.0
5.0
5.065"
5.0
5.0
5.065'
5.0
5.0
5.0
5.0
5.0
5.0

Q
5358::..J
5538 1
5700
5805
5883
6041
5909
2843

3234
2142

930
1564

457
-175

802
-1
88

126
155
184,
218,

One way to find and locate potential stability problems with the solution is to do a search in the
file for the word "WARNING". The user then needs to look at the detailed output closely to
try and detect both where and why the solution is going bad. The variables that are printed out
during the iterations are the following:

Iter = Iteration Number.

River = River Name of the location with the largest error in stage.

Station = River station with the larges error in the calculated stage.

ELEV = Computed water surface elevation at that river station.

DZ = The "Numerical Error" in the computed stage at that location.

Storage = Name of the storage area that has the larges error for this iteration.

Zsa = Computed elevation of the storage area.

Dzsa = The" umerical Error" in the computed storage area elevation.

River = River arne of the location with the largest error in flow.

Station = River station with the largest error in the calculation of flow.

Q = Computed flow

DQ = The" umerical Error" in the computed flow at the listed river station

Note: If the program goes to the maximum number of iterations, it will choose the iteration that
had the minimum amount of error, set that as the solution for the current time step, and then go
to the next time step.

!WARNING, USED COMPUTED CHANGES IN FLOW AND STAGE: AT MINIMl.f.1 ERROR. MINIMUvl ERROR OCCURED DURING ITERATION S.

•

•

.1 I
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Example Detailed Time Step Output
for • Continuedcross sectlons -

- , , , .... I. ~
" Elle ~ Fl!fmal tlelp

COMPUTED STAGES AND DISCHARGES AT T - 0.ll67 HOURS - 2!IO!I999 AT 0007 HOURS ::f
Beaver creek Kentwood

Riv. station Z Q V R;V. station Z Q v Riv. Stat; on Z Q V
5.99 n3.03 599. I.09 5.97 n2.94 588. I. 22 5.951 n2.83 579. I. 37
5.93 n2.7I 57I. I.56 5.9B n2.56 564. I. 79 5.894 n2.38 558. 2.04

5.875 n2.I9 552. 2.34 5.855 nI. 98 547. 2.65 5.836 2n.74 543. 2.9I
5.81 2n.52 540. 2.96 5.798 nI. 36 536. 2.45 5.779 2n.24 532. I. 76
5.76 2n.I? 528. I.I8 5.741 2n.07 523. I. 64 5.72 nO.9I 52I. 2.15

5.703 nO.75 519. 2.3I 5.685 nO.61 517. 2.30 5.666 nO.48 5I6. 2.I9
5.647 210.37 SIS. I. 92 5.628 nO.27 514. I. 62 5.6I nO.21 5B. I.3I
5.593 210. B 512. I. 52 5.576 nO.03 5n. I. 80 5.559 209.93 51I. 2.06
5.542 209.85 510. 2.23 5.525 209.78 510.' 2.24 5.508 209.72 510. 2.14
5.491 209.67 5IO. I. 94 5.474 209.64 5IO. I.76 5.457 209.61 510. I. 60

5.44 209.58 5IO. I. 4 7 5.425 209.58 509. I.n 5.41 209.57 509. 0.88
5.39 209.54 509. 0.88 5.37 209.52 509. Ion 5.35 209.48 509. I.46
5.33 209.40 5IO. I. 67 5.3I 209.28 510. I. 67 5.29 209.I5 5IO. I.47

5.274 208.95 SIO. I.66 5.258 208.68 5n. I. 95 5.242 208.29 5n. 2.55
5.226 207.85 51I. 3. os 5. n 207.46 5I2. 3.29 5.I94 207. IS 5I2. 3.B
5.I78 206.95 5B. 2.68 5.I62 206.83 5B. 2.16 5.146 206.75 SI4. I. 75
5.B 206.7I 514. I.45 5.n3 206.65 SIS. I. 50 5.097 206.59 SIS. I. 56

5.081 206.53 516. I. 60 5.065 206.46 517. I. 63 5.048 206.39 5I? I. 65
5.032 ' 206. 3I 518. I. 66 5.016 206.23 519. I. 66 5.0 206. I3 519. I. 64

solving for T • O.IB ;~
Iter River Station Elev DZ River station Q DQ

o Beaver creek 5.99 2B.07 0.03530 Beaver creek 5.99 6I3 I4
1 Beaver creek 5.0 206. B -0.00050 Beaver creek 5.93 584 1

~• ...... I '..J - r> tal .. ,.."

lm: Hydrologic Engineering center'

" .., ~
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During the unsteady flow computations, the program will output detailed information for cross
sections, bridges/culverts, inline weir/spillways, lateral weir/spillways, storage areas, and
storage area connections. This information should be reviewed closely when the software is
having stability problems. An example of the detailed output for cross sections is shown in the
Figure above.

L - Common Model Stability Problems for Dam Break Analysis/Brunner
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•
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3.2 W-05

Trouble Shooting Workshop

Introduction

This workshop will help students learn how to trouble shoot instability problems
associated with developing unsteady flow models with HEC-RAS. This workshop
contains four separate instability problems, which are to be solved by the student. While
the data is from actual studies, the models and results ofthis workshop do not represent
current orfuture conditions ofthe rivers.

Problem Description 1

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. A project file (Stabilityl) with the title "Stability Problem Number I" has
been loaded on your workshop computers. The file contains all the data for this
workshop. The geometry for this example includes the bridge crossing and interpolated
cross sections.

Task 1

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model based on
your hypothesis until a stable computation is achieved.

Note on Viewing Profile Plot

Stepping through a time series animation with the Profile Plot is a good starting
point to view where and when an instability occurred. When the Profile Plot Window is
first opened the program will default to the maximum water surface. Unfortunately,
when the program goes unstable the maximum water surface will usually have erroneous
data. The bad data skews the dimensions of the plot, as seen in Figure 1.

The view needs to be corrected to analyze the instability. Under the Options menu of the
Profile Plot, select Profiles. Next, clear the maximum water surface profile from the
selection window and select the first profile. An example is shown in Figure 2. This
should restore the view, then proceed through the time steps for analysis .

P-06(188-07)1 2007/GWB 1
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Reload Dala I •
Stability Problem Number 1 Plan: Unstable Problem 1 211812004

40000 ~,,,,-,"-",~""~,,,,~,,,,~....~....~..~....~....~....~....~.....~....~....~"".,8"e"a"v,.e."r,.,c"r,e"e"k, ,K"e.. ,nt",w,."O,O"d".·,""',··,·,,·...·'..."·'T"· .... " ..'1 ··,· ... ·· ......·...1 Legend

I
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I Gro~nd
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g
c
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>
~
w

Main Channel Distance (ft)

Figure 1 Maximum Water Surface Plot of Instability

3 (1 OFEB1999 0200J
4 (1 OFE B1999 0400)
5 (1 OFE B1999 0600) -+1
6 (1 OFE B1999 0800) -J
7 (10FEB19991000j
8 (10FEB19991200j
9 (1 OFEB19991400j
10 [1 OFE B1,,999 1600)

•
Select All Clear All I

OK Cancel I
Figure 2 Initial Profile Selected

Questions

At what time step and at what location did the program begin to go unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved? •
P-06( 188-07)1 2007/GWB 2
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3.2 W-05

Problem Description 2

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. A project file (Stability2) with the title "Stability Problem Number 2" has
been loaded on your workshop computers. The file contains all the data for this
workshop. The geometry for this example includes a bridge, interpolated cross sections,
lateral weir with gates, and a storage area.

Note: The computation interval for this simulation is set to 5 minutes. Determine what is
causing the instability without adjusting this interval.

Task 2

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model based on
your hypothesis until a stable computation is achieved.

Questions

At what time step and at what location did the program begin to go unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved?

P-06( 188-07)1 2007/GWB 3
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Problem Description 3

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. A project file (Stability3) with the title "Stability Problem Number 3" has
been loaded on your workshop computers. The file contains all the data for this
workshop. The geometry for this example includes the bridge crossing and interpolated
cross sections.

Note: The computation interval for this simulation is set to 5 minutes. Determine what is
causing the instability without adjusting this interval.

Task 3

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model based on
your hypothesis until a stable computation is achieved.

Questions

At what time step and at what location did the program begin to go unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved?

•

•

•
P-06( 188-07)/ 2007/GWB 4
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Problem Description 4

The stream for this example is a section of Brunner River located near Jensen Town.
The reach is a trapezoidal, concrete lined channel. A project file (Stability4) with the title
"Stability Problem umber 4" has been loaded on your workshop computers. The file
contains all the data for this workshop

Note: The computation interval for this simulation is set to 1 minute. Determine what is
causing the instability without adjusting this interval.

Task 4

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model based on
your hypothesis until a stable computation is achieved.

Questions

At what time step and at what location did the program begin to go unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved?

P-06( 188-07)/2007IGWB 5



,..-

•

•

•



•

•

•
ssP/eTA

ADVANCED FEATURES For
.UNSTEADY FLOW With

HEC-RAS

Cameron Ackerman, P.E.

3.3 L-08

1



Objectives:
.- -

• Mixed/Supercritical flow for Unsteady
Flow

• Pumps for Unsteady Flow
• Dam Break and Levee Breaching for

Unsteady Flow

~ Hydrologic Engineering Center

OBJECTIVES:

To know how to turn the mixed flow option on and be able to adjust the
accuracy/stability parameters.

To know how to enter pump data for unsteady flow.

2

3.3 L-08

•

•
To learn how to enter and model Dam Break and Levee Breaching for unsteady
flow.

ssP/eTA 2
•



• Mixed/Supercritical Flow

EIe 1:1>""" HOp
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r:-:-::----:-;c--;;------,

3.3 L-D8

When the mixed flow option is checked, the program will modify the unsteady flow
equations. This can increases model stability when there is subcritical flow,
supercritical flow, hydraulic jumps, and/or draw downs (sub to supercritical
transitions). This option should only be selected if you actually have a mixed flow
regime situation.

•

•

~ Hydrologic Engineering Center 3
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Local Partial Inertia (LPI)
Technique--- ",_.,
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~ Hydrologic Engineering Center
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The methodology used for mixed flow regime analysis is called the Local Partial
Inertia (LPI) solution technique (Fread, 1996). When this option is turned on, the
program monitors the Froude number at all cross section locations for each time
step. As the Froude number gets close to Ft (which has a default value of 1.0), the
program will automatically reduce the magnitude of the inertial terms in the
momentum equation (the terms in the large bracket on the top equation). Reducing
the inertial terms increases the model's stability. When the Froude number is equal
to or greater than Ft (1.0), the inertial terms are completely zeroed out and the
model is reduced to a diffusion wave routing procedure. For Froude numbers close
to Ft (1.0), the program will use partial inertial effects, and when the Froude number
is low, the complete inertial effects are used. The reduction factor for the inertial
terms is the power function shown in the lower equation where:

cr = LPI Factor to multiply the inertial terms by.

FT Froude number threshold at which the factor is set to zero. This value

can range from 1.0 to 2.0 (default is 1.0)

Fr = Froude number.

m = Exponent of equation, which changes shape of the curve. This exponent

can range between 1 and 128 (default value is 10).

ssP/eTA

3.3 L-08
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• LPI Filter

3.3 L-D8

E:-;ponent for Froude number ,eduction factor m(m>O):

Froude number threshold for eliminating acceleration terms:

.-~~ ~ --« - ~ «~« -

Unsteady Mixed FlowOptions*,,",,~,%

The above figure shows the LPI reduction versus Froude number for various values
of m (for the graphical illustration, the Froude threshold is at 1.0). For the default
value of m = 10, there is only a 10% reduction at a Froude number of 0.8 and a 30%
reduction at a Froude number of 0.9. From there the reduction quickly approaches
100% at a Froude number of 1.0.

•

local Partial Inleria Filler

1 0 ~=-----~-.;::--""""
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Froude Number

OK

~ Hydrologic Engineering Center

-m-t

-m=2

m=.c
.. m-a

-m-=10
-m-32

'--'m=04

-m"'128

Cancel

• Larger Exponent &
Threshold:

• Greater Accuracy

• Less Stability

• Smaller Exponent &
Threshold:
• Greater Stability

• Less Accuracy

5

•

The diffusion wave model (l00% reduction of the inertial terms) generally produces
good results for steep streams. An example from Henderson's Open Channel Flow
(1966), for a stream with a bed slope of 26feet per mile, found that the inertial terms
were typically less than 1% of the value of the gravitational tenus. Fread (1996) has
reported generally small errors for the flow hydrographs with the use of the LPI
technique, typically less than 2%. Errors reached the 4-6% level for very rapid
dam-failure in channels of flat slope (for earth dam failures the unknowns of breach
size and growth would produce much greater uncertainty, see later discussion).

The next graphic compares an HEC-RAS steady flow run (dotted lines) with an
unsteady (but constant) flow run (solid lines). For the steep reach at the upstream
end, the water surfaces and energies match closely. The unsteady flow has a drawn
out hydraulic jump.

SSP/eTA 5



Unsteady/Steady Flow
Comparison

3.3 L-G8
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This may actually be a better representation since the steady flow assumption of the
jump happening entirely between two adjacent cross sections is unrealistic when the
cross sections are closely spaced. However, in the vicinity of the hydraulic jump
the inertial terms can be quite large (rapid change in velocity with respect to
distance), so the water surfaces in this region should be regarded as approximate at
best. The subcritical region in the middle has a very good match. The unsteady
flow dips back down to supercritical flow more quickly than the steady flow run--it
even shows a slight rise in energy. The steady flow answer is more realistic. For
the rapidly changing velocities associated with the draw down, the inertial terms are
again significant (but ignored). Furthermore, the unsteady flow momentum
equation may be slightly under computing the values associated with the quick
contraction in flow area.

For more discussion see:

Mixed Flow Plan: 1) UNSTEADY FLO
Mixed Reach Mixed Reach

__ .-- .... -----------"---.".---------./' ~ r/'
~I -------- /

j - (

~
~ HJ-'_'_;;;I'- _.. ;;:1 ••• __ •••• :;1 -_ ••• _.

2) Mixed

·1

6
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Fread, "An LPI Numerical Implicit Solution for Unsteady Mixed-Flow Simulation",
ASCE North American Water & Environmental Congress, 1996.

U.S. Army Corps of Engineers, 1993. River Hydraulics, EM 1110-2-1416

U.S. A.C.E., 1993. Flood-Runoff Analysis, EM 1110-2-1417

SSP/eTA
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• Mixed Flow Considerations
-=

3.3 L-08

Even though the diffusion routing technique may have acceptably small errors for
steep streams, it is not necessarily the best choice. Steep streams tend to have
relatively little storage and less attenuation of the flood hydrograph than mild
streams. In this situation, there may be little justification for the additional data and
stability problems inherent in an unsteady flow model. A steady flow analysis may
give comparable (or even better) answers with far less work.

•

• SUBCRITICAL

• For a model that is
primarily Subcritical,
Mixed Flow option
can improve
stability.

~ Hydrologic Engineering Center

• SUPERCRITICAL

• For a model that is
primarily Super
critical, unsteady
flow less important.
Steady flow analysis
may be preferable.

7

•

Where the mixed flow option is most useful is in subcritical models that have short
sections of supercritical flow. Without the mixed flow option, in order to maintain
stability, the user would have to arbitrarily change the data in order to keep the
flow subcritical.

For the mixed flow option, the user should choose the largest values of F t (Froude
Threshold) and m (the exponent) that allow the model to maintain stability.

Model stability may require more than just the mixed flow option.

ssP/eTA 7



Mixed Flow Stability
.r- ---

• Mixed Flow Not a Panacea

• Cross Section Spacing

• Time Step

• Stability
• Consider Rating Curve to "Drown Out"

Supercritical Flow

3_3 L-08

•

The mixed flow option does not guarantee that supercritical stretches will be stable.

Itml Hydrologic Engineering Center 8

•In areas that have rapidly changing depths and velocities, it is important to have
close cross sections spacing. This includes the region upstream of critical depth
(before the flow goes supercritical), the supercritical region itself, and the
downstream hydraulic jump, if any.

In addition, a short time step may also be required.

A rating curve at a normal cross section is a feature added for version 3.1.2.

For a short and steep reach section, a rating curve can be used to "drown out" the
supercritical flow. This may be useful in solving stability problems.

To do this, choose a cross section at the downstream end of the supercritical region.
Make a copy of this cross section and put this new cross section immediately
upstream of the existing cross section so that they are only a short distance apart
(i.e., one foot). Add a rating curve to the upstream cross section (from the cross
section editor, go to "options" and choose "add a rating curve"), by entering a series
of flows and the corresponding water surfaces.

ssP/eTA 8
•
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Rating Curve for Stability
_.__•••_. ._••_ •••••_ ••••••••••••_ •••••••••••••• ••••H ••••••••
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,.. ......

lill

Care (and some experimentation) should be used in developing the rating curve. A
higher rating curve will generally be more stable. However, a higher water surface
could affect the results further upstream. For the profile on the right, the water
surface almost touches critical depth. This should have minimal, if any, effect on
the results further upstream. Steady flow experimentation may be quicker.

As an additional new rating curve option, the user can select the "Headwater
Check" box on the rating curve. If this is done, the program will check to make
sure that water surface in the upstream cross section ("headwater") is at least as high
as the water surface in the downstream cross section ("tailwater"). If the rating
curve returns a water surface lower than the tailwater, the program will ignore it and
instead it will use the downstream water surface (because this water surface is
"horizontally projected," as opposed to being computed, it is important that the two
cross sections be identical and close together). This is useful if the water surface
does not pass through critical depth at higher flows, such as the profile on the left.
To do this, add additional points on the rating curve for high flows, but put in
arbitrarily low water surfaces (tlote: the program will extrapolate the rating curve,
so make sure large enough flows are entered in the table!)

Concerns: the water surfaces in the formerly supercritical region are obviously
"fake," but make sure that any region that is affected upstream is not used as an
"official" water surface; the location of the hydraulic jump is no longer apparent
in reality the supercritical flow may continue downstream of the rating curve; short
cross section spacing, a short time step, and even mixed flow may still be required.

ssp/eTA
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Pump Stations
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To add a pump station, first click on the pump station button on the top row. Next,
by clicking on the schematic, a pump station can be added wherever desired. When
a pump station is added, the GUI will ask for a pump station name. After typing in
the name, the pump station data can be entered by clicking on the pump station
button on the left hand side and choosing the appropriate pump station from the list
(if the geometry has more than one pump).

ssP/eTA

3.3 L-08
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• Pump Station Data Editor

3.3 L-08

Pump StdhOl'I Odta Editor _
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• Set Connection info
• Add Distance DIS if

pump Inlet/Outlet not
at exact cross
section

• Optional On-Off
Reference

• Optional Highest
Elevation in Pump
Line

By clicking on the <SET RS> buttons or the <SET SA> buttons, the pump can be
connected from a cross section or storage area and then to a cross section or storage
area. If the pump inlet or outlet is not located right at a cross section, a distance
downstream can be added. The program will take this distance into account when
computing the appropriate headwater or tailwater.

•
~
t;:.;.:JJ Hydrologic Engineering Center 11

•

By default, the water surface at the inlet of the pump ("Pump From" location) is
used to trigger the pump control (see next slide). The option "On-Off Reference"
can be set to monitor an alternate water surface for triggering the pumps.

If the pump has a minimum elevation it has to pump to, the optional Highest
Elevation in Pump Line can be entered. The program will use this elevation or the
tailwater, whichever is greater, when computing the head that the pump has to pump
against.

ssP/eTA 11



Pump Group Data
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A pump station can have multiple pump groups and each pump group can have
multiple pumps. (This is analogous to how gates and culverts are organized.) All
the pumps in a pump group must have the same Pump Efficiency Curve. Each
individual pump can have its own water surfaces for turning on and off.

~S!""N""" 11'\111>1 J (!][!J R..... I'\II1>SI"" I
PuooComediooO~. I'\II1>G.~o~.1

s."'!'N_IG"",I\ J~~~

~ Hydrologic Engineering Center

• Pump Efficiency
Curve for each
Pump Group

• Multiple Pumps
within each Pump
Group
• Same Pump Curve
• Different pump-onl

pump-off water
surfaces

12
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• Advanced Control Rules
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3.3 L-D8
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Clicking the <Advanced Control Rules> on the pump editor brings up the above
editor.

The rules narrow the range of flow that is allowed from the pump by applying
conditional max and min flows.

Rules are added by clicking the <Add New Rule> button and then selecting the rule
type (next figure).

The first rule is always applied. It puts a maximum of 500 cfs from the pump. So
the pump will never pump more than this amount.

The second rule (highlighted rule in figure) only applies in the month of January
and only if the WSEL in storage area STO #1 is above 100 ft. If both of these
conditions are met, the pump will have a minimum flow of 100. As currently
programmed, this 100 cfs is a true minimum. Even if the pump curve shows that
the pump can't pump this much based on current head, the pump will still have a
minimum flow of 100 cfs.

The third rule lowers the maximum flow to 200 cfs if the flow at river station 1 is
lOO cfs or more.

The fourth rule lowers the maximum flow to 300 cfs if the stage at river station 0 is
95 feet or more. If the maximum is already at 200 cfs (because of rule 3), then this
rule has no effect. It won't override a maximum limit computed by previous rules .

•

•
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17th Street Pump Station
Hydrograph
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• Dam & Levee Breach
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A dam breach can be performed on an inline weir and a levee breach can be
performed on a lateral weir. The breach editor can be accessed from either the
unsteady flow analysis editor or by clicking the breach button on the inline or lateral
weir editor. It is usually more convenient to just click on the button on the
appropriate geometry editor, but the user should keep in mind that breach
information is stored with the plan data not the geometry data. For instance, to
compare a "breached" with a "not breached" run, the project should have two plans,
but they can (and in many cases should) have the same geometry.

•
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The dam breach data (next slide) is as follows:

Breach This Structure - This check box is used to decide if the program will
perform the breach or not. This box was added to allow the user to tum certain
breaches on or off, without loosing the user entered breach information.

Center Station - The centerline stationing of the final breach.

Final Bottom Width - The bottom width of the breach at its maximum size.

Final Bottom Elevation - The elevation of the bottom of the breach after it has been
fully developed.

Left Side Slope - This is the left side slope of the trapezoidal breach.

Right Side Slope - This is the right side slope of the trapezoidal breach.

ssP/eTA 15



Dam Breach Data
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Full Formation Time (hrs) - The breach development time in hours.

Failure Mode - This option allows the user to choose between two different failure
modes, an Overtopping failure and a Piping failure.

Piping Coefficient - If a piping failure mode is selected, the user must enter a piping
coefficient.

Initial Piping Elev. - If a piping failure mode is selected, the user must enter an
initial piping elevation.

Trigger Failure At - This field is used to select one of three trigger methods for
initiating the breach. The three trigger methods are a water surface elevation, a
specific time and date, and a water surface elevation plus a duration.

Starting WS - If the user selects water surface elevation for the failure trigger mode,
then this field must be entered. This field represents the water surface elevation at
which the breach should begin to occur.

Start Date - If the user selects a starting date and time as the failure trigger mode,
then this field must be entered. This field is used to enter the date at which the
breach will begin to occur.

Start Time - If the user selects a starting date and time as the failure trigger mode,
then this field must be entered. This field is used to enter the time at which the
breach will begin to occur.

~ Hydrologic Engineering Center 16
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Threshold WS - If the user selects water surface elevation plus duration for the
failure trigger mode, then this field must be entered. This field represents the water
surface elevation at which the duration is triggered ("the clock starts ticking").

Duration above threshold - If the user selects water surface elevation plus duration
for the failure trigger mode, then this field must be entered. This field is used to
enter the amount of time that the water surface must be above the threshold for the
breach to begin. In the above example, if the water surface is higher than 660 feet
for 2 hours, then the breach will be triggered.

Immediate initiation WS - If the user selects water surface elevation plus duration
for the failure trigger mode, then this field must be entered. This field is used to
enter a water surface at which the breach will immediately begin to occur
(regardless of the amount of time).

•
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Note: once the breach has been triggered, it will continue to grow even if the
water surface drops below the invert of the breach. The breach will reach its
maximum size, based on the formation time, regardless of the hydraulics.

The original cross section shape does not limit the maximum size of the breach.
The breach will reach the full size as entered by the user (and outlined in red on the
plot) even if this is below (or past the edge) of the cross section.

ssP/eTA 17



Non-Linear Breach Growth
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By clicking on the <Breach Progression> button, the above editor will be shown.
By default, the breach growth is assumed to be linear from start to maximum size
(Full Formation Time). However, a non-linear breach growth curve can be entered.
This is done by entering a Time Fraction (from zero to 1.0) and a Breach Fraction
(from zero to 1.0). The user-entered data is plotted in the graphic next to the table.
The breach progression curve is then used during the breach formation time to
adjust the growth rate of the breach.

~
~ Hydrologic Engineering Center
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•
In addition to adjusting the curve in order to have a more realistic breach growth,
the curve can sometimes be used in order to improve stability. If the program is
having stability problems during part of the breach growth, the rate of growth
during that time can be reduced by adjusting the curve.

ssP/eTA 18
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A piping breach starts out as a point-at the centerline station and elevation as
specified by the user. Its growth is modeled as a rectangle.

•

•

Breach Growth Geometry

lIZ)] Hydrologic Engineering Center 19
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When the top of the piping breach is greater than the water surface, it is assumed
that the levee sluffs and the breach is modeled as an open breach. The side slopes
are gradually increased until they reach the user specified values.

SSP/eTA 19



Levee Breach Data
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This option is very similar to the Dam Break option described previously. The only
difference is that the breaching is performed on a levee. The options and data
entered to describe the breach is the same as a Dam Break.

~ Hydrologic Engineering Center 20

•
In order to use this option, the user must first define the levee as a lateral weir
within HEC-RAS. The lateral weir profile is used to describe the top of the levee
along the stream both at and between the cross sections. Second, a weir coefficient
is entered for calculating the flow that may go overtop of the levee if the water
surface gets high enough. Entering breach data for the levee can be accomplished
from the lateral weir editor or from the Levee (lateral weir) Breach option from
the unsteady flow simulation window. The levee breaching data is stored as part of
the unsteady flow plan file, just as it is for a dam break. When the levee breach
option is selected, a breach editor will appear as shown above.

The information entered in the fields is the same as for a Dam Break.

A levee breach can grow vertically below the level of the original cross section.
However, (unlike a dam breach) it cannot grow horizontally past the edge of the
original lateral weir. Again, the red outline will show the final shape of the breach.

•
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A levee repair option is available by clicking on the <Breach Repair> button, Enter
the number of hours after, the breach has fully formed, that the repair is to start.
The total time for repair to take place and the elevation that the breach is repaired
to. The elevation that the breach is repaired to is shown on the levee breach
schematic (previous slide).

•

•

•

Levee Breach Data
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HEC-RAS Breach Locations •

•
22

Dam
(lnline Structure) .

~Reservoir
---~~--

(Storage Area)

rnJ Hydrologic Engineering Center

The formation of a breach can be simulated in two types of structures: inline and lateral.
The parameters and hydraulic computations for the breaches are the same. A reservoir is
usually modeled as "inline"; that is, its geometry is described with cross sections. This
allows dynamic routing of the flood wave through the reservoir.

Alternatively, the reservoir can be described as a "storage area" for which the geometry is
described by an elevation-volume relationship. Level-pool hydrologic routing within the
reservoir is done for this situation. (See Goodell')

There must be at least two cross sections between the storage area and the dam. The first
cross section is associated with the storage area and the second is associated with the inline
structure that represents the dam. These two cross sections should be large, "reservoir
sized" cross sections.

A lateral structure may be a levee that overtops and does not fail, or possibly fails
(depending on user input data). The levee is connected to a neighboring reach or storage
area.

IGoodell, Christopher R. "Dam Break Modeling for Tandem Reservoirs - a Case Study
using HEC-RAS and HEC-HMS," Presented at the ASCE World Water & Environmental
Resources Congress 2005, EWRI, Anchorage, AK, 15-19 May 2005.

•
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• Estimating Dam Break
Parameters

n •

• USBR Dam Safety Research Report!

• Froehlich (1995b)
• Earth dams

. • MacDonald and Langridge-Monopolis
• Earth dams

• Van Thun and Gillette (1990)

• Breach

3.3 L-08

Determining the size and growth rate for breaches is a very inexact science. The
Bureau of Reclamation's "Dam Safety Research Report," offers an excellent
literature review of the subject (available online).•

lfrZ)] Hydrologic Engineering Center 23
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MacDonald and Langridge-Monopolis developed best-fit and envelope curves for
both breach parameters and peak outflow from breached, earthfill dams as a
function of a breach formation factor.

Froehlich developed a best-fit regression equation for peak flow based on a breach
formation factor.

Breach is a physically based model that uses sediment transport equations.

The use of several different procedures, to get a range of values, is generally
recommended.

Reference:

Water Resources Research Laboratory, "Prediction of Embankment Dam Breach
Parameters", Dam Safety Office, Bureau of Reclamation, 1998.

SSP/CTA 23
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Reference for breach parameters:

3.3 L-08

prl>diction of Emb.nkment O.m
Bre;1Cn P.ut1mtters

A Urerature Review and Needs Assessment

050·98-004

Jii.-sO.....
DAMSAFETY OFFICE

h-,.''''

Hydrologic Engineering Cen~~ rn;m]

•

•Wahl, Tony L., "Prediction of Embankment Dam Breach Parameters - A Literature Review
and Needs Assessment," DSO-98-004, Dam Safety Research Report, U.S. Department of
the Interior, Bureau of Reclamation, Dam Safety Office, July 1998.

(http://www.usbr.gov/pmts/hydraulics_lab/pubs/PAP/PAP-0735 .DSO-98-
004.pdfhttp://www.usbr.gov/pmts/hydraulics_lab/pubs/PAP/PAP-073 5.DSO-98-004.pdf)

•
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• Castle Lake Example
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Breach

Froehlich

Width

480

305

Time

0.25

0.36

Peak Q

1,180,000

761,300

The above example is taken from a study HEC did on a debris avalanche dam that
formed after the eruption of Mount St. Helens.•

M and L-M 25
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0.50 147,600
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•

The MacDonald and Langridge-Monopolis equations probably do not give the most
appropriate results for this situation, since their data did not include any landslide or
debris blockage dams. However, even on a more typical embankment dam, breach
parameters can vary considerably between different methodologies .

ssP/eTA 25



Dambreak Floodwave
Progression
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How important the breach parameters are depend largely on how far downstream
from the dam the study area is located. At the toe of the dam, the computed peak
flow often varies wildly within the assumed limits of the breach parameters.
However, as the study area is moved downstream, the breach parameters have less
and less effect on the flow hydrograph. There are two main reasons for this. First,
the total volume of water in each of the different hydrographs is basically the same
(being the stored water behind the dam). Second, as the hydrographs move
downstream, a sharp hydrograph will attenuate much more quickly than a flat
hydrograph. Hydrographs from different assumed breach parameters can converge
to produce the same peak flow (and for that matter, the same rise and fall) in a
surprisingly quick distance. In the above example (Fread), the hydrographs have
substantially converged within five miles and are indistinguishable by mile 13. It is
still recommended that the user perform a sensitivity analysis on the breach
parameters for all dam break studies.

~ Hydrologic Engineering Center 26
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Levee breaches in general and dam breaks in particular have rapidly varying water
surfaces and flows. Because of this, a small time step is required to maintain
stability and accuracy. Often on the order of a few seconds for a dam break
problem. (See next slide).

SSP/eTA 26
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• Dam & Levee Breach Stability
Considerations

• Small Time Step - Important!

• Appropriate Cross Section Spacing
Downstream of Dam Breach (Courant <1.0)

• Increased Manning's n values just
downstream of Dam

• "Critical" VS. "Total" Breach Time

• Non-Linear Growth usually more accurate
• adjust, if needed

• "Mixed Flow" On (only if needed)

3.3 L-08

Cross sections that are spaced too far apart below a dam break can cause stability
and accuracy problems. However, the Courant condition should be kept close to or
less than one (e.g., if the velocity is 20 feet/second and a ten second time step is
being used, the cross section spacing should be no closer than around 200 feet).

•
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Dam breaks are usually associated with large amount of sediment, debris and
turbulence. The Manning's n value should be increased (particularly at cross
sections near the dam) to account for these affects.

The reported breach time, especially for piping initiated breaches, often includes a
significant period of time when the flow is, relatively speaking, a trickle. This time
should not be included in the "Critical Breach Time" unless the user makes
appropriate adjustments to the non-linear growth time.

If the dam break has stability problems, turning the "Mixed Flow" option on may
help (it may help even if the flow is not going supercritical). This may reduce the
accuracy of the water surfaces, particularly immediately downstream of the dam.
However, this error is usually very minor compared with the error caused by the
unknowns in the breach parameters.
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Example Dam Break Animation
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Getting a dam breach model to be stable can be tricky. However, it is usually
possible with enough adjusting. While close cross sections and small time steps
usually work best, there are occasions when very short cross section spacing and
tiny time steps can make stability worse. Trying a range of parameters is suggested.

580f-.-.......,..-,..,.....~,.......,.....,,~.......~1
o 1000 2000 3000 4000 5000 I

Slation(1I)
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Under the animation option in HEC-RAS, an animation of the profile plot or the
cross section plot can be written out as an AVI.

As a final note on dam breaching, Dr. Gee and Gary Brunner have submitted a
paper for publication, "Dam Break Flood Routing using HEC-RAS and NWS
FLDWAV." In it, they conclude that the computed breach outflow hydrograph is
similar for the two models. The discrepancy being mostly due to the interpretation
and approximation of the river geometry.

•
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DAM AND LEVEE BREAK WORKSHOP

Introduction

This workshop will help students learn how to use HEC-RAS to: enter and edit
dam and levee breach data; perform the unsteady breach run; make adjustments for
stability; and review and understand the pertinent dam and levee breach output.

Problem

For this workshop we will be using the Bald Eagle data set. A project file
(BaldEDmbrk.prj) with the title "Bald Eagle Cr.- Dam Break Run" has been loaded on
your workshop computers.

A dam, located at river station 81500, is being modeled as an inline weir. The
given unsteady flow hydrograph causes the dam to spill during the peak flows. For this
flood event, a piping breach will be added. The floodwave from the dam failure causes
the downstream levee to be overtopped. A lateral weir overtopping breach will be added
to the upstream levee section, and then the lateral weir will be partly rebuilt using the
levee repair option.

Students will be required to add the dam breach to the inline weir. The stability
and accuracy of the resulting breach should be checked and any minor modifications
performed. Next, the downstream lateral levee breach should be added. The following is
a summary of the required tasks for each group:

1. Open the project, open the current plan and then save the plan with a new
name (use the "save as" command). Give the new plan a descriptive name such as, "Dam
Break."

2. Enter the dam break information, save the plan data, and perform the
unsteady flow computations.

3. Review the results.

4. Save the current "Dam Break" plan with a new, descriptive name such as,
"Dam Break lOs."

5. Change the time step, save the plan, and perform the unsteady
computations.

6. Review the results.

7. Save the current "Dam Break lOs" with a new, descriptive name such as,
"Dam & Levee Break."

Dam Break Workshop 1
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8. Add the levee break information, save the plan data, and perform the
unsteady computations.

9. Increase the length of the time window, save the plan data ("Long Run"),
and perform the unsteady computations.

10. Add the levee break repair data, save the plan data ("Levee Repair"), and
perform the unsteady computations.

11. Review the results.

Tasks

1. Create a new plan.

Open up the unsteady flow analysis editor. Under the File menu, choose "Save Plan
As ... " and save the plan with a new name. This plan will contain the dam break
information. Use a descriptive name for the plan and for the short id.

2. Enter the dam break information.

The inline weir representing the dam is located at river station 81500. The dam break has
the following characteristics:

•

•
Center Station
Final Bottom Width
Final Bottom Elevation
Left Side Slope
Right Side Slope
Full Formation Time
Failure Mode
Piping Coefficient
Initial Piping Elevation
Trigger Failure at
Starting Water Surface

= 4200 ft
= 400 ft
= 592 ft
= 1
= 1
= 3 hrs
= pIpmg
= 0.6
= 620 ft
use water surface
= 664 ft

After the dam break information has been entered, save the plan.

3. Perform the unsteady flow simulation (with the original time step) and review the
results.

Both the profile plot and the cross section plot can be animated to show the changing
water surfaces with time. By choosing the inline weir cross section plot (river station •
Dam Break Workshop 2
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81500), and clicking on the animate button (the right arrow symbol), and then clicking on
play, the changes in the water surface and the growth of the dam breach can be seen.

4. Create a new plan and then compute the dam break with a ten second time step.

Under the File menu, choose "Save Plan As... " and save the plan with a new name. This
plan will contain the dam break information and it will be run with a ten second time
step. Use a descriptive name for the plan and for the short id.

5. Perform the unsteady flow simulation and review the results.

Compare the results of the dam break with the ten second time step to the previous dam
break results. This can be accomplished by clicking on the stage and flow hydrograph
button (on the main HEC-RAS editor) and then choosing inline weir under type.
Alternately, left click on the inline weir on the geometry editor (this may require zooming
in) and choose plot stage and flow hydrograph. Under the options menu, choose plans
and then select the two dam break plans (the current 10 second dam break plan and the
previous dam break plan).

6. Save the plan with a new name and add the lateral weir levee breach.

At the downstream end of the reach, the levee is composed of 3 separate lateral weirs.
Add a levee breach at the upstream lateral weir (river station 32100) with the following
characteristics:

•

Center Station
Final Bottom Width
Final Bottom Elevation
Left Side Slope
Right Side Slope
Full Formation Time
Failure Mode
Trigger Failure at
Starting Water Surface

7. Review the results.

Dam Break Workshop

= 700 ft
= 500 ft
= 558 ft
= 1
= 1
= 5 hrs
= overtopping
use water surface
= 579 ft
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8. Create a new plan with a longer time window. The simulation will now be run until
22Feb1999 at 1200. Increase the computation interval to 1 minute (this is mostly to save
time running the workshop), and run the simulation.

9. Create a new plan ("yet again") and add a levee repair with the following
characteristics:

•
Hours after full breach to start
Total repair time
Final filled in elevation

12 hrs
12 hrs
570 ft

10. Review the results. Compare the water surfaces in the two storage areas with and
without the levee repair option.

11. More detailed output (optional)

If time allows, an additional runes) can be made that has more detailed output. This will
provide a much smoother animation. Save the plan (for the last time!) with a new name.
On the unsteady flow analysis editor, in the Detailed Output Interval: window, change
the time interval to a smaller increment-for instance 10 minutes. After performing the
unsteady flow simulations, open up the profile plot and a cross section plot of the inline
weir and run the animation. •

•
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Questions

1. How does the floodwave hydrograph from the ten-second time step compare to the
original dam break hydrograph? Which do you think is more accurate? What additional
time step checks could be made?

2. How much did the lateral weir breach change the maximum water surface and the
peak flow into storage area STO #2? How much did the levee repair option reduce the
water surface compared to the breach without the repair?

3. Does the data input and the model output both make "hydraulic sense?" What
additional analysis and sensitivity checks could be done for this dam break problem?

Dam Break Workshop 5
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Workshop Solution
Pre-Processing Geometric Data

Tasks

1. View HTAB Parameters and Analyze the Hydraulic Property Table

~
~

The Cross Section Table Parameters were viewed by
depressing the HTAB Parameters button found in the Geometric
Data Editor, located in the "Tools" section. Figure 1 displays
the default parameters. The default parameters are sufficient for
this example because the table extends to the top of each cross section with an
incremental increase in elevation well below one foot.

~ ~~~~~-~~-~ ~ ~ -~ ~

CrQSs~Q" Table Pfo~ties ;; s .' w , w'ili!&W. ill

Logend

Ground
-i'

Le-'t'ee
~

l!!'eft

IL.....9.KJI Cancel I

Cross secbon plot IS tor the CUllent lOW In the table

Beaver Creek Kentwoo<! 5,99m

2'0

4 5.« 203.9 O.::-?- ~

5 5.41 202.7 O.
6 5.39 202.7
75.29 202.8
8 5.13 199.9
9 5.0 199.9

1 5.99 209.9
2 5.76 205
3 5.61 204.4

River IBeaver Creek i3
Reach: IKentwood iJ

C~~;;~~l':~~~F.~~~l-_.s.~~Y~,=:::-L...c~~."~~t_I~~:t.?~~~~JJF- --"'__
RS Chan Min Starf EI Poinl,(20·1 (0)

•

Figure 1 Default Cross Section Table Parameters

Next, (after running the Geometry Preprocessor on the Unsteady Flow
Analysis window) Figure 2 was displayed by selecting View and then
Hydraulic Property Plots from the main program window. As can be seen
from the figure, there is a smooth increase in conveyance as elevation
increases from the channel invert.

•
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•Rle Type View

Geomelry: I-B-ea-v-er-C-re-ek-n-e-ar-K-en-lw-o-od---------3~

River: IBeaver Creek 3 Position: I
Reach: jKentwood 3 RivSta: 1I"'""5.-0---3.!J.!J

'-----
Plol I Table I

Property Table
RS =5.0

•

Con'l. Total

StGrage Area

Conv. Channel

Cony. Overbanlcs
]I

I

60lfSlflf
• i i

40010lf200
iii i ••• i •• , • i i • ,

ConveyanceJ100lf (cIs) Storage (sq fl)

214l

212.1
J

/'

"""'e
c:
0

i
>
Q)

iii

202··t

200--

1001 I

0 100

Figure 2 Hydraulic Property Plot at River Station 5.99

2. Place Levees at Necessary Locations

Levees were placed at the following locations using the Graphical Cross
Section Editor.

River Station
5.99
5.76
5.29
5.13
5.00

Station
866
906
223
358
518

Elevation
214.8
214.3
209.6
209
209

The editor is selected from the Geometric Data Editor under the Tools
menu. In the Graphical Cross Section Editor, Add Levees was selected
from the Options menu.

Levees may also be placed using the Cross Section Data Editor
found in the Geometric Data Editor, located in the "Editors"
section. After depressing the Cross Section button the levees
were added by selecting Levees ... from the Options menu.

I~ Cross

I~~

•
Geometry Preprocessor Workshop Solution 2 GWB/CTA



•
1.3 WS-01

Legend
-----+-
Ground
---e

levee
•Bank Sta

20001500

Plan: Beava Oe:et with Le-v~

1000

St.tion (n)

500

Upstream Boundary Cross section

.1--+-.1~--11" .1~---->Io
4

222

220

218

216..
c 214
.2
16,. 212
"iij

210

208

206

204
0

App!)' lh~ lGa +01 ;PIO:I:QP:lion:s:-.-:~=~=~::.:.r~Kee=p P~rev~XS:..:P.:::Iot.::.s-=c=Ie.=r =Pre=v~l~ _
r======'-'=::::::;~ .!J.!l

lJ

E19t ~dit Qptions p'lot tielp

'4441¥VS!#!

•
Figure 3 Cross Section Data Editor for River Station 5.99

@~~=<_~""'--"_"'oO-""

i~~~"J}ata I

Enter station and elevation points to mark levee
ili .".~ on cross s-edion

Left

Station 1866

Elevation 1214.~

OK Cancel I Defaults

Right

Clear I
Figure 4 Adding Levees to River Station 5.99

After the levees were added the geometry was saved as a new file and the pre
processor was run. Next, the Hydraulic Property Tables were examined.
Figure 5 displays the plot of River Station 5.99 with the addition of the levee.
As seen in the figure, when the levee is overtopped there is an abrupt increase
in conveyance with a small change in elevation. This occurs because RAS is
a one-dimensional model, and as soon as the levee is overtopped the area
protected by the levee is instantaneously filled with water. Viewing Figure 6,
the area instantly filled is from Station 500 to 900, up to an elevation of 214.8
feet.

•
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F"e Type View

Geometry: fimmiijjj
River: IBeaver Creek

Reach: IKentwood

Plot I Table I

T ·Ifni·
::1 Position: I
3 RivSta: 1,....5.,....99---3.:!J.!J Variables .. ·1

Property Table
RS=5.W

IiU3

.-

(

•
2221
220~ ,,' .---~

218: ""<~~
216~··r/'/

~). /
. I

'''''214:

212:

:r
21Q"

208I~~~~-'i"""""~~~---'-i~~~~-'-~~~"-"'~~~~-'i
o 100 200 300 400 500

Legend

Cony. Ctlannel

Conv. Overba nks
)[

Cony. Total

Stor.age Area

Figure 5 Hydraulic Property Plot of River Station 5.99 After Levee Addition

ConveyaneeJ1 000 (efs) storage (sq fl) ..
<Jr------------------------------ .r

file Qptions tjelp

River: P;JiM_i 3~~ I +-1
Reach: IKentwood :3 River Sta.: 15.99 :3 .!.L!,t

Beaver Creek Geometric Data Plan: Beaver Creek with Levees
Upstream Bo,undary Cross section

1+---.1 '" .14--1. I· .14 -Io
4

Reload Data I

legend-----Ground............"j.....
levee

•Bank Sta

•

soo

Figure 6 Cross Section 5.99
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3. Place Normal Permanent Ineffective Flow Areas

Permanent ineffective flow areas were placed in generally the same manner as
the levees. The Graphical Cross Section Editor can be used by selecting
Add Normal Ineffective Area (1 pt) from the Options menu. The default
setting for ineffective flow areas is non-permanent. After the ineffective flow
areas are placed, they need to be changed from non-permanent to permanent.
This was done by selecting Set Ineffective Areas To Permanent Mode...
from the Geometric Data Editor under the Tools menu. The river stations
with ineffective flow areas were selected, as shown in Figure 7.

(5 selected)

5.99
5.76
5.29
5.13
5.0

Beaver Creek Kentwood
Beaver Creek Kentwood
Beaver Creek Kentwood
Beaver Creek Kentwood
Beaver Creek Kentwood

Selected Locations
SelectedLocations~------------~--------..... I

Node Types::J

River: IBeaver Creek

Reach: IKentwood

RS: 5.76
5.61
5.44
5.41
5.39
5.29
5.13

• Clear Selected List I OK Cancel I
Figure 7 Ineffective Areas Changed to Permanent

Additionally, the ineffective flow areas may be added by selecting Ineffective
Flow Areas ... from the Options menu of the Cross Section Data Editor.
This will display Figure 8. To set the ineffective flow areas to permanent, the
box labeled "Permanent" was checked.

r. Normal

Left

r Multiple Blocks
Right

Figure 8 Permanent Ineffective Area

Station r~62.12

Elevation 1214.93

P" Permanent P" Permanent

•
OK Cancel I Defaults I Clear
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Next, the geometry was saved as a new file and the pre-processor was run.
Finally, the Hydraulic Property Tables were viewed. Figure 9 displays the
plot for River Station 5.99. As can be seen from the figure, the addition of the
permanent ineffective area smoothed out the transition of increasing
conveyance with increasing elevation. The permanent ineffective flow area
behind the levee provides a better representation of what is physically
occurring because as the levee is initially overtopped the conveyance in the
overbanks will gradually increase.

• I

File Type View

Geometry: U!4.u4l1!mJrmm;.m~~

River: IBeaver Creek 3 Position: I
Reach: IKentwood 3 Riv Sta: 1""15-9-9---3""1· ..:!J ..!J. Variables ..J

Plol I Table I

Conveyancel1000 (cfs) storage (sq fl)

222
,

-"220
,/,

218

e 216
l

c
0
ii5

214if>
~
w

212:~

210··

20B1 ,
0 200

<.

,
400

Property Ta.ble
RS=5.99

,
600

,
BOO

legend

Cony. Channel

Cony. Overbanks
•

Cony. Total

Storage Area

,
1000

~
I

•
Figure 9 River Station 5.99 After Permanent Ineffective Area

Questions

1. Considering that HEC-RAS is a one-dimensional model, what problems will
occur if a levee is overtopped during a simulation? What options in RAS can
be used to model a levee being overtopped?

Because the program is one-dimensional, there can only be one water surface
elevation. Thus, when a levee is overtopped the water surface level behind the
levee will instantaneously be the same elevation as the water in the main channel.
Of course, this is not actually occurring and must be taken into account when
modeling. To model this phenomenon correctly a permanent ineffective flow area
can be placed behind the levee. The sudden increase in water behind the levee
will be seen by the program as storage, and not conveyance.

•
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Another application would be to place high Manning's n values behind the levee.
The high Manning's n value will hinder conveyance in the same manner as a
permanent ineffective flow area.

2. Are there any anomalies with the conveyance in the overbanks at River
Station 5.29? If so, what is it caused by, and how can it be fixed?

As seen on Figure 10, there is a break in the smooth relationship between
conveyance and elevation. By examining the table it is found that this break
occurs between the elevations of213.9 and 214.5. Next, the cross section
geometry is examined at this elevation. As seen on Figure 11, the right overbank
geometry dramatically changes at this point.

0< ~""~~=~ ~ ~ >;'«~M'~~M"

imtlm1tiYprauliP'nf~l!i![~ +'1%I__;;]&J1/ Vll';'~ .~.

Property Table
RS = 5.29

legend

Conv. Total
,:.. ..

Stor.age Area

C~nv. Chan.nel

Cony. Overbanks
•

~ 210
c:
o
'ii
6)
iii 208

File Type View

Geomelry um'lIlSlMllBMiECH I I 9 ~
River: IBeaver Creek il Position: I
Reach: IKentwood 9 Riv Sta: ....15-.29---..,.

Plot I Table I

•
200

21l4
j

z02+f~~~---r-,~~~---r-,~~~---r-,~~~---r-,~~~-"
o 100 200 300 400500

Conveyancel1000 (cfs) Stor.age (sq ft)
,---------- ---------"---

Figure 10 Hydraulic Property Plot at River Station 5.29

•
In HEC-RAS, the determination of total conveyance for a cross section requires
that flow be subdivided into units for which the velocity is uniformly distributed.
The approach used in RAS is to subdivide flow in the overbank areas using the
locations where n-values change. The program sums up all the incremental
conveyances in the overbanks to obtain a conveyance for the left overbank and
the right overbank.

Geometry Preprocessor Workshop Solution 7 GWB/CTA
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HEC-RAS uses Manning's equation to calculate conveyance. Imbedded in this
equation are relationships for channel depth, channel area, and wetted perimeter.
In this example, when the calculations go just above the elevation of 214 feet,
Manning's equation sees an enormous increase in wetted perimeter for a minute
increase in water depth. The conveyance answer found from this calculation is
dramatically different from the conveyance answer found at the previous
calculation below 214 feet.

•
Eile Qplions tielp

River: Itb''';'. iJ .!-:J(jJ I + 01
Reach: JKentwood iJ RiverSla.:J.--5-.29------3---.....±L!J

Reload Data I

•

legend-----Ground
-a---

levee
--4--

Ineff
•

8s.nk SIs

180()160014.Q012()()

----. ----------~-

• sao 1a()()

SI8tion (ft)

600

Plan: With Levees + Ineffective Areas
River Mile 5.29

1------------.06-----------.1·1

Beaver Creek Geometric Data

200

218

216

214

e: 212

c
0 210ii5
'""W 208

206

204

202
0

Figure 11 River Station 5.29

To account for this situation another subdivision for Manning's n must be added
at the point of discontinuity. The value does not need to be different, as long as
the subdivision is present, RAS will calculate separate conveyances for the
geometry. As seen in Figure 12, a subdivision was added at Station 1024.

Figure 13 displays the Hydraulic Properties Plot for River Station 5.29 after the
subdivision was added at Station 1024. As seen on the figure, this subdivision for
the conveyance calculations smoothed the relationship between conveyance and
elevation.

•
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River: IBe"ver Creek :::::;]~ IE:I I + --I
Reach: IKentwood 3 River St".: 15.293 ... •

1.3 WS-01

Aeio~d D~t~ J

218
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04 --l 0 1
0
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-----Et--
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204

16GO14-0-0:120'01000-
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o
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Figure 12 River Station 5.29 With Additional Manning's n Subdivision

•
File Type View

Geomelry: I'=im;;;;:,....-=:;:]==.==.=.=.=.=,.========.-r ~

River: IBeaver Creek 3 Position: I
Reach: IKentwood :iJ Riv Sta: 1...5-.2-9-----:iJ~.!J.!.I

Plol I Table I
Property Table

RS =5.29

Figure 13 Hydraulic Property Plot of River Station 5.29 After Adding
Subdivision
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3. How does a permanent ineffective area affect storage within the cross section?
When should a cross section be modeled with non-permanent ineffective areas
and when should it be modeled with permanent ineffective areas?

As il1ustrated in Figure 9, a permanent ineffective storage area behind a levee will
quickly add storage to the cross section once the levee is overtopped. If there was
no levee, the area of storage would gradually increase with elevation.

If it is assumed that the entire ineffective area wil1 begin to convey flow once a
particular water surface elevation is reached, then the ineffective area should be
modeled as non-permanent. If it is assumed from the geometry that a particular
area will never convey flow then the area should be modeled as permanent.

Note: If the cross sectional geometry denotes a significant change in storage or
conveyance when a levee is overtopped then this cross section should be altered.
The cross section should be terminated at the levee and the area that was deleted
should be modeled as a storage area. Abrupt and significant changes in storage
and conveyance should be avoided because they can cause instabilities in the
unsteady flow model.

•

•

•
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• Workshop 2 Solution:

Basic Unsteady Flow Modeling Using HEC-RAS

In this problem, the geometric data processed in Workshop 1 will be used

to route a flood event. Unsteady flow data will be defined, a simulation

performed and output will be reviewed.

Workshop Tasks:

1. Open Wrk2.prj. This data represents the data developed in Workshop 1

2. Open the Geometry file. Check the HTAB settings and adjust them, if

necessary based on your Workshop 1 analyses. Save the file.

~
==-..:J

I Cancel I

2000

OK

1000 1500

Slation (11)

vvs 25 yr.-Ground
•Bank Sla

f.;;~i;Et:~IiH;~~~;.·:}. HTab Incr

500

Beaver Creek Kentwood 5.44

220

2oo~~;"""""':"""""';''''''''':-:''':;''';''''~'';:':

o

.,
c

.12
;;
>
j2
UJ

• The HTAB settings, shown below are those established in workshop 1.

•
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3. Open the Unsteady Flow data editor and enter the required data for
processing.

Cancel

.'"'" Flow
(efs)

500

Simulation T,ime
(hours)'
00'00

.. MLlltiplier: I ' .
'",_Plot Data,.'! -=",', OK ,-,

Date

21M 19742400

Time Step Adiustment 0ptions [' 'Critical" boundar\! conditions1·· ._- 'r Monitor this hydr09raph for adjustments to computational time step

Max Change in Flow (without ch,:mging time step): - Jr----I

ay -
2 22May1974 01 00 01:00 730. .~

--------::
3 22May1974 0200 02:00 1404.33
4 22May1974 0300 03:00

.__.-..._--~--_.-::
2477.03 ............._..........._....... ,~:••••••..•••• ··H···.H.•..•_••.••••.••••.H

5 22M ay1974 '0400 04:00 3875. ................J:.. .. ••••••••••••••• ..... ••••••••••• H • .............-

6 22M ay1974 U500 05:00 5502.97
~--_._-_ ...._._-_._.__._---_.._._.__._...

r 22Ma\!1974 0600 06:00 7250.

Min Flow:

'r'Re~dfromDSS beioresimulati~h"

File: 'F;;;;:;:;;'~-:::;;;:~:"'="':";;"""'::::::'::::":'-"""::"'''';'~:'::;'';'';;;';;';;;;;;;;'';;;;====;:;:;';;'=';z;;;;~
Path: I _

The Excelfile was

opened; the column of

flow data was

highlighted and copied.'

The Flow Column in

the data editor was

highlighted and the

copied data pasted into

the table (Ctrl V).

a. Upstream Boundary
is a flow hydrograph.
The data for the

flood is in an excel
file, and is listed in
Hydrograph Table, on
the next page.

•

b. Downstream Boundary is a rating curve. The data are listed in the
Rating Table, on the next page.

•
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InsRow.l·

CancelOKPlot Data

Stage (It)

2 206.09
3 207.26

5 209.3
4 208.47

7 210.25
6 209.83

13 212.02
14 212.25
15 212.47
16 212.6.:..:..8---------t-'--'

._--"--------

8 210.68
'9 210.99

1.0 211.27
,-,-~----------

11 211.5_3 .
12 211.78

r Read from DSS before simulation

File: I
Path: 1'"",-----------------.,

(; Enter Table

The downstream

boundary Rating Curve

was entered into the

Table. An alternative

would be to enter the

data into the DSSfile

and then read itfrom

DSS, using the option

at the top ofthe table.

A zero flow stage was

added at the minimum

elevation to ensure

stage is providedfor

lowflows.

b. Initial Flow
should start with
the first
discharge value
from the flood
hydrograph.

•

•
The initial flow was set to 500 eft, as shown below.

" .

File Options Help

Boundarl' Conditions i:::illii,ai::ciJoditionsJ
Initial Flow Distribution Method

r Use a Restart File Filename: I'
r.- Enter Initial flow distribution

•
River: !Beaver Creek

Reach: It~~ntwood
.. =:]

... ..

.6.pjjly Data I

. Add Multiple.... I
,t.,dd A Flow Chanqe Location I

- I
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4. Set up the Unsteady Flow Analysis. Establish a new Plan, check
Programs to Run, and set the times. What Computational Interval would
be appropriate? Do not forget to select the cross sections for output.

- .,~

Computation Seltings-=;..::.::=.. ::.. ::.:::::;~--'-'-:;--~---~-;:=:==::::::::;1:
Computation Interval: )10 Secot::.±J Hydrograph Output Interval:

r Computation Level Output. Detailed Output Interval:

DSS Output Filename: C:\HEC Classes\RAS Classes\2006 Unsteady F
-~ ~- .. ;>''"''''1,*''''

r Mixed Flow Regime [see menu: "Options/Mixed Fiow Options:.:") Steve

Ic::::::;::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::G.9.f.n.p.~!:~:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::1:
Iindicated at the

beginning and end

ofthe simulation. That is a very small time-step for this flow hydrograph and

absence ofhydraulic structures.

The computation

interval was

initially set to 5

minutes.

However, the

simulation

reported

computational

problems. The

interval had to be

reduced to 10

seconds before

there was a fairly

clean simulation.

Still, maximum

iterations were

•

4. Evaluate the results.

a. Are there model results that suggest problems? What could be
done to improve the solution?

The small computational interval, described above, is an obvious problem.

Generally, shorter time and distance steps should improve the solution.

• Applying the cross-section intelpolation routine can reduce the distance steps.

PS-02(188-08) Unsteady Modeling Solution 4 Brunner, 2007
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stage

Flow

Legend

ERROR
0.116
0.023
0.028
0.047
0.023
0.023
0.024
0.023
0.023
0.023

WSEL
212.40
211.30
212.49
214.85
214.81
214.81
214.81
214.80
214.80
214.80

= 215.33 (ft)
=22May19741200
= 1392B.2~ (efs)
= 22May1974 1200 '"

. ...
=144'i7 /4 r~r.rp.-f!) ,:. ,,~

, , . ~.., .. ;:~

RS
5.76
5.44
5.76
5.99
5.99
5.99
5.99
5.99
5.99
5.99

Peak Stage
Time

Peak Flow
Time
VnllJmp.

Kentwood
Kentwood
Kentwood
Kentwood
Kentwood
Kentwood
Kentwood
Kentwood
Kentwood
Kentwood

Reach: Kentwood RS: 5.29

I
,:· Computation Messages:..·..,..·: ...:...--,..

Maximum iteralions of 20 at:

22MAY1974 01:20:40 Beaver Creek
22MAY1974 01:20:50 Beaver Creek
22MAY1974 01:21:00 Beaver Creek
22MAY1974 01:21:10 Beaver Creek
22MAY1974 01:21:50 Beaver Creek
22MAY1974 01:22:00 Beaver Cleek
22MAY1974 01:22:10 Beaver Creek
22MAY1974 01:22:20 Beaver Creek
22MAY1974 01:22:30 Beaver Creek
22MAY1974 01:22:40 Beaver Creek

~Posl Process .' --._--~-----------,-- ----.."""---IR,ver Beaver Cleek RS: 599 .IReach Kentwood Node Type Cross Section'

I Proftle: 22MAY1974 2400

ISimulation: 14114 •

. .. . .

Plan: May74-Vl River: Beaver Creek

Beaver Creek

. ... ~

g
Q)
01
IX>
Vi

P' PlotStagerv" PlotFlow,r ObsStage r'ObsFlowr Use Ref Stage

Stage Flow] Table l'Ratinq Curve I

Eile Type Qptions t:!elp

River: ... ~I
Reach: i-K-en-tw-oo-d----==; River Sta.: j~1I6~ijjiii••[=:J:J.!J.!J

A review ofthe flow and

stage hydrographs shows

some irregularities at the

lower end ofthe reach.

Shown is the plotfor

section 5.29.

• During the computations
the Messages show Max

iterations at time &

location, along with

ERROR. This indicates a

failure to converge and

the maximum errorfor

that solution.

•

4000

•
209 +-~---.r-~~-~-r----.-.--r-....,.-.---,----.-.,.-----.---,-~~--~~-~~--l-o

2400 0200 0400 0600 0800 1000 1200 1400 1600 1800 2000 2200 2400
I 2~4 I

--I:"'_.===-- =-= .. . . -=---==_-=_-=-__::::.._=-= ....~--- -
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• A review ofthe sections and the hydraulic properties shows the presence of

levees and a sharp break in the conveyance when the levee is overtopped.

b. If time permits, make adjustments and run again.

The Geometry file was
modified to add interpolated
sections with a maximum step
of500 feet. That means that
any channel reach length

~ greater than 500 feet will be
,..........~--:.........;J subdivided by adding

sufficient interpolated
sections to reduce the step to
no more than 500 feet. The
geometry file was saved as a
newfile and a new plan was
run with the modified
geometry.
The interpolated sections
should be carefully reviewed.

Delete Interpolated 'XS's

'l.- '

Decimi3lplaces in interpolated StalElev.
;

Reach:

River.

Cut Line GIS Coordinates---~---""7="=-""'""-----'

.r- Linearly interpolate cut lines from bounding XS's
(only available when boundingXS's are Georeferenced)

~~~.

,~ '.~~@!iSQl~!lpnJ!bY "ReiJcb.. ;:\;:\., ;. r' .,

•
The levee option in the downstream sections did not appear reasonable on the
interpolated sections. Using the Graphical Editor can easily modify this.

•
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• Options

IBeaver Creek SJ 145659. 2~O.08.~r' Persistent Scale

Reach: IKentwood :::J RS: If#.M.:.k-"'il [[ [:::J .!l.!J r Com~~re Geometry Files

Description I. '0 r UpdateCompareXS

Bank Station Tools: ....LBI LB"'I.~ 'Vi ~RBI'RB"'II~'!'4[]dr Merge Cross Sections

1.5 WS-02

I
I
I •

------+1<------.08-----i'j

214-ir----:-'-T--'--T--+-~_7_-~_7_-..+__7_-7-_;_-~-+-

.... I~:] Legend----:---"7--1'7--11 Ground
-8--.. Levee

212 .- , ,-··;·-···;··:······t·-·:-~··,. . , ~ ! ,

~ ::-~:;:t;:~+~r~f±~~4~tt-m &;9.

~ ··-------:··---·---·----.;·-···--·--·~-···-~··-·7--·-~-·----+--~.-- ....~-.---,-.- ..-._~- ...-.~----.--.
LU ,. 1 '" ,---- .. ~---~--- ..,- ._--,"' .. -- .. ----.,--- ... "\---- ...... ----:-.---!'"----~----'7----..,- ... - .. .,----- ----'!'----.----..,-- ... ~-_ .. _-

. •• I

204 +----"--;-.-"*.

202 -.-..-;--.-:---..----

._-~-_.~----+---:~_.._._~---+~. -~-;_.~---

- - - - ~ - - - .. ~ : - -:- - - - .. - - ~ -. - .; ' _.. .. .. - -. i-" -. - ; - ~ - - ~ - .~ - - _.. - .. ~ - - ~ .; .. - -- .} - - -
" I I I---_.__._-_.._._-.-..-_..,._-_._---_.__.__....-........_---_..._-+_._..._._-

I . s.

.,-r--~------._--------------------~~-~-

1Mov~Dbiecls

, ,
;

2000

- --,. - -. - '! -- - - .. - - - - "'t- -.--, ,

15001000

station (ft)

500

•. ~ .. __ .. .l __ .. _ --: .. __ .. _:_ ... __ ... ~ •. ': ..... _ ... _ .'.. _

,. . :.,.:....
.~-~¥ ':: ~~_¥., w~ - -. _~ _ -,. ¥ '! .. ~. ., !- .. ,.. .,_ .. -- "1--.
I' ,'.

200 -1--+'--+---;l--+----+-+--+--+-----+-+---'--+'-+--+--+--........c.--+-----+--+---1
•••• A _ : ••• __ •• ~ .... _ ..... __ •• ' •• _

,
198+-~-~~-~--+-~~-~~-+--~-~~-~-+-~~-~~----i

o

•
The levee location was movedfor the interpolated sections and the geometry

file was Saved As a new file name. The Simulation Editor was set to compute

on a 30-second interval and the Output Locations was set for all Cross

Sections. The simulation was run as a New Plan. The simulation sill showed

some maximum iteration near the end ofthe simulation.

The results were compared to the original simulation. The comparisons for the

two plans are shown below, upper is stage and lower is flow hydrograph. The

lines without symbols are the new solution with interpolated cross sections.

Note the smoother shape at the beginning and end ofthe hydrograph.

•
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River: Beaver Creek Reach: KentVlOod RS: 5.13
214 14000 Legend

Stage -1974+500'

213 12000 Stage - May'74-V1

I Row -1974+500'

(
.~ ..~..........

212 /
Flow-May74-V1

\ 10000
'\

1/
\

211 \\
/

\ 8000

€ \
Ja

<ll
2-

0> 210 "c7l /
\. 0. u::

I \\ 6000
(

209

/
\.

\
/

4000

208 J \
/

\

\

207
"",~ .. -2000

./"';.::..- , "
,;~/ '<'\

''"-

206 0
2400 0200 0400 0600 0800 1000 1200 1400 1600 1800 2000 2200 2400

I 22 Mav1974 I
Time

1.5 WS-02

•

•
c. What was the attenuation in peak discharge?

The Flow and Stage hydrographs are available at any output location. By

looking at the downstream section, one can see the peak discharge. However,

to see the hydrographs at two, or more locations, you need to use the DSS

Viewer. The flow hydrographs are shown for the upstream and downstream

boundary cross sections.

•
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I .' Select highlightedDSS Pathname(sJSelect entire filtered list

IBEAVER CREEK KENTWOOD/5.0/FLOW/01MAY1974/1 HOUR/1974...500·1
IBEAVER CREEK KENTWOOD/5.99/FLOW/01MAY1974/1 HOUR/1974...500·1

87 BEAVE CREEK KENTWOOD .99 FLO
86 BEAVER CREEK KENTWOOD 5.99 IFLOW

Filler FLOW
83 BEAVER CREEK KENTWOOD 15.91333 i FLOW
84!l.~AVERi::RE!.!SKENTWOOD i 5.~!:pj-';--TFLOW -=~_-.-_-+'.:..:..
85 BEAVER CREEK KENTWOOD 15.91333' i FLOW

1.5 WS-02

File Utilties .
Time Windo~·-·"'-·__·_-_·---':"-__··---'-·~"":'-.·----..-.....,...-·-71·.. .
Starling Date: 121M.AY1974 ~. Starting Time: 12.400. .. Clear .1 Num~erof paths: .,r,-.---"40""6

E~ding Date: 122MAY1974 ~ EndingTime:~' Plan Time 1 File Size. .1 970.50KB

DSS File: IC:\HEC C1ass~s\RAS Classes\2006UnsteadyFlow\23WS Unsteady Flow\Data\wrk2soldl::::J .~.

•

PlotlTabulale Selected Pathname[s) Clear Selected List I .Close

•
The Flow Hydrographs for the upstream and downstream locations are selected

and then plotted. From the plot, you can see little change in peakflow. The

table version ofthe display gives the actual values. The values around the peak

were copied to the clipboard and are displayed on the next page.

•

14000

12000

ooסס1

8000
ii)
u.
~
;;:
g
u.

8000

4000

2000

,
0200

,
0400

,
0600 0800

5.0.5.99

I j

1000 1200 1400
22May1974

Time

1600 1800
,

2000
,

2200

Legend

EAVER CREEK KENTWOOO 5.9

BEAVER CREEK KENTWOOD 5.0

2400
I
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• Data
Date

22May1974 11 :00
22May1974 12:00
22May1974 13:00

KENTWOOD 5.0
INST-VAL
CFS
13464.15
13892.84
13865.86

1.5 WS·02

KENTWOOD 5.99
INST-VAL
CFS
13770.00
14000.00
13770.00

5. Add a lateral flow to River Station 5.29. The inflow starts at 25 cfs,
peaks at 250 cfs at noon and subsides to 25 cfs at midnight. Save the
Unsteady Flow file as a new name and run the simulation as a New
Plan. How much and how far did the inflow change the peak profile?

"." '·r.; r River' Beaver'week'Reach: Kentwood RS: 5.29

----
:!r.!t.~.f"J9!J,Q)V:~Hydrqgi4Ph,.. ,i l '."·, ,." ••

IC~::::::::?:~r.e.:~Ct~:s.:?::fi1:~::~~Q:!'.~i!C=::=:::JJ

"I I: '"

The internal boundary

location RS 5.29 was
River IBeaver Creek ::1

added. The Lateral Reach IKenlwood :0:1 River Sta: 15.29 :::J rf:i:ljr~:~:~~~~(J.~Q1iiQ.n.:ro.:~~iii.~1

Inflow Hydrograph ..". .... :,-%;" '~-= ';;;'-~~l '~c-,,:"-;.~.
5t-3ga Hydrograph Flow Hydrograph Slage/F,ow Hyde, Ratihg Cur"e

option was selected. The "crmal Dcpth I Lateral inflow Hydr."' ,- Uniform Lalera! Inflow' I Groundwaler Internol'! I
starting, peak, and 1 T"if.'G'ate Openings 'I ~~~ Cvr;lrolled Gat;;s" . i'''''iq;t'or, d;'"s :l,;rntern. ot;~7sl'ag.a/Flo!Atl

River Reach 'RS IBoundaru Condilion'TuDe Xi, ill!
ending discharge were 1 Beaver Creek Kentwood 5.99 IFlow Hydrographll .

2 Beaver Cleek Kenlwood 5.29

input and the ~3iBe~avieiirciireiiek~oiKi;je~nlw~oiiod~;;;a;;:;ii5~.0__!lIRialilingiiiCiurjve__II'~ .1 ~I

"Interpolate Missing Values" option

was used to fill in the lateral flow

hydrograph. The flow file was saved

under a new name and the unsteady

flow simulation run under a new plan.

•

Time SleD p.diustmenl Options ["Critical" boundary conditions] -...... .._.---.
- Monitor this hydrograph for adjustments to computational time step

,..-----
Max Char,ge In Flow (wltho')t c:hang.;"g rirf,e ,~Iepj

(. Enter Table Dala time interval: 11 Hour i1
,Select/Enter the Data's Starting Time Re,ff~e~renQfc~e==::--....-...----..:.-;::::::::=::.j
I(. Use Simulation Time: Date: 121 MAY1974 Time: 12400

ir Fixed Start Time: Dale: I ~ Time: .r--

1_1:..j_.=..21:..::.M~ay!:..:.19::::,72.4.=:24~00:::........j__~00::.::0~0_~25.
1--...:2=-1_.::.:22=.::M~a.\!:..:.'19~72.4 ~01~00~.__:=..01:..:.:::0~0_~43. 75
1.......:3:.j_.=.:22::..;M""aYc..:.19:c,7...:...4.=.:°2:=:°0"--1__.::.:°2:;.::0:::,0_----4 6.2..5. _ _ .
1_4'-1_.=.:22::..;M""aYc..:.19:c,7...:...4.=.:°3:::,0°"--1__.::.:°3:;.::0:::,0_----4 ?!..c?.5.._ _ _._.. _ .
1.......:5:.j_.=.:22::..;M""aYc..:.19:c,7...:...4.::..°4:::.°°"--1__.::..°4:.:.::0:::,0_----4 !.90:... .._..._.__ .
1.......:6:.j_.=.:22::..;M""aYc..:.19:c,7...:...4::::::°5:=:°°"--1__=°5:;.::0:::,0_----4118. 75

Ids)
Laterall nflow

(hours)
Simulation Time

Multiplier:

Interpolate Missing Values I Del Row J Ins R'ow I
- ... _... _._..... _.._..._.

Date

No. Ordinates I

Min Flow:

Theflow is added below RS 5.29, so the

largest change will be seen at the cross

section immediately downstream, as

shown in the hydrograph plot on the

next page. (Stage is the upper plot and

flow, the lower.) Although, there is

some increase in stage both upstream

and downstream fi'om the addedflows,

• as shown in the Profile Summary Table.

Plot Data OK Cancel
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1.5 WS-02 .

River: Beaver Creek Reach: KentlMlod RS: 5.13• 214.0 16000 Legend,
15500 8tage - 74 ftd+LatQ,
15000

8Iage-1974+500'

213.5
_....... .........-
Flow - 74 fld+LalQ

14500 ..........._...................
Flow - 1974+500'

.......•.......-.
14000

§: 213.0
/" ........ , ..~...-......... ~

//.,- ~
<ll

'".~ 13500 "0> //m 0

./
II:

/~ "".,,,, 13000

212.5 II ~'\\ 12500
II , ;,

11 , 12000, '
\\

212.0 .. , 11500
// \''/ ,\

0800 1000 1200 1400 1600 1800
5/22/1974

Time

River: Beaver Creek
River Sta Profile Plan Q Total W.S. Elev

Reach: Kentwood
(cfs) (ft)

Kentwood 5.99 MaxWS 74 fld+LatQ 13998.08 220.02
Kentwood 5.99 MaxWS 1974+500' 13996.17 220.02

Kentwood 5.76 MaxWS 74 fld+LatQ 13979.83 217.60
Kentwood 5.76 MaxWS 1974+500' 13979.92 217.59

• Kentwood 5.61 MaxWS 74 fld+LatQ 13970.57 216.87
Kentwood 5.61 MaxWS 1974+500' 13970.59 216.85

Kentwood 5.44 MaxWS 74 fld+LatQ 13966.35 216.27
Kentwood 5.44 MaxWS 1974+500' 13964.36 216.25

Kentwood 5.41 MaxWS 74 fld+LatQ 13961.93 215.72
Kentwood 5.41 MaxWS 1974+500' 13960.62 215.69

Kentwood 5.39 MaxWS 74 fld+LatQ 13961.86 215.66
Kentwood 5.39 MaxWS 1974+500' 13959.83 215.62

Kentwood 5.29 MaxWS 74 fld+LatQ 13960.82 215.25
Kentwood 5.29 MaxWS 1974+500' 13957.66 215.20

Kentwood 5.13 MaxWS 74 fld+LatQ 14202.10 213.86
Kentwood 5.13 MaxWS 1974+500' 13954.69 213.82

Kentwood 5.0 MaxWS 74 fld+LatQ 14201.54 212.71
Kentwood 5.0 MaxWS 1974+500' 13953.62 212.67

•
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•
2.2 WS-03

Workshop Solution
Modeling Bridges with Unsteady Flow

Tasks
1. Enter the Bridge Information

The bridge is located at river station 5.4 of Beaver Creek. The Bridge
Design Editor can be used to enter the deck and road embankment and
the pier data.

The Deck/Roadway and Pier data are entered in the Design Editor.

Bounding X Internal Bridge Cross Sectiof'l~<. <

11<~;~~!..11 Momentum Equation ...

~".,,"''"' - ~= """ '"

HEC-RAS

CancelOK

Enter anew river station 1m the nev·
bridge or C1.dvert in re.3c.h

·~(enli.oIJood"
Copy Bridge/Culvert .

Rename River Ststion .

Delete Bridge/Culvert .

River:

Description

Reach:

•

•

• Road embankment is at a constant
elevation of 216.93 feet.

• The bridge low chord is at elevation of
215.7 feet.

• The bridge opening has vertical walls
at 450 and 647 feet.

• The bridge has 9 piers. The piers are
1.25 ft. wide each and have a square
nose. The piers are spaced 20.0 ft.
apart on center, starting with the first
pier at station 470.0 ft.

• The bridge deck is 40 feet wide, and
the upstream side of the bridge deck is
30 feet from cross section immediately
upstream of the bridge.

-----~,.,.=-",=~ -,*,"",,,-~- - .. '" ~-~

I!ddge Design Editor

- Deck/R oadway
EI of High Chord (Top of Road) 1216.93

EI of Low Chord 1215.7

W Add Vertical Walls in Deck
Opening Width (B lank for Chan)1197

r Add Sloping Abutments
Side Slope I'H : 1V

MakeDeck/Roadway I
~Piers

Number of Piers 19

Upstream XS Starting Station 1470

Downstream XS Starting Stalion 1470

Pier Centerline Spacing 120

Pier Width 11.25

Make Piers I
Close I

Bridge Modeling Solution 1 VRB/GWB/CTA
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•

Jneff
•BanJ. Sta

20GO

20GO

lSGO

1S0G

10GG

1000

Station (ft)

RS=SA Downstream (Bridge)

2.2 WS-03

R~5.4 Upstream (Bridge)

SOO

SGG

Appf)' Dct;'!.. I~

=::r RiverSta.: 15.4 =::r .!I.!I
D

5.39 . 'Distance between: 100 (It)

Description

Bounding XS 's: 5.41

Deckl
Roadway 225

~ 220
Pier g

i c 215
0
:g
'" 210

Sloping ~

Abutment w

.~
205

Bridge
ZGG

Modeling
G

Approach

Cuillerl 225
V 22G
Multiple g
Opening c 215

0
Analysis :g

21G'"'"HTab iii

PClIllm.
2G5

200
Bridge 0

Design

~ ~ ~ ~

II)~Roadway DaU': i;gjtp[

U sheam DOINnstream

The Deck Distance must be
entered and the location ofthe
abutments and other roadway
data should be checked to ensure
they represent the bridge
correctly. Check the pier data
too.

Del Row

Ins Row

Station
1 o.
2 450.
3 450.
4 647.
5 647.
6 1850.
7

Station
o.
450.
450.
647.
647.
1824.

high chord low chord ..
216.93 202.7
216.93 202.7
216.93 215.7
216.93 215.7
216.93 202.7
216.93 202.7

R

•
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~g~,Mooeling Approach Editor
•

2.2 WS-03

Select a bridge modeling approach for both low flow and high flow.
Enter the necessary coefficients for the selected modeling
approaches.

~ Copy I~ Bridge II I~~ .!.I.!J
, Low Flow Methods'

Use Compute
r ~ Energy (Standard Step)

r r Momentum Coef Drag Cd I"~
r r Yarnell (Class A only) Pier Shape K I"~
r r WSPRO Method (Class A only) WSPRO Variables I
to Highest Energy Answer

Multiple methods can be used
initially; however, a single method
should be selected prior to unsteady
flow modeling. Based on previous
modeling with this data, the shown
combination is the best choice for
this bridge.

High Flow Methods
r Energy Only (Standard Step)
to Pressure and/or Weir

Submerged Inlet Cd (Blank for table)

Submerged Inlet + Outlet Cd

Max Low Chord (Blank for default)

f;=I ..

OK Cancel Help

Also, remember to add ineffective flow areas at the cross sections
that bound the bridge. SAVE THE GEOMETRIC DATA.

Select Ineffective Mode

I~~ffect;ive«n!, Areas

Select set of bridge coefficients to Edit

ClearDefaults I

Left

1420

1216.5

(" Multiple Blocks
Right

1677

1216.5

r Permanent r Permanent

Cancel IOK I

r. Normal

Station

Elevation

Version 3.1.3 provides for direct
access to the effective area option
for the bounding sections. The
initial model applied the Normal
Effective Flow option, laterally
offset from the abutment locations
based on a rapid contraction and
expansion offlow in the vicinity of
the bridge. The elevation for the
ineffective areas was set to just
below the top ofweir elevation.

•

•
2. Compute Steady-flow Water Surface Profiles

Once you have saved the geometric data, create a new steady flow
plan. The steady-flow file is set for three profiles: 5000, 10000, and
14000 cfs. Give the plan a title and remember to enter a short 10 for
the plan, and save the data.

Bridge Modeling Solution 3 VRB/GWB/CTA



2.2 WS-03

.J

3. Review The Results •Review the results to ensure that the computed water surface profiles
are reasonable. Make necessary adjustments to the model.

The Bridge Comparison table shows thatfor the 1974 flood event the
pressure/weir ow solution was used.

E~e Qptions 2td. Tables ~ocations !jeIp

Reach River Sla Profile

Kentwood 5.4
Kentwood 5.4
Kentwood 5.4

PF1
PF2
1974 flood

217.51; mm'~;;~J_.__._m....

Eile Qptions ~td. Tables bocations tlelp

. HEC-R.6.S Plardnit Brid e River: Beaver Creek Reach: Kentwood

Reach River Sta Profile E.G. US. Min EI Prs BR Open Area PrsOWS
(ft) (ft) (sQ It) (It)

Kentwood 5.4 PF 1 213.45
Kentwood 5.4 PF2 215.65 215.70 1600.36
Kentwood 5.4 1974 flood 217.24 215.70 1600.36

Q Weir Delta EG
(efs) (ft)

022
0.47

B14." 1.44
•

Check the cross sections around the bridge. The Six XS Bridge table shows
that there was more overbankflow in the upstream ofthe bridge than
downstream. This may be a result ofthe ineffective flow options being off
upstream and turn on downstream. Also, the overbankflow at the upstream
section is ar eater than weir ow.

Eile Qptions 2td. Tables !.ocations !::!elp

• HEC-RAS Plarr In~ Sr e River: BeaverCreek Re<lch: Kentwood Profile: 1374 flood

A look at the all ofthe profiles shows that the flow data are consistentfor

Reach River 5t<l Profile

•
0.01

0.21
(II]

Frctn Loss C &E Loss Top Width

1974 flood
1974 flood

1974 flood
1974 flood

SR D 1974 flood
BR U 19741lood

Kentwood 5.39

Kentwood 5.41
Kentwood 5.44

Kentwood 5.4
Kentwood 5.4

Kentwood 5.34'

Bridge Modeling Solution 4 VRB/GWB/CTA
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2.2 WS-03

Reach River Sta Profile

Kentwood 5.44 PF1
Kentwood 5.44 PF 2
Kentwood 5.44 1974 flood

Kentwood 5.41 PF1
Kentwood 5.41 PF 2
Kentwood 5.41 1974 flood

Kentwood 5.4 SR U PF1
Kentwood 5.4 SR U PF 2
Kentwood 5.4 SR U 1974 flood

Kentwood 5.4 BR D PF1
Kentwood 5.4
Kentwood 5.4

Kentwood 5.39 PF 1 208.91 !
Kentwood 5.39 PF 2 210.95:
Kentwood 5.39 1974 flood 21229:

Kentwood 5.34" PF 1 3.86
Kentwood 5.34" PF2 4.29
Kentwood 5.34" 1974 flood 4.63

The effective area controlling elevation was lowered at the downstream
section to allow overbankflowfor the 1974 flood profile. Also, the overbank
'n J values were doubled at the bounding sections to reduce overbank

t

conveyance. The weir coefficient was lowered to 2.5 to reflect the low head
and the long weir length which will tend to be too efficient. The model was
rerun and checked against the observed data.

Eile Qptions ~td. Tables ~ocations tielp

HEC-RAS Pklt" l~Ad' RIVer: BellVet Creek Reach: Kentwood Profile: 1974 f1coOd

•

Reach River Sta Profile

Kentwood 5.44 1974 flood
Kentwood 5.41 1974 flood
Kentwood 5.4 BR U 1974 flood
Kentwood 5.4 BR D 1974 flood
Kentwood 5.39 1974 flood
Kentwood 5.34" 1974 flood

[ft}
217.62:
217.31 :
217.32:
217.32:
216.15:
215.691

0.371
032i

0.09
0.06

QLell QChannel
[cis} [cis]

3704.44 4300.54
1342.53 9964.47
284.42 12987.74
284.15 12992.84

1103.38 10245.66
3155.60 5875.29

QRight Vel Chnl
(cis] . [Ills)

599502 4.06
2693.00 5.06
76997 8.01
765.15 8.01

2650.96 5.98
4969.11 5.70

Bridge Modeling Solution 5 VRB/GWB/CTA



2.2 WS-03

We need to increase the n values in the overbanks and rerun until the weir
flow and overbankflow balance. Nvalues were increased to 0.6. Weir flow
a roximated the overbank ows. •

E.i1e Qptions ~td. Tables !"oeations ~elp

. . HEC·RAS PlatY FInal Stead" River: Beaver Creek Reach: Kerdwo'Jd Pre,file: 1974 Roe.d

Reach River 5ta Profile

Eile Qptions 2td. Tables bocations t!elp

Reach River 5ta P,ofile

'.1b, .f "'w;;. HEC.RAS PI<ll'l' Final SteadY River. Beaver Creel< Reach Kentwoc<l ,Prolile'1974 flood

4. Compare the Computed Results With Observed Data

•

1974 flood

1974 flood
1974 flood

1974 flood

SR 0 1974 flood
SR U 1974 flood

Kentwood 5.34'

Kentwood 5.44

Kentwood 5.39

Kentwood 5.4
Kentwood 5.41

Kentwood 5.4

IFIoW in right overbank.

The flow rate used in the third profile (0=14,000 cfs), is the same as
an observed event that occurred on May 22, 1974. The USGS
obtained high water marks and average values were estimated from
the high water marks.

__~ '" _ ~N 'iI.;'=~,.".,.-"""",."__,, -.,.,,~ "'."..." "l" ,~""",.,.,..,,..........,, >><-=>"" ~»»= »» -»=

o~~~Water Sprfaces for ~rjson ",

Delete Row

:.:1 Add an Obs. '+IS Location

• t· ObservedWS Location • Observed \.1/'.Iter

•
HelpCancel IOK

9 Beaver Creek Kentwood 5.0 211.8

7 Beaver Creek Kentwood 5.29 214.9
8 Beaver Creek Kentwood 5.13 213.6

River Reach RS PF 2 1974 flood
1 Beaver Creek Kentwood 5.99 220

6 Beaver Creek Kentwood 5.39 215.2
5 Beaver Creek Kentwood 5.41 217.8
4 Beaver Creek Kentwood 5.44 217.8

2 Beaver Creek Kentwood 5.76 218. 4
1--=-3i-=B:"'::e-=-av:"'::e'-:rC:'-re;:.:e'-:k--t7:'Ke""n'-:tw...:o..:..od":---;-:5:':.6='1-------I-·---···· '218:1'--

The observed stages can be enteredfor the third profile by selecting Steady
Flow Options, and selecting Observed WS.

Bridge Modeling Solution 6 VRB/GWB/CTA
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2.2 WS-03

The combination ofchanges produced a good reproduction ofthe observed
profile data. The profile plot shows the entered observed water surface
elevations for the third profile. Standard Table 1 was modified to show the
observed data along with the computed water surface elevations. The
results are shown below. Generally, the profile is within 0.1 ft.

Elle Qptions

Reaches ._ Relo<td O<lla I

Bridge Modeling Solution· Unsteady Flow Plan: Beaver Creek - Final Steady
Geom: Beaver Cr... Fin'al Bridge

1----------- Beaver Creek Kentwood
225

-j
Legend

220

EG 1914 flood

WS HH4flon<:l:
~ _. ~ --......... _.. _.
Grit 1974 t:Ioo-d.

Or·ouod

ows 1374 fiood

Main Channel Dista.nce {ftl

liooo5000400-G30GO2<>001000

205

200+----.--

19S-l------~-----~----~-----~----~----~o•
Eile Qptions ~td. Tables ~ocations !:!elp

ii§ i0JW/1\ • "'" HEC-RAS Plal'r Stead Final Aiver. Beaver Creek Reach: KentwoOd Profile: 1974 flood

Reach River Sla Profile Q Total Min Ch EI W.S. Elev
(efs) (ft) (Ill

Kentwood 5.99 1974 flood 14000.00 209.90 220.03
Kentwood 5.76 1974 flood 14000.00 205.00 218.39
Kentwood 5.61 1974 flood 14000.00 204.40 218.01
Kentwood 5.44 1974 flood 14000.00 203.90 217.73
Kentwood 5.41 1974 flood 14000.00 202.70 216.79
Kentwood 5.4 8ridge ,
Kentwood 5.39 1974 flood 14000.00 202.70 215.52 215.20
Kentwood 5.29 1974 flood 14000.00 202.80 215.28 214.90'
Kentwood 5.13 1974 flood 14000.00 199.90 213.59

t213.60'
Kentwood 5.0 1974 flood 14000.00 199.90 211.80 211.80

216.33
215.38·
214.10:
212.19

Flow Area Top Width Froude II Chi

6667.30 1864. 0.44
8969.35 1758. 0.28

0.21
0.20
0.37

=-:-_--'0.46
0.26
0.49
0.50

•
Bridge Modeling Solution 7 VRB/GWB/CTA



2.2 WS-03

5. Set up an Unsteady Flow Simulation.

•
Number of points on free flow curve: 140

Number of submerged curves: 1"'-40---

Number of points on each submerged curves: I' 0

Apply number of points to all bridges and culverts

Head water maximum elevation: 1220

Tail water maximum elevation (Optional): 11-2'-8--

Maximum Swell Head (Optional): 1
Maximum Flow (Recommended): 1"-30'-'0'-0-0-

The range ofelevations for the
processing ofbridge data should
exceed the expected range offlow
and elevations. The tai/water and
headwater elevations could be set
one-foot higher than the values for
the 1974 flood. Also, the maximum
flow could be set to the maximum
expected in future applications.

Based on your review of the steady-flow simulation, determine the
appropriate settings for the bridge processing (HTAB). Set the HTAB
values and save the geometry file. You don't have to rename it.

I OK Cancel

Eile Qptions Help

Plan: IBeaver Creek -Initial Unsteady Short ID IUnsteadylnit

Geometry Fae: IBeaver Cr. + Final Bridge :.::I
Unsteady Flow Fie: IMay 1974 flood :.::I

[

Programs to Run j Plan Description:

i~¥~::J1 Q
-S~:~:~~~:ti:eWindowI;~;----- Sl"~'" 1240; J

Ending Date: 105/22/1974 Ending Time: 12400 •

[
~~~::1~":'v:':Tl;":;: ~-;';;;";,pho";;;';:::-~l

Detailed Output Interval: •

DSS Output Filename: IC:\data\Lectures\2005 Unsteady\2.5 W Bridges and ~

r Mixed Flow Regime (see menu: "0ptions/Mixed Flow Options ...")------_.._-_._.._.__._----~ ___ .._--_._.._------

Compute

The flood hydrograph
used in the previous
workshop will be applied
here, along with the
downstream boundary
and initial flow. The
hydrograph represents
the May 1974 flood.

Set up an unsteady flow
simulation. Decide the
appropriate time interval
and set any required
parameters. Save the
plan as a new name and
run the simulation.

•

•
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6. Review the Results for the Unsteady-flow Simulation.

Review the results to ensure that they are reasonable. Compare the
results for the maximum stage to those from the third profile with the
observed data. Make any necessary changes and run the simulation
again, until results look reasonable. Keep track of the changes you
make.

The Hydraulic Properties Plot for the bridge is shown above. The family of
curves looks reasonable, except for the zone around elevation 216. The low
chord elevation is 215.70, where pressure flow using the gate equation will
begin. The sharp breaks for several curves reflect the upstream water
surface elevation based on the gate equation, which is independent of
tailwater. Solutions in that ran e rna have di lcul .

File Type View

Geometry: IlHlii•••mlllllilliliIIIIT iii iTTf i]iiiiii]ii I] iiii3~
River: JSeaver Creek 3 Position: I
Reach: IKentwood =:1 Riv Sta: 1r-"5.-4-SR---

Plot I Table I
Internal Boundary

Beaver Creek KentwDod 5.4 BR

•

220

2·18

216
.......
e

214c
0

ii
> 2·12~

l1J
'-
<I)

~
2"10

"t:l
ro 200<I)

I

206

204

202
0

~

Bridge Modeling Solution

5000 10000

Flow(cfs)

9

15000 20000

legend

Tail....'ater Curves
B

25000

VRB/GWB/CTA



2.2 WS-03

The stage andflow hydrograph plot, for the bridge solution, is shown below.
Generally, the hydrographs appear reasonable up to the low-chord

elevation. Then there is a break in the hydrographs as they hit the low
chord and to 0 road or the brid e. •

River: Beaver Creek • ~I HW Peak Stage

Reach: Kentwood River Sta.: 15.4 BR =:J .!J -!J TW Pe:~~~age
P' Plot Stage P' Plot Flow r :o.:b.~::$.:!~g~ rObs Flow r Use Ref Stage Peak FI~:e

Stage Flow I Table I Ratino Curve I Internal Boundarv Curves J

217 ........,....,.....-,-:...,::.:::.:..:;.....::..;.:.:::..:.;..::::.;-...;...:

::~i::l::~:: ::j:= ::t:
I i I I ,

·~~~~~T--~ww W-1--- ~~

~6 , ., , .
'--T--i--'~~ --~--- -~-

~5 ~mI~~l ~T:~:,
. __ ! __ J •• J ~_

21 0-F-~~-+--:--+-~+-"';'-+-~r---.-+--:--+-~+-",;,-+-~~--;"
2400 0200 0400 0600 0800 1000 1200 1400 1600 1800 2000 2200

I 22May1974
Time

Questions

= 216.78 [Il)
= 22May1974 1200
= 215.52 [Il)
= 22May1974 1200
= , 3958.52 (efs)

Legend

stage tiVV
~

stage lW

Flow

•

1. How do your steady-flow results compare to the observed data?
What methods did you use?

The steady flow results were a little low immediately upstream from the
bridge. The pressure and weir equation were usedfor the third profile.
Lowering the weir coefficient to 2.5 and increasing the overbank n values to
reduce overbank conveyance around the bridge gave reasonable results,
closer to the observed data.

2. What settings did you use for HTAB on bridge model processing?

The HTAB settings limited the tailwater and headwater to values above the
1974 flood. Also, the maximum flow was set to 30,000 - twice the 1974

Bridge Modeling Solution 10 VRB/GWB/CTA
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peak. The number ofcurves were the default setting.

3. What changes did you make to the unsteady flow model, after you
were satisfied with the steady flow solution?

The headwater stage hydrograph is a little ragged around the bridge deck.
This can be expected when pressure and weir flow is present; however, it
might be improved with a few adjustments. A newfeature is a plot to track
the solution through the bridge rating, as shown in the Internal Boundary
Curve below. The ragged zone is through the bridge when flow goes from
usin the ener solution to ressure ow with the ate e uation.

Eile Type Qptions tlelp

River: Beaver Creek T !:J114427.55. 208.40 HW Peak Stage

Reach: Kentwood T River Sta.: 15.4 BR M:J .!L!J TW Pe:t~~age
TimeP' Plot Stage P' Plot Flow P' Obs Stage P' Obs Flow W Use Ref Slage Peak Flow

Slaoe Flow1 Table 1Ralino Curve Inlernal Boundary Curves I

=216.78(ft)
=22May1974 1200
= 215.54 (ft)
= 22May1974 1200
= 13958.51 (cfs)

Plan: Unsteadylnit River: Bea er Creek Reach: Kentwood RS: 5.4

•
220

SOGO 1GOOO

Flow(cfs}

1500(}

legend

•

Ifwe were not satisfied with the internal boundary curves at the transition
from the energy solution to the pressure solution, we could adjust the gate
coefficient to smooth out the flow transition. Ifa value of0.40 was used a
lower headwater would result from the same tai/water (at a given flow). A
comparison ofthe results showed no significant improvement in the solution
and was not used.

Bridge Modeling Solution 11 VRB/GWB/CTA



HEC·RAS Plan: Unstead'l River: Beave! Cleer Reach Kent\o\ood

2.2 WS-03

•
Reach River Sta Profile E.G. US. QWeir

(ft) refs)
Kentwood 5.4 22MAY1974 0600 214.28i
Kentwood 5.4 22MAY1974 0800 215.90i
Kentwood 5.4 22MAY19741000 217.24 799.92:
Kentwood 5.4 22MAY19741200
Kentwood 5.4 22MAY19741400 216.94
Kentwood 5.4 22MAY19741600 216.94
Kentwood 5.4 22MAY19741800 216.94

~pstream energy grade elevation at brid; or culvert (specific to that opening, not necessarily the weighted average).

The Bridge Only table is shown below for profiles around the peakflow.

Eile Qptions 2td. Tables bocations !::!elp

F Pro~i1e out~utTable .. SixXS Bridge . - .•_.. • r.;](Q)~

The weir flow values from post-processing can be compared to the flow
transitions upstream and down from the bridge. The Six XS Bridge Table
shows those results for the weir profiles, as shown below. Flow is conserved
in the overbanks and overbankflow is comparable to the computed weir
flow.

•

•

7.49
7.38

837.66: 6.57

530.58 7.33

936.50: 7.49

?~!~m . 6.26

530.58:7:33

...... ~_. .._.._._.__l.
757.29, 6.12

11754.57: 768.46: 7.24
638.96i 1~9:§?L-.... -7.56

12014.35: 812.35 7.30

"~_"':!.~'."LI_~ __ l:l64~~9,:...7'..,:,0.,'. 7.38

22MAY19741200
22MAY19741400

22MAY19741000

22MAY19741400
22MAY19741200

22MAY1974 1000

22MAY19741400

22MAY19741200

22MAY19741200
22MAY1974 1000

22MAY1974 1400

22MAY19741000

HEC·R.c.S Plan: Unttead' River Beaver Creek Reach Kent\'.'ood

Kentwood 5.44
Kentwood 5.44

Reach River Sta Profile

Kentwood 5.41

Kentwood 5.44

Kentwood 5.41
Kentwood 5.41

Kentwood 5.34"

Kentwood 5.4 SR U 22MAY19741400

Kentwood 5.34"

Kentwood 5.39

Kentwood 5.4 SR 0 22MAY19741000

Kentwood 5.39
Kentwood 5.39

Kentwood 5.4 BR U 22MAY19741000

Kentwood 5.34"

Kentwood 5.4 SR U 22MAY19741200

Kentwood 5.4 SR 0 22MAY1974 1200
Kentwood 5.4 SR 0 22MAY19741400

Bridge Modeling Solution 12 VRB/GWB/CTA
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4. How did the unsteady-flow simulation compare to the steady-flow
profile with 14,000 cfs?

A comparison plot is shown belowfor the Unsteady flow Maximum Water
Surface (Dark Solid line) and the 14,000 cft steady flow (line with X). The
profile compare well, but in general, the unsteady flow profile is lower. We
can expect the unsteady flow profile answer to be slightly lower because the
unsteady flow solution does not use the contraction/expansion coefficients
for computing energy losses. At the downstream boundary, it is evident that
the unsteady solution started at a higher water surface elevation than the
steady flow solution. (The lower two profiles are the third profile unsteady
flow profile from post processing and the first profile steady flow because
the lrst and third ro lIes were selected or the two lans.

Eie Qptions !jelp

Reaches .. 1.Iti Profiles ... I~[!] Helo.>d Dota I

legend

WS Max \\IS - Unslell<iy,
¥'is 197~ flood - Steady Fin.1

¥'is PF 1 - Steady Fin.l

Ground
I

0\\15 1!l74 flood - Ste.<ly Final

WS 22MAY1974 0200 - Unsteo<ly.

6000500040003000

M.in Ch.nnel Distance (Il)

..

20001000

225

220

215

"'
t:
.Q

21015
>
"iii

205

200

19

Bridge Modeling Solution - Unsteady Flow Plan: 1) Unsteady 2) Steady Final
Geom: Beaver Cr.... Fmal6rid,ge

1<--------- Beaver Creek Kentwood ,I

•

•
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Lateral Spillways and Weirs, Storage Areas, and SA
Connections Workshop Solution

Tasks

1. Develop Storage Areas, Lateral Structures, and Storage Area
Connections

a. Construct storage areas for Site I and 2.

Storage areas were drawn over Site 1 and 2 utilizing the

The data was entered in the Geometric Data Editor by selecting the
"Storage Area" button, located in the "Editors" column. The Area Times
Depth Method was selected for both storage areas. Upstream SA minimum
elevation was set to 209 feet and the area to 80 acres. The Downstream SA
minimum elevation was set to 207 feet and the area to 85 acres.

b. In the Unsteady Flow Data Editor set the initial water surface elevations
of the storage areas.

In the editor the Initial Conditions tab was selected and the elevations
were set to 209 feet and 207 feet for the upstream and downstream storage
areas, respectively. These elevations are the minimum elevations of both
storage areas, thus the storage areas are dry at the beginning of simulation.

c. Connect the storage areas to each other with a storage area connection.
The connection should consist of a weir and culvert.

The connection was drawn utilizing the "SA Conn" tool found in
the Geometric Data Editor, located in the "Tools" row. By ~

beginning the connection within the upstream storage area and ended the
connection in the downstream storage area the connection is linked to these
two storage areas. The connection was named SA Transfer.

The connection editor was opened with the "Storage Area Conn." button
on the Geometric Data Editor, located in the "Editors" column. By selecting
this option Figure I was displayed.

PS-04( 188-03)/Apr 2007/MRJ I
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•

•
[J

SetSA I
Set SA I

::1

Apply Data I
Eile ~e'll' t!elp

SA Conn:

From: IStorage area: Upstream SA

To: IStorage are~: Downstream SA::..:-..---=====::;
Structure T'ype: IWeir and Culverts ::::J INo FlapG~tes

Description

•

218 Legend
Culvert

~ 216
Spillwa.y

HTab
Paramo 214

'""''*"........
c
0 212'ii
>
~
UJ

210

208

206
0 20 40 60 80 100

Weir I
Embalkme

Station eft)

Is elect connection to Edit

Figure 1 SA Connection Editor

•
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From this editor the Weir/Embankment tool was selected. Data was
entered for the weir , as shown in Fi re 2.

\-\feir Station and Elevation,Weir Data-----------;I===l Finer. ..
I Weir Width 20 ~~~S!!::ta!:!:t!!:io~n~~E~I~ev~a!...lio..n-;p.;;....*'I
! Weir Computations: 1 D.! 217.
I 2 100. ! 217.i Standard Weir Equation Paramelers------, 3

4

Weir Coefficient (Cd) 13 5
6
7

Weir Crest Shape: 1Broad Cresled 3
8
9

10
11
12
13
14
15

OK Cancel I

•
Figure 2 Weir Editor

After editing the weir, the Culvert tool was selected from the SA Conn
Data Editor. Data was entered for a single culvert as shown in Figure 3.

--,-- -,,--. -~~--------~~""

,Culvert !lata Editor

~~ Delete ... J Culvert ID liimii . J :::1
Solution Criteria: IHighest U.S. EG 3" Rename ... I .!J.!J
Shape: I-C-irc-u-la-r---3 Span: 1-=~;-D-i-am--~1~7-=:::":-::::;

Help ICancel I

Centerline Stations

Upstream IDownstream ... 1
1 50. 50. 1
2 I
3 I

~4

OK

10

Exit Loss Coeff:

Manning's n for Top:

Manning's n for Bottom:

Depth to use Bottom n:

Depth Blocked:

Culvert Length:

Entrance Loss Coeff:

Chart 1*: 11 . Concrete Pipe Culvert

Scale 1*: 11. Square edge entrance with headwall

Upstream Invert Elev: 1209

Downstream Invert Elev: 1'-2-08--

tt identical barrels: 11

,SeJe"Ctculvert to edit

Figure 3 Culvert Data Editor•
PS-04(188-03)/Apr 2007/MRJ 3



2.5 WS-04

d. Connect the two storage areas to the reach via lateral structures.

The lateral structures were added using the lateral weir
tool found in the Geometric Data Editor, located in the
"Editors" section. After pressing this button the Lateral
Structure Editor shown in Figure 4 is displayed.

•
«~--~,,~..,..,..-~---~ "'~~~~ ~-='t""--'-"""'--"""" =-~ ... .,..., ...» - - - ...

,;6 la~J;aL~tructure Editor - Beav~r Cr.~ Storage Areas with .'. ~[Q)tEJ

:::1
Set SA... IIStorage area: Upstream SASA:

Eile ~ew Qptions tielp

River: IBeaver Creek 3 _---:...;.;..;.. 1+-,
Reach: IKentwood 3 HW RS: i 3.!1!1
Description I 0
HW Position: IRight overbank 3 r~;i~i:~~i~~~::l- B;~~~;;~.~mil

Tailwater Connection~":""'~~-~::~~~§§~~~§§~~
Type: IStorage Area

.'Legend

•
Ground

•Bank Sta

100 200 300 400 SOO 600

Station (ft)

o

222

220

218

216

214

212
210

20S

206
2(}4+-'~~~~"T"T~"""""~~......-r~-.--.-.--.-.--..,....,-.--.~

-1M

All Culverts: INo Flap Gates
,...----------------=----....,.Structure Type: Weir/Gates/Culverts/Diversion Rating Curves

l,.,Ieir/
Embal~melll

~
Gate

l_I~
---;;r

Culvert

V ~

~
c

Diversion
0

iiiRC "
~ '"LiJ

[Seiect River Station of Lateral Structure to Edit

Figure 4 Lateral Structure Editor

Under the Options menu Add a Lateral Structure option was selected.
The River Station was entered as 5.9. Next, the Weir/Embankment button
was selected. The dimensions of the lateral weir were entered as shown in
Figure 5. The weir was connected to SA Upstream by selecting the Set SA
button and choosing "SA Upstream."

•
PS-04(188-03)/Apr 2007/MRJ 4
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The same method was used to add the second lateral weir at River Station
5.570. The dimensions of this weir are shown in Figure 6. After completing
the geometry, the file was saved and the unsteady flow simulation was run.

7

Figure 5 Lateral Weir Located at RS 5.9

Cancel I

WeirSta ....

DK

RS
1 5913j3
2 5875'
3 5.83666"

II4 5.79833"
5 5.76
6 57225"
7 5.685'

" .. &
;~

8 5.6475" I'
9 5.61

.,
,........,.....

10 5.576'
11 5542"
12 5.508' .-
13 5.474'
14 5.44

~~" .._-:,~~

15 5.425"
16 5.41
17 5.39

~. -..+ld:18 535666'

Weir StationinQ at HWXS's

· ..;.·· ··· · ·1 ....

9
8

15

1112 .

16

10

13
14

Weir Coefficient (Cd)

Weir Crest Shape: !Broad Crested ::3

! Weir Computations: IStandard Weir Eqn ::3 i 1---"'-1j-=':::::':~·---::":::':=::::-::-t..::.l

I 2Standard Weir Equation Par,amE,tAr<, ,.,.•.,"..~_._._ ....., 3

Weir flow reference: IWater Surface ::3 4

~ 5 +_
6

rWeir Stationing Reference···.. · ~ i 1.....:~-=-~I-----+----1

IHWDistancetoUpstreamXS: ro--I 19

I. I ~
L J

•
6

WeirSta

OK

17 5.065'

8 5.39

10 532333"

16 5.0975'

7 5.41

9 5.35666"

11 5.29

Well Slatiol'lloo at H'w'XS's

1---,-1-=18;;:.5::::.0~32::::5_· _~_ - ~

I Cancel I

12 5.25'
1---'-13=1.:=:5.=:21::...·---1· -------
1........:..:

14
=:].5:::::.1::,:,7-.---j .._ ....--_.._.

I-:'.:.j.c:c:..:..:..---l·_.. --.
15 5.13

RS
1 5.576'

1_~2.:=:5~54~2,-"---l.....- .. _.._.+_.

1_~3 .:=:5.~50~8:...."---l--.._----
4 5.474'

1--=15 ~5'c..:.44':"'-_-l. __~.. _
6 5.425"

1
2
3

7

(Weir Data···· ~~~~~~I!~LJ~
I WeirWidth ~ 1':!
!Weir Computations: IStandard Weir Eqn ::3 I
!

Standard Weir Equation Parameters------,

Weir flow reference: IWater Surface ::3

Weir Coefficient (Cd) ~

11-.::,BI----+----1
Weir Crest Shape: '-1B-ro-a-d-Cr-es-te-d---::3-.....,- I 9

______.J 1---'-]l=-l · ·.._--,··..· ··..··..--_·····1

IWeir Stationing Reference 1---'-16:=1- 1- 1
. I' 17 II

I
I G?l I~I----+----I

~ 1B __ . 1._
I HW Distance toUpstreamXS: ro--ll---'-19==+- +- I ....

I ._.....__. .__. .__._J ?O

Figure 6 Lateral Weir Located at RS 5.570

•
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-'

e. Save a new plan for Task I with the new geometry file, then proceed with
the simulation. •In the Unsteady Flow Analysis Window, a new plan with the name

"Lateral Weirs and Storage- Task I" and the short ID "Task 1." was saved.
The simulation was then initiated.

__ _ v _

~ .Profjle,P1$11 < ,,' _~ ._ • < j . ~LQJ~

EiIe Qptioos tloip

Reaches... 111!J Profiles,. I~I!] Reload Oat. I

legend

fO M8XWS

WS MaxWS
-~~-~.~~-~.

Crt' Max WS------Ground

, ....... "., .....-...~ .. -
,..,.",,...:.;.-,

~,j,,;>~-"" ....4"' .."*':~1

,""'~ ...:.....,.;~ .. '" .,,..r"

:( <,"~
... ". ....¥ ... _'N_N_..._~ ....

21G __ ..._.....,./'"

Beaver Cr. - SA and SA Connection Plan: Storage Areas and Lateral Structures 4/20/2006
10------------- Be.aver Creek Kentwood ~m _~

-----~..=-"~~-----=>"--=-=-

215

•Main Channel Distance (ft}

.J

Figure 7 Profile Plot of Maximum Water Surface Profile

•
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E.G. US.

22MAY197410oo 215.97j

21 MAY1974 2400 209.61 i
22MAY1974 0200 210.62:

22MAY1974 0600 214.14i
22MAY1974 0800 215.31 f

22MAY1974 0400 212.42'

23MAY1974 0400

22MAY19742400

22MAY19741200 .~6.39:
22MAY19741400 216.
22MAY19741600

23MAY1974 0200

22MAY19742200
22MAY1974 2000
22MAY19741800

(ft)

MaxWS?!§:~?L

?1M6V1Cl740l':OO

Kentwood 5.4

2.5 WS-04

• '.' © ¥ • HEGflAS Plan: Task 1 River: Beaver Creek Reach: Kentwood •

Kentwood 5.4

Kentwood 5.4
Kentwood 5.4

Kentwood 5.4
Kentwood 5.4

Kentwood 5.4

Kentwood 5.4

Kentwood 5.4

Kentwood 5.4
Kentwood 5.4

Reach River Sta Profile

Kentwood 5.4
Kentwood 5.4
Kentwood 5.4

Kentwood 5.4

Kentwood 5.4

•

•
Figure 8 Profile Output Table for Bridge Only

f. View output and adjust geometry until the bridge is not overtopped.

Figure 7 displays the profile plot with the maximum water surface profile
displayed. From this plot it can be seen that the maximum profile does not
overtop the bridge for the given geometry. Additionally, Figure 8 displays the
Profile Output Table for the Bridge Only. Under the Options menu
Profiles was selected, and every time step was selected. The data shows that
there was no weir flow.

2. Place Gates on the Downstream Lateral Structure

a. Construct the gates along the downstream lateral weir.

From the Lateral Structure Data Editor the downstream lateral weir at
RS 5.570 was selected. ext, the Gate button was selected. Figure 9 displays
the data entered for the gates. Ten gates were entered; each gate is 4 feet
ap·art. After entering all gate information the geometry file was saved as
"Beaver Cr. with Gates."

•
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Geometric Properties

•
10.6

Gate type (or methodology): ISluice

Gate Flow--------------c---.I

Sluice Gate Flow---------=-c--,'"

Sluice Discharge Coefficient (0.5-0.7):
16

Invert:

14"
1207

** Openings: 110

Height:

Width:

Gate Group:

•HelpOK

--( Submerged 1frim;fic;ee;FFiClo;w:::::;;;:;;==~~~~;n~
Orifice Coefficient (typically 0.8):

Head Reference:

Weir Coefficient:

l~.~_.~~.-.c,~~~._". __,_..:...- ===::::;:~::::::::::;~I

Weir Flow Over Gate Sill (gate out of water)'

j Weir Shape: I-S-ro-ad-C-r-es-te-d-,-.--

Figure 9 Lateral Gate Editor

b. In the Unsteady Flow Data Editor develop a time series of operation
for the gates that will release the water in the downstream storage area
after the flood wave.

In the Unsteady Data Editor RS 5.570 was selected and then the Add
a Boundary Location button was depressed. A time series was
developed that opened the gates after the flood wave had passed. After
entering the times series information the unsteady flow file was saved as
"Unsteady Flow with Gates." Figure 10 displays a plot of the time series
for gate openings.

•
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Cpii:iUI Table I

6

5
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Figure 10 Times Series of Gate Openings

c. Save a new plan for Task 2 with the new geometry and unsteady flow files
and then proceed with the simulation.

In the Unsteady Flow Analysis Window, a new plan with the name
"Gates - Task 2" and the short ID "Task 2." was saved. The simulation
was then initiated.

Questions

1. Did your design meet the requirement to prevent weir flow over the highway
bridge?

As shown in Figures 7 and 8 the design met the requirement to prevent weir flow
over the highway bridge. Pressure flow did occur during the simulation but the
bridge was never overtopped.

PS-04(188-03)/Apr 2007/MRi 9
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2. When did the maximum flowrate occur in the storage areas? What was the
maximum stage of both storage areas? What was the maximum flowrate
between the two storage areas? What was the maximum flowrate over the
lateral structure located at River Station 5.9?

Figure 11 and 12 display the Stage and Flow Hydrographs for the upstream and
downstream storage areas. As seen from the figures, the maximum flowrate
occurred in the upstream storage area on the May 22nd

, 1974 at 1100 hours
(1,843 cft). The maximum flow in the downstream storage area occurred on May
22nd

, 1974 at 1400 hours (1,899 cft). The maximum stages ofthe storage areas
were 218.1 eet and 216. 7 eet or u stream and downstream, res ectivel .
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PI,.,: Task 2 Storage Area: COwnstream SA
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• The maximum flo wrate between the two storage areas can be viewedfrom the
Stage and Flow Hydrograph ofthe hydraulic connection, as shown in Figure 13.
The maximum owrate was 671 c s.

Figure 13 Storage Area Connection

Pial: Task 2 SA Connection: SA TransfEr

22 700 Legend
,,'
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218 600
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214 400
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(/) u::

21 300

21 200

208 100

/
/

0206
2400 1200 2400 1200 2400 1200 2400 1200 2400

I 22May74 23Mly74 I 24May74 25Mly74 ITrre

•
The maximum flow over the lateral weir can be found by examining the Stage and
Flow Hydrograph plot ofthe lateral weir located at River Station 5.9, as shown
in Figure 14. This figure can display the flow and stage information for
headwater upstream and downstream ofthe lateral weir. Additionally, the figure
can display flow and stage information for tai/water ofthe lateral weir (flow
entering or leaving the storage area). To make the figure easier to read, only the
flow information is included. As seen on the figure, the maximum flowrate over
the weir (flow leaving) is 2,188 eft.

•
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,
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Figure 14 Lateral Structure at River Station 5.9

3. How did the stage and flow hydrographs change from Task 1 to Task 2? Did
any numerical oscillations occur in the stage and flow hydrographs? If so,
how can these oscillations be smoothed? •

Figure 15 displays the downstream storage area before and after the control
gates were added.

•
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Figure 15 Downstream Storage Area With and Without Gates

•
Numerical oscillations can be observed, particularly in the downstream storage
area hydrograph when the water surface elevations ofthe two storage areas
approach each other (see circle on Figure 12). Oscillations become more
prevalent and pronounced at coarse time steps (e.g. >30 seconds). Some
oscillations can be smoothed by using a smaller time step, lowering the Storage
Area Elevation Tolerance and raising the Weir Flow Submergence Decay
Exponent. These tolerance factors are found in the Unsteady Flow Analysis
Window under the Options menu, under Calculation Options and Tolerances ...
For further discussion on these calculation options please read pages 8-23 and 8
24 ofthe RAS 3.1 User's Manual.

4. What is another alternative, besides off-stream storage areas, to keep the
bridge from being overtopped?

The bridge could be designed with multiple openings besides the main channel to
pass larger flows. Multiple culverts could be placed along the bridge.

•
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r Plot Initial Condition, Reload O.t. I
Plan: Unstable Problem 1Stability Problem Number 1
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Trouble Shooting Workshop Solution

At what time step and at what location did the program begin to go unstable?

As seen in Figure 1, the water surface profile for Beaver Creek is unstable, and
eventually the errors become so severe that the program crashes.

Task 1

Questions

Figure 1 Profile Plot of Progressing Instability

The computational messages on the HEC-RAS Hydraulic Computations window showed
some minor instability at the very first time step. However, there was no significant
instability until 0300 on 10FEB1999, at which time the computational error was up to
0.687 feet. From there things just got worse, and the errors grew very large. The
location of the largest errors was shown as cross section 5.0.

•

•

•
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~-_.." ....

!!~,5~-.RASrinished Cp~"R.~.tations :. rrJf ulL8J
,... Geomehy Processor

River: Beaver Creek RS: 5.0
Reach: Kentwood Node Type: Cross Section
IB Curve:

-Unsteady Flow Simulation
Simulation:
Time: 72.0000 13FEB1999 00:00:00 Iteration: 0
Writing Hydrograph 57 of 57

- Post Process
River: Beaver Creek RS: 5.99
Reach: Kentwood Node Type: Cross Section

Profile: 12FEB19991800

Simulation: 35/35

,...Computation Messages

Maximum iterations of 20 at: RS WSEL ERROR ~
09FE B1999 01 :00:00 Beaver Creek Kentwood 5.0 205.50 0.043
1OFEB1999 03:00:00 Beaver Creek Kentwood 5.0 206.92 0.678 U
1OFE B1999 05: 00: 00 Beaver Creek Kentwood 5.0 209.40 0.974
1OFE B1999 06: 00: 00 Beaver Creek Kentwood 5.0 210.45 0.020

oj

10FEB1999 07:00:00 Beaver Creek Kentwood 5.0 208.46 0.224
Solution solver went unstable, iteration 18 atl OFEB1999 09:00:00
Beaver Creek Kentwood 5.0 212.08 2.676
1OFE B1999 10: 00:00 Beaver Creek Kentwood 5.0 209.14 0.646

,(;
1OFE B1999 12:00: 00 Beaver Creek Kentwood 5.0 210.51 4.760
1OFE B1999 14: 00: 00 Beaver Creek Kentwood 5.0 211.49 4.172 d- .....

Close I
Figure 2 Detailed Output

Since the instability is occurring near the downstream end of the model, the user should
examine the downstream boundary condition first. This particular data set has a rating
curve at the downstream boundary. Figure 3 displays a plot of the rating curve. The plot
shows a smooth continuously increasing rating curve. Most likely, the rating curve is not
creating the instability.

•

•

•
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What caused the instability?

Figure 3 Downstream Boundary
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•

•

Upon further review of the data, no problems were found with the geometry or boundary
conditions. In the Unsteady Flow Analysis Window, the computation interval is set at
one hour. This is an extremely large time interval for the computations. The upstream
boundary condition for this simulation is a rapidly rising flow hydrograph. The one hour
interval cannot capture the rapid change in flow with time and causes the instability.

If you were able to fix the instability, how was this achieved?

The computation interval was lowered to five minutes and the simulation was run. As
seen in Figure 4, the change produced a stable simulation.

•
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Figure 4 Maximum Water Surface Profile with a Computation Interval of 5 Minutes

•

•
PS-06(188-07)/2007/GWB 4



,

•
3.2 WS-05

Task 2

The simulation was run and the Profile Plot was examined. The animation tool
was used to progress through the time steps. The animation shows that the program went
unstable at the time step on 1OFEB 1999 at 2200. This is shortly after the gates were
opened on time 2000. Figure 5 shows the profile just as the model starts to go unstable.

•

Elle Qptions !:ielp

Reaches'H 1.!.l!J Profiles. I~I!J r Plot Initial Conditions Reload Data I

•
Ground

........~

1000 2000 3000 4000 5000

• I I
Main Channel Distance (n)

•

Figure 5. Instability Occurring on the Profile Plot

Questions

At what time step and at what location did the program begin to go unstable?

Reviewing the output shows that the model begins to go unstable just after the gates are
opened. The location of the instability is at multiple locations downstream of the
location of the lateral structure with the gates. After analyzing the output, it was noticed
that the flow going through the gates is highly unstable from one time step to the next. It
is difficult to tell at exactly what time step the program became unstable, but there is
definitely a problem with the gates.
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What caused the instability?

Figure 6 displays the detailed output just after the gates were opened. As seen on the
figure, the flowrate through the gates went from 0.0 cfs to 5311 cfs in one time step (5
min.). This is a large change in flow leaving the reach between time steps. The rapid
change in flow is most likely the cause of the instability in the solution.

•
E.ile ~it i;gmat :lew t!'\'J

RIVER STATION QTOTAL
Beaver creek 5.4 3.40
0.00 0.00 0.00
Gate ,.~ GO- 0.00 Q- 0.00

QWf:IR QGATE QCULVERT SUBMERGEt.K:E Q PER CROSS SECTION
3.40 0.00 0.00 0.000 3.40 0.00 0.00 0.00

Hydrographs written at ~9.92hours.

Start of New Time step

Sdlv1ng for Time Window • 19.91667 to 20. 00000 Hours

It.er River station Elev DZ
~~~r:~e

Zsa DZsa River station Q
a Beaver Cr eel< 5.37 214.28 0.68010 205.08 0.07990 Beaver creek 5.33 8421
1 Beaver creek 5.37 214.14 0.19479 STo #1 205.08 -0.00552 Beaver creek 5.33 8715
2 Beaver creek 5.0 212.11 0.08005 STO #1 205.07 -0.00230 Beaver creek 5.Q 12426
3 Beaver creek 5.0 212.07 0.05737 STo #1 205.07 -0.00095 Beaver creek 5.0 12553
4 Beaver creek 5.0 212.04 0.04234 $To #1 205.07 -0.00039 Beaver creek 5.0 12638
5 Beaver creek 5.0 212.02 0.03063 STo *1 205.07 -0.00017 Beaver creek: 5.0 12701
6 Beaver Cr eek 5.0 212.00 0.02225 STo In 205.07 -0. 00007 Beaver Creek 5.0 12747
7 Beaver Cr eek 5.0 211.99 0.01644 STO #1 205.07 -0. 00003 Beaver Creek 5.0 12779
8 Beaver cr eeK 5.0 211. 98 0.01193 STo #"1 205.07 -0.00001 Beaver cree"k 5.0 12803
9 Beaver cr eek 5.0 2ll.98 0.00867 STo #1 205.07 -0.00001 Beaver creek 5.0 12821

COMPUTED STAGES AND DISCHARGES AT T - 20. 0000 I-k)URS - 2/10/1999 AT TIME 20:00:00

,"",

DQ
4499

420
261
181
123

90
65
46
34
25

Beaver creek Kentwood

Lateral weirs

Storage Areas

NAME ELEVATION NET Q
STo <l'1 205.07 5320.66

RIVER STATION QTOTAl
Beaver creek 5.4 5320.66
0.00 0.00 0.00
Gate #"1 GO- 8.00 Q- 5320.66

Riv. Station Z Q v
5.274 214.14 9408. 2.12

5.0 211.98 ~2821. 1.81

•.~:

IYJ.

2153.92

vQZ

Q PER CROSS SECTION
0.00 0.00 3166.74

Riv. station

QCUlVERT SUBMERGEIIK:E
0.00 0.000

QWEIR
0.00

v
2.38
2.36
3.46
2.04

Q
13096.
13088.
14356.

9040.

R;V. station z
5.99 219.40
5.93 218.83
5.41 214.54
5.31 214.24

Figure 6 Detailed Output

Under the Unsteady Flow Data Window the Time Series of Gate Openings was
examined. As can be seen on Figure 7, the gates are rapidly opened (5 minute interval).
The rapid opening of the gates is the cause of the rapid increase in flow, which in tum
caused the instability.

•
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Plot I Table)
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Gate Opening Height - Gate #1

River: Beaver Creek Reach: Kentwood RS: 5.4 LS Gate #1

~

.~..
I

'"c'c..
Q.

o

Simulation Time (days)

Legend

•

~._.._~--_ ..- ..._._--_._-- ~- ._---_._---_... ---~---_._.~~~-~~~_.._-~~-_.__.-----_._-_._-~---

Figure 7 Plot of Gate Opening

Figure 8 displays the Stage and Flow Hydrograph of the storage area for the unstable
simulation. The sudden spike in flow that occurred when the gates were opened caused
the instability. Shortly after that the flow went negative to a very high amount.

Peak Stage ·21S.96(llj ..
Tine = 11 Feb1999 1800

Peak Flow = 12033.77 [efs]
Tine = 11 Feb1999 0200 ..:JVnhJlTlP. = 4nAl OR IArorA-ftl

Plan: Unstead lat Storage Area: STo #1

Figure 8 Stage and Flow of Storage Area for Unstable Simulation

204+......~.,........~..........~............+-.-T"'"""T"~...,.......~ ............~,..,.......,........,~...,.....,...,.....,...,.....,~· ~.. ~.·..."....,."...".;4,···15000
2400 0600 1200 1800 2400 0600 1200 1800 2400 0600 1200 1800 2400

I 10Feb99 I llFeb99 I 12Feb99 I
Time

•

220

218

I
216

I
214 --j-'

e
" 212

I
Ol

"iI'i
210

208

206

PS-06(I 88-07)/2007/GWB

--,-,.----r15000

500J

-+--I------t

7

Legend

stage

Nellnflow

Missing Data
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Ifyou were able to fix the instability, how was this achieved?

The time series of gate openings was adjusted in the Unsteady Flow Data Window. As
seen in Figure 9, the gates were opened over a longer period of time. •

River Beaver Creek Reach: Kentwood RS: 5.4 LS Gate #1

Legend..
Gate Opening Height· Gate #1

L. .J

.t::
.50"..
I
<:>

.!:
c:..
Q.

o

4

2

•
0.940.920.900.880.860.840.82

Simulation Time (days)

o+---,....-.I>--,....--..----r----r----~-__,--

0.80

Figure 9 Plot of Slower Gate Opening
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Figure 10 Stage and Flow of Storage Area for Stable Simulation
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Figure 10 displays the Stage and Flow Hydrograph of the storage area for the stable
simulation. By opening the gates at a slower rate the rapid change in flow leaving the
reach was decreased. This prevented instabilities in the simulation. Another solution
would have been to reduce the time step. However, you were asked not to do that for this
problem.

PS-06(188-07)/2007/GWB 9
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Task 3

Examining the animation of the Profile Plot and reviewing the computational messages
on the "HEC-RAS Hydraulic Computations" window, showed that the program crashed
near the beginning of the simulation. The detailed output was examined to determine
exactly when the instability occurred.

Questions

At what time step and at what location did the program begin to go unstable?

The detailed output was examined under the Computation Log File, found in the
Options menu of the Unsteady Flow Analysis Window. A search for the word
"Warning" was done to locate the initial point of instability. As seen on Figure 11, the
"Warning" first occurs at the cross sections near the downstream end of the model at time
1.333 hours.

• Stability3.bco - Notepad -~ -~ . ~ .~ r::--llfl.f)(1

•

Eile ~~ FlTmat Ylew_~~_••___~_ .._._-----_._..
RIVER REACH STATION QTOTAL HEAD WATER TAIL WATER HEAD DERIVATIVE
Beaver creek Kentwood 5.4 1362.81 210.76 210.70 0.001582

Hydrographs written at 1.33hours.

start of New Time step •solving for Time Window • 1.33333 to 1.41667 Hours

Iter River station Elev 02 River St:ation Q OQ
o Beaver creek 5.0 199.91 13.33740 Beaver creek 5.0 2867 1713
1 Beaver creek 5.048 1892.24 ...** ............... Beaver creek 5.065 25352 33672
2 Beaver Cr eek 5.048 705.77 Beaver creek 5.065 7546 25437
3 Beaver creek 5.048 350.01 Beaver creek 5.065 2207 7627
4 Beaver Cr eek 5.048 243.08 Beaver creek 5.31 -44 2619
5 Beaver Cr eek 5.048 211.14 45.63230 Beaver creek 5.33 3392 3915
6 Beaver Cr eek 5.13 219.07 27.29804 Beaver Cr eek 5.274 454 1718
7 Beaver Cr eek 5.048 420.98 ......... .,.'111* ...... Beaver creek 5.032 1198 4672
8 Beaver Cr eek 5.048 264.34 Beaver Cr eek 5.032 3848 3786
9 Beaver Cr eek 5.048 217.37 67.09959 Beaver Cr eek 5.032 4677 1185

10 Beaver creek 5.032 200.63 16.06414 Beaver Cr eeK 5.048 509 2667
11 Beaver creek 5.048 199.91 15.90423 Beaver cr eek 5.032 4356 2023
12 Beaver creek 5.032 199.91 ."..,.."..,.. .... Beaver Cr eek 5.016 2236 3876
13 Beaver creek 5.081 204.19 21. 73150 Beaver Cr eek 5.065 3614 4493
14 Beaver creek 5.081 199.91 Beaver Cr eek 5.065 4470 1224
15 Beaver creek 5.194 201. 07 32.25425 Beaver creek 5.178 3517 4719
16 Beaver creek 5.162 200.49 6.21144 Beaver creek 5.21 3757. 3865
17 Beaver creek 5.33 202.77 Beaver Cr eek 5.31 4483 1494
18 Beaver creek 5.35 205.28 6.68886 Beaver creek 5.35 3345 1922
19 Beaver Creek 5.37 202.73 ...,...,....,...,.. .... .,...,.. Beaver creek 5.37 1711 1892
20 Beaver Creek 5.41 202.71 Beaver creek 5.41 4420 3185

~ USED COMPUTED CHANGES IN FLOW AND STAGE AT MINIM~ ERROR. MINIM\.lIII ERROR OCCURED DURllIKi ITERATION 16.

CQ.1PUTED STAGES AND DISCHARGES AT T • 1.4167 HOURS - 2/10/1999 AT TIME 01:25:00

Beaver Cr eek Kentwood

Figure 11 Detailed Output

What caused the instability?

Since the instability is occurring at the cross sections near the downstream end of the
model, the user should examine the downstream boundary condition. This particular data
set has a rating curve at the downstream boundary. Figure 12 displays a plot of the rating
curve. •
PS-06(188-07)/2007/GWB 10
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Figure 12 Downstream Boundary Condition•
As seen in the plot, there is an area of discontinuity in the rating curve. This
discontinuity causes a large difference in the water surface slopes at lower flows. The
program goes unstable because of large differences in the derivatives caused by the large
differences in the water surface slopes.

If you were able to fix the instability, how was this achieved?

To correct the problem the rating curve was adjusted to produce a smooth, continuous
increase in flow versus stage. Figure 13 displays the adjusted rating curve that produced
a stable simulation.

•
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Figure 13 Adjusted Rating Curve Producing Stability
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• Task 4

The Profile Plot for this example shows a dramatic change in water surface slope
occurring at River Station 7.0, which is at the upstream end of a significant drop in the
channel.

Eile Qptions t!elp
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Figure 14 Profile Plot of Instability

Questions

At what time step and at what location did the program begin to go unstable?

Examining the animation of the Profile Plot shows that the program went unstable where
the slope of the reach dramatically changes, River Station 7.0. Figure 14 displays the
Profile Plot illustrating the instability. The instability occurs at the beginning of the
simulation and progressively became larger.

•
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What caused the instability?

As seen on Figure 14, the water surface profile goes to critical depth where the slope of
the reach changes. When HEC-RAS is run in its default mode (non-mixed flow regime),
it is limited to subcritical flow for unsteady flow simulations.

If you were able to fix the instability, how was this achieved?

There are three possible solutions for this problem. The first involves examining the base
flow from the input hydrograph. The simulation with the instability had a base flow and
initial condition of 700 cfs. This low flow allows the water surface to pass through
critical depth. One solution is to increase the base flow and initial flow to a value that
does not pass through critical depth. A value of 1000 cfs was set and the simulation was
re-run. This adjustment to the hydrograph and initial conditions provided a stable
simulation.

Second, the change in slope could be modeled as an inline weir. An inline weir was
added just downstream of the change in slope at River Station 6.995. Figure 15 displays
the cross section view of the inline weir. Figure 16 displays the dimensions of the inline
weIr.

,

•

•

•
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Stability Problem Number 4 Plan: Unsteady with inline weir
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Notice that the inline weir has the same dimensions as the cross section. Thus, the
placement of the inline weir at this cross section does not impede the flow in any manner.
The purpose ofplacing the inline weir at this point is to provide stability in the model.
The solution of the continuity and momentum equations are causing the instability at the
point where the slope dramatically changes. With the inline weir in place, RAS uses a
weir flow equation instead of the unsteady flow equations for the solution over the drop.
This solution allows the program to get a subcritical water surface both upstream and
downstream of the drop. The flow transition is handled by the weir eq'uation and is not
modeled directly.

The final solution to this problem would be to turn on the mixed flow regime option.
With this option turned on the program automatically reduces the magnitude of the
inertial terms in the momentum equation when the Froude number starts to get close to
1.0. This feature allows the program to solve for the water surface passing through
critical depth, and then going into a hydraulic jump.

All three of these methods were tried on this data set and they worked. The resulting
profiles are shown in Figure 17. The lower profile is at the base flow of700 cfs, and the
upper profile is the maximum profile.

~ " ~_~ A __

.' Profile Plot ., trJLQlrE]

•

•
.... -..".; ;. '1""

......... _ - - .... __ .

e 490 "., .f
c:

i
w 485 ~_"'--;--_._,---I

10000 20000 30000

Main Channel Distance (tt)

40000 50000 60000

.
Ground

Figure 17. Resulting profiles from mixed flow regime run.
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1. Save the Plan with a New Name

ShortlD IOriginal

[]

IEllisting Conditions· GIS Data ::1

1
----------::1
Flow Hydrograph ~

Plan Description:

ionExit

Computation SeUings--;;::::===:;;----------;===:=:;l
Computation Interval: 12 Minute::1 Hydrograph Output Interval: 14 Minute ::1
r Computation Level Output Detailed Output Interval: 11 Hour ::::J
DSS Output Filename: IC:\Documents and Settings\qOheccta\My Documents ~

r Milled Flow Regime (see menu: "Options/Milled Flow Options ... ")

r Water Quality Simulation

Simulation TimeWindow~===::::::---------;====1
Starting Date: 119FEB1999 ~ Starting Time: 11700

Ending Date: 120FEB1999 .I!J Ending Time: 11"""12-0-0-_·'

Ic:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::G9.0p.~t~::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::JI

New Plan

Open Plan '"
Save Plan

~ile:

Delete Plan '"

Dam and Levee Break Workshop Solution

The first step was to save the plan with a new name (Figures 1, 2 and 3).

Tasks

The purpose of this workshop was to help students learn how to use HEC-RAS to:
enter and edit dam and levee breach data; perform the unsteady breach run; make
adjustments for stability; and review and understand the pertinent dam and levee breach
output.

Introduction

Figure 1. Unsteady flow analysis window with "Save Plan As... " option shown

•

•

•

Dam Break Workshop Solution 1 SSP/CTA



3.4 WS-06

-- - ,
Save Plan Data_~_",\tMI'!l'i,"";"''C''0;U-~" _ '" , ,. it' ~"'y ~:m,~#~,l

Hie File Name Selected Folder De/alit Project Felde! I My DocumentsI
IBaid Eagle Dam Brea~ IBaldEDrnbrr..p C:\ .. \4.5 W Dam and Levee Breaching\Data for solution stuff

Bald Eagle BaldEDmbrk.p01 ~C:\

~ Documents and Settings
~qOheccta

~ My Documents

Figure 2. "Save Plan Data As" window showing new Title

Enter the short plan Identifier (16
charma:-.)

IDam Break

)

•

OK Cancel

Figure 3. Short Plan Identifier window

2. Enter the Dam Break Data

Once a new plan has been created, the next step was to enter the Dam Breach
infonnation. To get to the dam breach editor, the user could either click on the <Breach
(plan data» button on the Inline Weir editor, or from the unsteady flow analysis editor
choose options, dam breach. Next, the infonnation should have been entered as shown in
figure 4.

•

•
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Legend
•
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Piping Coefficient: r-IoC":.6:----

Initial Piping Elev: 1620

Trigger Failure at: IWS Elev

StartingWS r-16-64---

Figure 4. Dam Breach window showing breach data

After the dam breach infonnation was entered, the unsteady flow simulation was
perfonned and various tables and graphs could be examined to show the results. Figure 5
shows the inline weir cross plot when the dam has a large piping breach.

3. Perform the Unsteady Flow Simulation and Review the Results

•

•

EIe Qptions ~
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Figure 5. Cross section plot showing piping breach•
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4. & 5. Create a New Plan and Run the Dam Breach with a Ten Second Time Step WS-06

The next two tasks were to save the plan with a new name and perform the
unsteady flow simulation with a ten second time step. Figure 6 shows the stage and flow
hydrograph for the inline weir for both the original dam break and the ten second dam
break. Figure 7 is a zoomed in plot showing a slight difference in peak flow between the
two plans. •
fie T",. Options Hdo

RiYer. 10aidEOlIo iI ~12lJ'ob19S9 ~22:45,662.36, 0"",01."_

Reoch !Loc:Hav :3 Riv.,Sta.: 181&Xl IS i1!J.!l HWP.~~tage

rv PIal Stage rv PIal Flow r Db. Stage r Obs _ r Use Rei Stage T'YI Peal< Stooe

Stage Flow I lobi. I R."., C<Ne I Got.o_1 T....

• 664,36I~)

• lSFob19S9 2J04

: ~:,:. m,.; .=J

•
...... l

T---

I, ...._+""''''
i

..... ; .

:
--+._._. '.-

",j + 7""r"' L.... + ,_ i'

I
"" -- --j-- :---

I
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........;...__........_-_.~-,.,;,---,,:.., ... ,-1 ..,........·....·..........,·,-

Figure 6. Stage and Flow Hydrograph for the Dam Break
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Figure 7. Zoomed in view of Stage and Flow Hydrograph showing peak flow from Dam Break
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6. Add the Lateral Weir Levee Breach

The next step was to save the plan with a new name and add a levee breach. The
levee represented by the lateral weir at river station 22900 was the first to be overtopped,
so the breach was added at this location (Figure 8).

•
""w__"..&=~~",=~".__~ ~ ~ ~'-~""" _~~__"'~< _~ ~_~_~_ ~ _~_~V~_~~
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Figure 8. Lateral Breach window showing levee breach data

7. Review the Results

After perfonning the unsteady flow simulation, the results can be reviewed.
Figure 9 shows a profile plot of the lateral weir with and without the levee breach. Figure
10 shows the stage and flow hydrograph for the storage area. The red line in figure 10
corresponds to the date on the animation control: 20Feb1999 0700.

•
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Figure 9. Profile plot at levee with and without levee breach
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Figure 10. Stage and Flow Hydrograph at storage area with and without levee breach
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The next step was to create another plan, this time with a longer time window.
The time increment, as shown in Figure 11, was increased to 1 minute. This was mainly
done to reduce the time it took to finish the workshop.

8. Create a New Plan with a Longer Time Window 3.4 WS-06

•
Eile Qptions Help

Plan: ILong Run ShortlD ILong Run

Geometry File: 'Existing Conditions· GIS Data ::1
Unsteady Flow File: IFlow Hydrograph ::oJ

Programs to Run Plan Description:
P'" Geomelry Preprocessor n
P'" Unsteady Flow Simulation L:.:.:J
P'" Post Processor
r Water Quality Simulation

Simulation Time Window;::====-:::-;---------;====1
Starting Date: 119FEB1999 ~ Starting Time: 11700
Ending Date: j22FEB1999 .JIJ Ending Time: 1~12-0-0---1

Computation Sellings--;===:::;:-----r-------;:====;J
Computation Interval: 11 Minute:::J Hydrograph Output Interval: 14 Minute ::1
r Computation Level Output Detailed Output Interval: 11 Hour 3
DSS Output Filename: IC\Documents and Settings\qOheccta\My Documents ~

r Mixed Flow Regime (see menu: "Options/Mixed Flow Options ...")

1 Dam (lnline Structure) with breach data. 1 set to breach.
1 Levee (Lateral Structure) with breach data. 1 set to breach.

IL:::::::::::::::~:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::G~i!iP.~t:~:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::~~::::::::::~::::::::::::::::JJ

Figure 11. New Plan with Longer Time Window

9. Create a New Plan and Add the Levee Repair

Create yet another plan and the levee repair. Figure 12 shows the levee repair
information.

10. Review the Results

Figure 13 shows the profile plot with the levee breach and with and without the
levee repair. It also visually shows the amount the levee has been repaired. Figure 14
shows the stage at storage area #2 for three different plans. The stage line that ends at
20Feb at 1200 is the dam break without levee breach. This plan had a shorter time
window than the other two plans. The top line is the stage with the levee breach. The
middle line (the one the pointer is next to) is the levee breach with repair.

•
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Figure 13. Profile Plot of Levee Breach with and without Repair
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Figure 14. Stage Plot of Storage Area #2

11. More Detailed Output (optional) •To create a more detailed graphic ofthe dam breach, the plan can be saved for a
final time and the simulation run with a smaller detailed output time increment. Figure
11 shows the dam breach growth at a fifteen minute detailed output.

•
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Figure 11. Cross section plot at the dam showing breach growth at 10 minute interval

Questions

1. How does the floodwave hydrograph from the ten second time step compare to
the original dam break hydrograph? Which do you think is more accurate? What
additional time step checks could be made?

The ten second time step is slightly higher. The peak flow at the dam is about
1,000 cfs higher out of a total of 476,500 cfs. A two minute time step is generally too
long for a dam break problem (ten seconds is better). For this problem, the difference
between the two results is actually quite small.

In general, a smaller time step is more accurate and extremely important for
problem stability. For this problem, the ten second time step iterated less than the two
minute step (the two minute time step went to maximum iterations and failed to converge
on at least one time step). A good way to identifY what time step should be used is to
satisfY the Courant condition for the impending flood wave. The quick way to get started
is to estimate that the flood wave will travel at 20-30 fps. Then identifY the average reach
length between cross sections - in our case it is about 300 ft. Ifwe use 30 fps and 300 ft,
then our time step should be around 10 seconds! If we use 20 fps, we'd be closer to 15
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seconds. You would want to look at the flood wave velocity over the reach of interest
during the peak flow to identify the appropriate time step to select. 3.4 WS-06

However, it is possible for shorter time steps to iterate more. A longer time step
can sometimes "average out" some of the quicker changes in the hydrograph. However,
even when this does occur it does not mean the answer is more accurate (in fact, the
reverse is quit possible).

Additional simulations could be made with other time steps, such as 5 seconds
and 30 seconds. This would allow a greater sensitivity test on the time step.

2. How much did the lateral weir breach change the maximum water surface and
the peak flow into Storage Area #2. How much did the levee repair option reduce
the water surface to the breach without the repair?

The maximum flow into the storage area with the levee breach is 138,000 cfs and
134,000 cfs without it. This is a relatively small difference. The maximum water surface
without the breach is 555.0 ft. The initial peak stage drops as water flows from storage
area #2 to storage area #1, and then it starts to rise again (the stage in storage #1 rises
reducing the flow from #2 to #1). The maximum with the breach is 556.3 ft and the
maximum with the breach and repair is 555.2 ft (basically the same as with no breach).
So the levee repair reduced the maximum stage by at least a foot.

Getting the correct stages and flows for this question is a little tricky. First, make
sure you are looking at storage area #2 (not #1). Second, the storage area plot does not
show the flow from the lateral weir into the storage area. The storage area shows net
inflow, which means the flow from storage area 2 to 1 is subtracted out of the flow
coming in from the lateral structure. To get the flow into the storage area from the levee,
look at a plot of the lateral structure.

3. Does the data input and model output both make "hydraulic sense?" What
additional analysis and sensitivity checks could be done for this dam break
problem?

When the levee breach reaches its full size, there is still over 100,000 cfs going
through the break. From the size and shape of the levee, it would probably continue to
enlarge. In addition, the two levees further downstream are both overtopped with large
flows. They would also likely breach. Finally, it is unlikely that the levee could be
repaired so quickly with the depth of water and flow still leaving it. The HW in the river
is close to equalizing with the TW in the storage area #2, so we would not expect the
peak stage to change significantly in SA #2.

The most important additional analysis would be to change the dam break
parameters: size and time of formation.

•

•
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